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Preface  

Where to Find Help  

Online Help  

No matter where you are in Medisoft, help is not far away.  Access the online Help screens to 
find detailed information on each feature in the program.  Online Help is available in two 
different ways:  

Context-Sensitive Help  

For help in a particular part of the program, click the area for which you need help and press 
F1.  The help topic for that area should appear.  

Main Help File  

To access the main help file, click the Help menu and select Medisoft Help.    

The main help file will appear displaying the Contents tab.  Use the Contents tab to view 
categorized topics for the program.  Use the Index and Search tabs to find out additional or 
specific information about the program.  

Medisoft Knowledge Base  

The Knowledge Base is a searchable online database containing technical information relevant 
to the use of Medisoft products.  To access the Knowledge Base, go to the following web site:  

http://www.medisoft.com/kb 

When accessed, you can search for information concerning Medisoft products.  All current 
technical information is contained in the Knowledge Base.     

Training  

There are various training options available.  Please contact your local Value-Added Reseller or 
the Medisoft Sales Department at 800-333-4747 for information concerning these options.  

Independent Value-Added Resellers  

There are Value-Added Resellers in your market area who are knowledgeable and efficient in 
selling, installing, troubleshooting, and supporting your Medisoft program. You can contact the 
Medisoft Sales Department at 800-333-4747 for the name of a qualified Value-Added Reseller 
in your area to give you hands-on help or search the Medisoft website at www.medisoft.com for 
a reseller in your area.  

Technical Support  

Call Support at (800) 334-4006 between the hours of 8:00 a.m. and 8:00 p.m Eastern Standard 
Time. You will hold for a technical support representative who has specific knowledge about the 
issue for which you are calling.  

 

http://www.medisoft.com/
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Getting Started with Medisoft 

The topics featured in the Getting Started with Medisoft book are intended to help you set up 
your practice, begin entering transactions, create claims, and apply payments. The topics in this 
section do not completely document Medisoft. For more information, look up related information 
in the Search field of the Help file and access other parts of the Help system. 

New in this Version 

Enhancement: ARRA Reporting 

Medisoft 17 includes four new reports to help you to remain compliant with upcoming ARRA 
requirements, specifically the requirements for electronically verifying the eligibility of your 
patients for insurance and for electronically sending claims to insurance providers. These 
include: 

 Appointment Eligibility Analysis - Detail  

 Appointment Eligibility Analysis - Summary  

 Electronic Claims Analysis - Detail  

 Electronic Claims Analysis - Summary  

Each of these reports offers several filters for controlling the information that shows. In addition, 
several summary values appear on each report so that you can see at a glance the information 
you need to verify that you are meeting ARRA requirements.  

Enhancement: ARRA Audit 

Medisoft 17 includes a feature that allows you to track reporting and exporting for ARRA when 
you generate audit reports. A new option on the Audit tab in Program Options allows you to turn 
this feature on or off. It is turned on by default. Certain reports or grids that are printed or saved 
to disk will be audited. 

Note: Previewed reports will not be audited. 

 The following types of information are included as part of the ARRA Audit: 

 Data grids 

 Custom reports, including claims and statements 

When printed from either Transaction Entry or Statement Management, but not the Report 
menu or Report Designer. 

 Medisoft reports 

 Office Hours data 

 Final Draft reports or data printed or saved to disk 

 Internal reports 

 Statements 

 Eligibility information 

BillFlash 
Medisoft Advanced and Network Professional programs only. 

Statements sent to patients electronically through Medisoft will now use BillFlash. You can 
enroll within Medisoft now, as well as upload your statement files directly from Medisoft 
automatically. You can view and approve the uploads at BillFlash by clicking links from within 

file:///C:/StarTeamWorkingFolders/Lytec%20-%20Medisoft/Medisoft/Help%20Files/Medisoft%2017/Appointment_Eligibility_Analysis_-_Detail.htm
file:///C:/StarTeamWorkingFolders/Lytec%20-%20Medisoft/Medisoft/Help%20Files/Medisoft%2017/Appointment_Eligibility_Analysis_-_Summary_Report.htm
file:///C:/StarTeamWorkingFolders/Lytec%20-%20Medisoft/Medisoft/Help%20Files/Medisoft%2017/Electronic_Claims_Analysis_-_Detail_Report.htm
file:///C:/StarTeamWorkingFolders/Lytec%20-%20Medisoft/Medisoft/Help%20Files/Medisoft%2017/Electronic_Claims_Analysis_-_Summary_Report.htm


Getting Started with Medisoft 

2 

Medisoft, and BillFlash will print and mail your statements to your patients. For more information 
on BillFlash, to get more detail, and learn how to enroll, go to BillFlash  

Within Medisoft, you can control several aspects of what prints on your statements, including 
which credit cards you accept, service messages you want to print, printing of account 
summaries and aging, and printing up to six messages you want to appear on statements. For 
more information, go to Program Options - BillFlash tab 

Options on the Activities, Bill Flash menu allow you to enroll with BillFlash, view and approve 
statements that have uploaded to BillFlash, see your account settings at BillFlash, and view 
reports, such as the Disposition report. Each one of these menu options will open a different 
page at the BillFlash website.  

Several windows in Medisoft have quick access to the eView page of the BillFlash website via a 
new View eStatements button. In addition, when a patient is selected and Ctrl + F7 is clicked, 
the eView page will open for any statements for that patient. These windows are: 

 

 Patient List 

 

 New/Edit Case 

 Quick Ledger 

 Guarantor Ledger 

 Apply Payments (through Transaction Entry) 

 Collection List/Tickler 

 Edit Statements 
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 Deposit List 

 Apply Payments 

 Transaction Entry (note that Calculate Totals has been moved.) 

 

HIPAA X12 Version 5010 

The following are changes made to Medisoft 17 to accommodate the upcoming change from the 
Health Insurance Portability and Accountability Act (HIPAA) Accredited Standards Committee 
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(ASC) X12 version 4010A1 to ASC X12 version 5010 and National Council for Prescription Drug 
Programs (NCPDP) version 5.1 to NCPDP version D.0.5010. HIPAA X12 version 5010 and 
NCPDP version D.0 are new sets of standards that regulate the electronic transmission of 
specific healthcare transactions, including eligibility, claim status, referrals, claims, and 
remittances. Covered entities, such as health plans, healthcare clearinghouses, and healthcare 
providers, are required to conform to HIPAA 5010 standards.  

These changes include new windows/tabs, restructured windows or moved fields, menu 
changes, new fields, additional options, and other changes. 

New Windows or Tabs 

There are three new windows or tabs. 

Edit Claim window, new EDI Note tab.(for Claim level notes) 

The EDI Note tab has been added to the Edit Claim window. Information on this tab is pulled 
from the Case Window, Comment tab. This tab allows you to change various note information at 
the claim level so it does not affect the data in the case record itself.  

  

For more information on this tab, see EDI Note tab  

EDI Notes and List windows (for Transaction Line Item notes) 

A new EDI Notes window will allow you to enter notes of various types for electronic 
transmission. The corresponding List window will open when the new EDI Notes button is 
clicked during Transaction Entry, Patient or Guarantor Ledger, or Unprocessed Transactions.  
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From this window, you can create or edit EDI Notes using the EDI Note window. 

 

You can use this window to enter four different types of notes. Depending on your selection in 
the Note Type field, the fields will change. For more information, see EDI Notes.  This change 
eliminates the need to type notes with delimiters in the Transaction Documentation window. 

On the Transaction Entry and Patient Ledger windows, you can see if there is an EDI note 
associated with a particular line item by adding the EDI Notes column, using the Grid Columns 
window. 

Note: This column will NOT display by default. When you add it, the Caption will be 
EDINotes and the Width will be 4; however, after clicking it, the Caption will simply be E with 
a width of 2. If you attempt to change it back to EDINotes, it will return to E automatically. 

Warning: You must close any open EDI Notes windows before you can return to Transaction 
Entry, Unprocessed Transactions, or the Ledger windows.  
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Restructured windows and moved fields 

Several fields have been moved and windows have been restructured and rearranged to 
accommodate the moved fields. 

 Allergies and Notes, as well as EDI notes, have been moved to the Comments tab of 
the Case window.  

 

 Condition Codes have been moved from the UB04 window, FL 4 to 41 tab to the 
Condition tab of the Case window to accommodate changes that allow condition codes 
to be used in professional claims. 

Condition Codes will not be copied if the user uses Copy Case.  

file:///C:/StarTeamWorkingFolders/Lytec%20-%20Medisoft/Medisoft/Help%20Files/Medisoft%2017/Case_Comment.htm
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New Fields added 

Several new fields have been added throughout the program. Below is a table describing the 
window where the new field is located, the field name, and its purpose. 

Window where the field is 
located 

Field Name Purpose 

Practice Information, Practice 
Tab 

Email Enter the general email 
address for the practice. 

Case Window, Case Policy 2 
Tab 

Medicare Secondary 
Reason 

Allows you to specify the 
reason why Medicare 
coverage is secondary. 
Visible only if an insurance 
with Type of Medicare is 
selected. 

Patient/Guarantor, Name, 
Address Tab 

Date of Death Enter the date on which the 
patient died, if necessary. 

Patient/Guarantor, Name, 
Address Tab 

Suffix Allows you to enter a suffix 
for the patient's name, such 
as Jr.  

Windows that show the 
patient's name will now 
display the suffix as well. 
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Patient/Guarantor, Name, 
Address Tab 

Race Select the patient's race. 

Patient/Guarantor, Name, 
Address Tab 

Ethnicity Select the patient's 
ethnicity. 

Case Window, Medicare and 
Tricare Tab 

Special Program Code Allows you to select any 
special program from the 
drop-down list. 

Provider Window, Address Tab Middle Name Allows you to enter the 
middle name of the 
provider. 

Referring Provider Window, 
Address Tab 

Middle Name Allows you to enter the 
middle name of the 
referring provider. 

Case Window, Policy 1, 2, and 
3 Tabs 

Group Name Enter the group name for 
the insurance plan. 

Procedure/Payment/Adjustment 
Window, General Tab 

Purchase Service Amount Use this field to enter 
amounts you pay a lab or 
other vendor for technical 
services they performed for 
you for the procedure, such 
as lab testing. This amount 
will appear on the 
Transaction Entry window 
and a summary total of 
these amounts on the 
Claim window.  

Procedure/Payment/Adjustment 
Window, General Tab 

NDC Unit Price Use this field to enter the 
unit price of a drug or 
biologic. 

Transaction Details Reference ID Qualifier Use this field to specify a 
qualifier for the 
Rx#/Reference ID. 

Procedure/Payment/Adjustment 
Window, General Tab 

NDC Unit of Measurement Use this field to enter the 
unit of measurement that is 
used for the drug or 
biologic. 

Menu Changes 

The option for UB-04 Condition Codes has moved from the UB04 Code Lists menu to the main 
Lists menu. 

Additional Options 

 Additional Diagnosis Codes: The program now allows you to have up to 12 diagnosis 
codes for a case. The following fields and windows are affected: 

 Program Options, Data Entry tab: Number of Diagnosis can now be set from 
4-12.  

 Transaction Entry: You can now have columns for up to 12 diagnosis codes, 
as well as up to 12 column check boxes to specify if the code is being used for 
that procedure. 
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 Unprocessed Transactions: You can now have up to 12 columns for 
diagnosis codes on the List window, as well as the Edit window.  

 Case Window, Diagnosis Tab: You can now have up to 12 Default Diagnosis 
fields.  

 Patient/Guarantor, Name, Address Tab, Sex field: Added the option Unknown 

 Case Policy 1, 2, and 3 tabs: Relationship to Insured has several new options.  

Other Changes 

 Medicaid Referral Access # field is now called Referral Access #. 

 Case Window, Condition Tab: First Consultation Date field is now called Initial 
Treatment Date. 

 Case Window, EDI Tab: Timely Filing Indicator field is now a drop-down instead of a 
free-form text field.  

 Case Window, EDI Tab: The EPSDT Referral Code field is now a drop-down.  

 Insurance Type Code: Removed this field from the EDI tab on the Case window. 

 Claim Filing Indicator Code: Added four new items to the drop-down:  

 Dental Maintenance Organization 

 Federal Employees Program 

 Other Federal Program 

 Commercial Insurance Co 

 Relationship to Insured: items in the list have been rearranged so that values valid for 
5010 are on top and legacy values for 4010 are on the bottom. 

 Timely Filing Indicator: This is now a drop-down with preset values, to ensure that a 
valid value is always selected. 

Revenue Management Click Reduction 

Several changes have been made to the functionality and workflow of Revenue Management to 
reduce the number of times that the user must click to achieve the desired result. Among these 
changes are: 

 Claims will be auto-checked so that the user does not need to click Check Claims. 
There is a new option on the Medisoft tab in Revenue Management Preferences called 
Auto Check Claims. Selecting this option will enable the program to auto check the 
claims when the user selects Process > Claims.  
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 Claim edit checks and IG edit checks have been combined into one step and executed 
when you select Claims from the Process menu. Errors are displayed on the Claims 
Preview report, as well as under each individual claim.  

 One click removal of all claims marked with a red X, eliminating the need to click 

Remove Claim many times. An icon appears next to the Remove Claim button on 
the Claim Preview window. Clicking this icon will remove all claims marked with a red X. 

 Addition of a Failed Claim report that will be displayed when the Send button is selected 
from the Claim Preview window. This report will display all claims that were removed, 
eliminating the need to preview this report separately.  

 Claims that fail any edit and are removed from the transmission file will be written back 
to Medisoft and the status in Medisoft changed to Alert. Denial information will be 
written to the History tab in Revenue Management and the Comments tab on the Claim 
window in Medisoft. 

 Remove the OK button displayed after clicking Send from the Claim file saved 
message. Remove the Transmission has been received button that displayed after the 
file was sent/received. 

Revenue Management 5010 ERA Changes 

Changes have been made to Revenue Management processing to handle the upcoming switch 
to 5010 ANSI. Among these are the following: 

 Updates to the 5010 RelayHealth IG. These updates include: 

 For the 835 IG, the TRN02 element has increased size to a maximum of 50 
characters.  

 The N407 element (Country Subdivision Code) in Loop 1000A AND Loop 
1000B has been added to the 835 IG. It is situational and has a maximum 
length of 3 characters. It is required when the address is not in the United 
States of America, including its territories, or Canada, and the country in N404 
has administrative subdivisions such as but not limited to states, provinces, 
cantons, etc. 

 Several new elements for Loop 1000A (Payer Identification) in the 835 IG that 
are not active yet but must be added. In this way, if they are received, the ERA 
will not be discarded. These are the following: 

    POS# ID Min/Max Usage 
Req 

Values 

PER Payer 
Technical 
Contact 
Information 

1300   >1 R   

PER01 Contact 
Function Code 

  ID 2--2 R BL 

PER02 Payer 
Technical 
Contact Name 

  AN 1--60 S   

PER03 Communication 
# Qualifier 

  ID 2--2 S EM, 
TE, 
UR 

PER04 Payer Contact   AN 1-256 S   
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Communication 
# 

PER05 Communication 
Number 
Qualifier 2 

  ID 2--2 S EM, 
EX, 
FX, 
TE, 
UR 

PER06 Payer 
Technical 
Contact 
Communication 
# 

  AN 1--256 S   

PER07 Communication 
Number 
Qualifier 3 

  ID 2--2 S EM, 
EX, 
FX, 
UR 

PER08 Payer Contact 
Communication 
# 

  AN 1--256 S   

PER09 Contact Inquiry 
Reference 

  AN 1--20 N/U   

              

PER Payer WEB 
Site 

1300   1 S   

PER01 Contact 
Function Code 

  ID 2--2 R   

PER02 Name   AN 1--60 N/U   

PER03 Communication 
# Qualifier 

  ID 2--2 R   

PER04 Payer Contact 
Communication 
# 

  AN 1-256 R   

PER05 Not Used           

  

 There are new RDM (Remittance Delivery Method) elements being added to 
Loop 1000B. These will be ignored in posting but need to be defined in the IG. 
These are the following: 

    POS#  ID Min/Max Usage 
Req 

Loop 
Repeat 

Values 

RDM Remittance 
Delivery 
Method 

1400   1 S     

RDM01 Report 
Transmission 
Code 

  ID 1--2     BM, 
EM, 
FT, OL 

RDM02 Name   AN 1--60       
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RDM03 Communication 
Number 

  AN 1--256       

RDM04 Not Used       N/U     

  

 There is a new DTM (Coverage Expiration Date) element for 5010. This 
segment explains that coverage was denied because the patient's coverage 
has expired. The new values are below: 

    POS# ID Min/Max Usage 
Req 

Loop 
Repeat 

Values 

DTM Coverage 
Expiration 
Date 

0500   1 S     

DTM01 Date/Time 
Qualifier 

  ID 3--3 R   050 

DTM02 Date*   DT 8--8 R   CCYYMMDD 

DTM03         N/U     

*This is the date on which the patient's coverage expired. 

 There are new Claim Received Date Elements (DTM) in Loop 2100. These 
have been added to the IG so that they are recognized if they are received. 
They are not used in posting a remit, however. Here are the new values: 

    POS# ID Min/Max Usage 
Req 

Loop 
Repeat 

Values 

DTM Claim 
Received 
Date 

0500   1 S     

DTM01 Date/Time 
Qualifiier 

  ID 3--3 R   050 

DTM02 Date*   DT 8--8 R   CCYYMMDD 

DTM03         N/U     

*This is the date that the claim was received by the payer. 

 The number of repeats for the REF Service Identification Element in Loop 2110 
has been increased to 8 for 5010. The 4010 required only 7.  

 There is a new element for 5010 added to the IG in Loop 2110 (Service 
Payment Information): REF Healthcare Policy Identification. Here is a table of 
the values: 

    POS # ID Min/Max Usage 
Req 

Loop 
Repeat 

Values 

REF HealthCare 
Policy 
Identification 

1000   5 S     

REF01 Reference 
Identification 
Qualifier  

  ED 2--3 R   0K 

REF02 Healthcare   AN 1--50 R     
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Policy 
Identification 

 Updates to reports: 

 Claim Preview Report now includes: 

 any suffix after the patient's name (Segment NM107 in Loop 
2100). 

 the Coverage Expiration Date for an expired policy (DTM 
Coverage Expiration Date in Loop 2100). 

 the Claim Received Date, which shows the date the claim was 
received by the payer (DTM Claim Received Date in Loop 
2100). 

 Claim Details Report now includes: 

 any suffix after the patient's name (Segment NM107 in Loop 
2100). 

 the Claim Received Date, which shows the date the claim was 
received by the payer (DTM Claim Received Date in Loop 
2100). 

 the specific amounts of a claim (REF Healthcare Policy 
Identification in Loop 2110). 

 Remittance posting includes Coverage Expiration Date in Loop 2100. 

 25 Changes to the 5010 Eligibility IG. 

Element Location  Modification 

ISA11 (Interchange Control 
Standards ID) 

Interchange Control Header Was previously hardcoded to 
U, but is now blank.  

ISA12 (Interchange Control 
Version Number) 

Interchange Control Header Replaced 00401 with 00501 
for use with 5010. 

GS08 
(Version/Release/Industry 
Identifier Code) 

Function Group Header Updated from 004010X092 
to 005010X279 

ST03 (Implementation 
Convention Reference) 

Transaction Set Header This is a new segment 
added after ST02 and 
hardcoded to 00510X279. 

NM112 (Name Last or 
Organization Name) 

Loop 2100A This is a new element for 
5010.  

NM112 (Name Last or 
Organization Name) 

Loop 2100B This is a new element for 
5010. 

REF04 (Reference Identifier) Loop 2100B This is a new element for 
5010 

NM107 (Name Suffix) Loop 2100C The insured person's name 
Suffix has been made 
available as a data element.  

NM112 (Name Last or 
Organization Name)  

Loop 2100C This is a new element for 
5010. 

REF04 (Reference Identifier) Loop 2100C This is a new element for 
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5010. 

N407 (Country Subdivision 
Code) 

Loop 2100C This is a new element for 
5010. 

DMG10 (Code List Qualifer 
Code) 

Loop 2100C This is a new element for 
5010. 

DMG11 (Industry Code) Loop 2100C This is a new element for 
5010. 

DTP01 (Date/Time Qualifier) Loop 2100C This has changed from 472 
to 291. 

EQ01 (Service Type Code) Loop 2110C New codes have been 
added. In addition, there is a 
new data element that takes 
the value from the 
appointment. If that value is 
null, it takes the value from 
practice preferences. If that 
value is null, 30 (Health 
Benefit Plan Coverage) is 
hardcoded. The latter is 
current functionality.  

NM107 (Name Suffix) Loop 2100D The patient name suffix is 
added. 

NM112 (Name Last or 
Organization Name) 

Loop 2100D This is a new element for 
5010. 

REF04 (Reference Identifier) Loop 2100D This is a new element for 
5010. 

N407 (Country Subdivision 
Code) 

Loop 2100D This is a new element for 
5010. 

DMG10 (Code List Qualifier 
Code) 

Loop 2100D This is a new element for 
5010. 

DMG11 (Industry Code) Loop 2100D This is a new element for 
5010. 

EQ01 (Service Type Code) Loop 2110D New codes have been 
added. In addition, there is a 
new data element that takes 
the value from the 
appointment. If that value is 
null, it takes the value from 
practice preferences. If that 
value is null, 30 (Health 
Benefit Plan Coverage) is 
hardcoded. The latter is 
current functionality.  

REF04 (Reference Identifier) Loop 2110D This is a new element in 
5010. 

 The following PER segments have been deleted from Loop 2100B: 

    ID Min/Max Usage 
Req 

Values 
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PER Information 
Receiver 
Contact 
Information 

  3 S   

PER01 Contact 
Function Code 

ID 2--2 R IC 

PER02 Name AN 1--60 S   

PER03 Communication 
Number 
Qualifier 

ID 2--2 S ED, EM, FX, 
TE 

PER04 Communication 
Number 

AN 1--80 S   

PER05 Communication 
Number 
Qualifier 

ID 2--2 S ED, EM, EX, 
FX, TE 

PER06 Communication 
Number 

AN 1--80 S AAABBBCCCC 

PER07 Communication 
Number 
Qualifier 

ID 2--2 S ED, EM, EX, 
FX, TE 

PER08 Communication 
Number 

AN 1--80 S AAABBBCCCC 

PER09 Contact Inquiry 
Reference 

AN 1--20 N/U   

   

Revenue Management Configuration and Setup Changes 

Several changes have been made to Revenue Management to simplify the setup and 
configuration process. Among them are the following: 

 Eliminated the Alias table for ERA processing. The user will not need to choose the 
practice or payor information for ERA processing. Instead, information from the ERA file 
itself is used to process the ERA file. The Pay To field from Loop 1000B (practice or 
provider) and the Payer Name field from Loop 1000A Segment N102 (payer 
information) directly match the information sent out on the claim and will be used, 
eliminating these steps.   

 Allowing the user to edit the Receiver table directly, bypassing the wizard. Certain 
sections of the table remain locked, however.  

 Allow the user to log in to Revenue Management automatically from Medisoft.   

 Simplify the setup of ERA. Assign Posting codes will be populated by default with the 
appropriate payment codes that reference carrier-specific codes in Medisoft. In addition, 
there is a set of default ERA posting defaults in the Remit Posting Code window in 
Revenue Management. If Use Insurance Posting Codes is checked and there are no 
carrier-specific codes, these new Default Posting Codes will be sent.  
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Office Hours Professional Registration 

Office Hours Professional is registered at the same time as Medisoft. Although there is still a 
place where you can register Office Hours Professional, you do not have to perform a separate 
registration once you register your Medisoft product. Any messages you might receive to 
register Office Hours Professional can be ignored once Medisoft is registered. 

 

Medisoft Overview 

The following topics and links to topics discuss key elements such as new features, data 
conversion, accessing and step-by-step procedures, along with offering a brief description of 
key windows/features and links to these features.   

Step-By-Step Procedures 

There are a series of step-by-step procedures in the Help file that give instructions on using 
Medisoft. Open the Contents tab of the help file and click the Step-By-Step Procedures book to 
see all the areas in the program for which these procedures are available. 

Navigating in Medisoft 

Once the program is open, you can get a good look at the main program window.   

 

Title Bar 

The top bar on the window is the Title bar and it displays the name of the active program and 
contains Minimize, Maximize, and Close buttons on the right side.  
 

 

Menu Bar  

Just below the Title bar is the Menu bar, which shows categories of activities available in the 
program.  Click the various headings, such as File, Edit, Activities, Lists, Reports, Tools, 
Window, and Help, and each opens a submenu with a list of all the activity options available in 
that category.   
 

 

Toolbar 

Below the menu bar is the toolbar with an assortment of speed buttons (or icons) that are 
shortcuts to accessing options within the program.   

Select the option you want by clicking the appropriate button.   

The toolbar can be customized to fit your organization's needs.  Change the order of the 
buttons in the toolbar or remove them so they do not appear.  Create a new toolbar with only 
the buttons or file names that you want.  In addition, you can move the toolbar to the top, 
bottom, or either side of the screen or return it to its original position and layout.   
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F1   Look up Toolbar Customizing. 
 
  

 

 

 

Button Definition  

 

The Transaction Entry icon opens the Transaction Entry window where most 
of the transactions for the practice are maintained. 

 

 

The Claim Management icon opens the Claim Management window where 
claims are prepared, edited, and sent for payment. 

 

 

The Statement Management icon opens the Statement Management window 
where statements are prepared, edited, and sent for payment. 

 

 

The Collection List icon opens the Collection List window where you manage 
collection items. 

 

 

The Add Collection List Item icon opens the Add Collection List Items, which 
you can use to create collection items. 

 

 

The Appointment Book icon opens the Office Hours Patient Appointment 
Scheduler where appointments for the practice are scheduled. 

 

 

The Eligibility icon opens the Eligibility Verification Results window where you 
can check patient insurance eligibility. 

 

 

The Patient Quick Entry icon opens the Patient Quick Entry window. This 
feature provides another method for creating patient and case records. For 
more information on this feature, see the topic Patient Quick Entry Overview. 

 

 

The Patient List icon opens the Patient List window and access to patient 
case information. 

 

 

The Insurance Carrier List icon opens the Insurance Carrier List window and 
access to carrier information. 

 

 

The Procedure Codes List icon opens the Procedure/Payment/Adjustment 
List window. 

 

 

The Diagnosis Codes List icon opens the Diagnosis List window. 
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The Provider List icon opens the Provider List window. 

 

 

 

 The Referring Provider List icon opens the Referring Provider List window. 

 

 

 

The Address List icon opens the Address List window. 

 

 

 

The Patient Recall Entry icon opens the Patient Recall: (new) window. 

 

   

 

Clicking the Custom Report List icon displays the Open Report window and 
lets you print any of the documents listed, such as Statements, Walkout 
Receipts, Patient Lists, CMS-1500, Superbills, etc. See Custom Report List.  

 

   

 

The Quick Ledger icon opens the Quick Ledger.  You can access the ledger 
by clicking this icon or pressing F7 at almost any time the program is open. If 
you have already selected a chart number, the Quick Ledger defaults to that 
chart number. 

  

 

The Quick Balance icon opens the Quick Balance window, which displays a 
selected guarantor’s remainder balance.  

 

     

 

The Enter Deposits and Apply Payments icon opens the Deposit List window 
where you can create and print deposit lists and apply payments to patient 
transactions.  

   

 

The Show/Hide Hints icon is a toggle on/off icon.  A Hint is a context-
sensitive help feature that displays a short description of that portion of the 
program or window on which the pointer is resting.  A written description of 
the function is also displayed in the Status bar at the bottom of the window. 

 

 

The Help icon opens the Help files.  

 

 

 

The Launch Work Administrator icon opens the Work Administrator program 
where you can create tasks for users and/user groups.  

   

 

Launches the Medisoft Reports Engine (for Medisoft Advanced and Medisoft 
Network Professional only). Complete all reporting tasks in this window. The 
Medisoft Report window offers several key features not available when 
running reports off the Reports menu including new reports and features to 
enhance productivity. For more information, see the Medisoft Reports 
overview topic. 
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The Edit Patient Notes in Final Draft icon opens the Final Draft program.  It is 
a word processing program that is integrated with your patient accounting 
program and can be used for creating letters, notices, notes, etc., using data 
already stored in the patient accounting database.  

  

     

 

Clicking Exit takes you out of the program entirely.  If you have the Remind to 
Backup on Program Exit option activated in Program Options, you are 
reminded to back up your files before the program is shut down. 

 

File Menu 

The File menu contains options for managing your practice files.   

 

 

 

Edit Menu 

The functions of the Edit menu are Cut, Copy, Paste, and Delete.  These deal primarily with the 
handling of text.   
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Activities Menu 

This is the center of much of the daily routine of the practice.   

 

 

Lists Menu 

This menu provides access to the various list windows available in the program.   
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Reports Menu 

Reports within Medisoft are accessible through the Reports menu.  You can also access the 
Custom Report List and the Report Designer through this menu.   
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Tools Menu 

The options available in this menu help you access peripheral programs and information to 
assist in the management of your practice. 
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Window Menu 

This menu contains options that control the display of windows in the program.   

 

 

Help Menu 

The Help menu contains access to information on how to use the program, as well as how to 
register.   
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Shortcut Bar 

At the bottom of the screen, above the Status bar, is a shortcut bar that describes the available 
shortcut function keys available in the active window.  This bar may also be referred to as the 
―function help bar.‖  

 

 
  

 

 

Medisoft at a Glance 

Setting up Your Practice 

The Provider window contains important information about the providers associated with your 
practice.   
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Each provider in the practice needs to have his or her own record set up in the database.  You 
can use the Provider Class window to enter classes or groups for providers.  

 
 
  

Classes can be used when assigning rules. For more information on assigning rules, see the 
topic Assigning Rules. 

The Referring Provider window contains important information about the referring providers 
associated with your practice. 
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You will use the Insurance Carrier window to enter insurance carrier records. 
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You will use the Insurance Class window to enter classes or groups for insurance carriers.  
 

 
  

Classes can be used when assigning rules. For more information on assigning rules, see the 
topic Assigning Rules. 

 

The Facility window contains important information about the labs and facilities associated with 
your practice. 

 

The Addresses window is used to enter address information important to your practice.   
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The Diagnosis List window displays all diagnosis codes that have been entered into the 
database and controls to edit or enter new codes.  
 

 
 
 
 
You will use the Procedure/Payment/Adjustment Code window to enter and edit, etc. procedure 
codes.  
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If you process electronic claims, you can use the EDI Receivers window to initially create EDI 
receivers. EDI Receivers are also set up in the Revenue Management feature. 

The Patient List window is the main space for entering/editing patient and case information. 
Another method for entering/editing patient and case information when using Medisoft 
Advanced and Network Professional, is the Patient Quick Entry window.   

You can also take advantage of Medisoft’s security features and set up different users with 
varying degrees of permissions to application functions. 

Scheduling Appointments 

Scheduling appointments is simple using Medisoft's integrated appointment scheduling 
application, Office Hours. 

Entering Transactions and Payments 
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You enter charges via the Transaction Entry window and you can also apply payments using 
this feature. Users of Medisoft Advanced or Network Professional can take advantage of the 
Deposit List window for entering payments. 

Generating Claims and Statements 

Claims processing centers on the Claim Management window from which you can create, edit, 
and print/send claims. Medisoft also provides support for UB-04 claims.  And you can use the 
Statement Management window (available in Medisoft Advanced or Network Professional) to 
create billing statements for patients. For more information, see Medisoft Claim Generation 
FAQ and Electronic Claims Overview. 

Running Reports 

You can use the robust reporting capabilities of Medisoft to keep track of your office’s 
performance. Medisoft offers a rich list of reports to manage office functions and analyze your 
practice's performance.  

Running Utilities 

Medisoft also provides easy automation of several functions via the Task Scheduler and EMR 
interfacing via the Communications Manager. Medisoft Advanced and Network Professional 
users can also take advantage of the Dashboard, a utility that monitors and displays key 
functions of the practice. 

Keystrokes and Shortcuts 

Special keyboard shortcuts reduce the number of times you have to click the mouse or press 
keys to accomplish a task.  

Keystrokes Common to Most of the Program 

Keystroke Action 

F1 Opens Help files in most windows 

ESC Closes or cancels current function or window 

F3 Saves 

F6 Opens a search window 

F7 Opens the Quick Ledger window  

F8 Opens a window to create a new record 

F9 Opens a window to edit the selected record 

F11 Opens the Quick Balance window  

F12 Opens Medisoft Office Messenger 

SPACEBAR Toggles check box (check/uncheck) 

ENTER Depends on settings in the Program Options window 

CTRL + S Toggles Sidebar display 

CTRL + X Cuts selected text 

CTRL + C Copies selected text 

CTRL + V Pastes selected text 

ALT + DOWN 
ARROW 

Opens drop-down lists 

SHIFT + F4 This shortcut automatically populates the last accessed patient’s 
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chart in a new chart number field.  The system holds in memory 
the last patient's chart number selected  (for instance in the 
Patient List, Deposit List, Collection List, Quick Ledger, Quick 
Balance, etc.), and when you go to another window, you can 
use the shortcut to populate the last record. Select the Chart 
field and press SHIFT + F4 to automatically populate the last 
accessed patient’s chart in a new chart number field.  This 
feature is supported in many windows throughout the system.  

NOTE: Reports that do not use the Data Selection 
Questions window for data filtering, do not support this 
feature. 

 

Keystrokes-Formatted Date Edit Controls 

 

Keystroke Action 

+ Increases date by one day (or highlighted section of date by one) 

- Decreases date by one day (or highlighted section of date by one) 

 

Keystrokes-Grid Control in Various Windows 
  

Keystroke Action 

LEFT ARROW Moves left one cell 

RIGHT ARROW When not in edit mode, moves right one cell 

CTRL + RIGHT 
ARROW 

When in edit mode, moves right one cell 

UP ARROW Moves up one cell 

DOWN ARROW Moves down one cell 

PAGE UP Moves up one page 

PAGE DOWN Moves down one page 

ENTER Moves to the next cell 

 

Keystrokes-List Windows 
  

Keystroke Action 

F2 Changes value in Field 

F3 Saves record 

F8 Creates new record 

F9 Edits selected record 

 

Keystrokes-Transaction Entry 
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Keystroke Action  

F2 Opens the MultiLink window 

F4 Opens Apply Payment to Charges window 

F5 Opens Transaction Documentation window 

   

Keystrokes-Eligibility  

 

Keystroke Action 

F10 Opens the Eligibility Verification Results window when Eligibility is enabled.  

   

Keystrokes-Report Designer 

 

Keystroke Action 

CTRL + F Opens the Find Dialog for searching 

CTRL + O Opens the Open Report window to print a report 

CTRL + S Save As 

CTRL + F4 Closes the open report 

ALT + F4 Exits Report Designer 

LEFT ARROW Moves selected components left 

RIGHT ARROW Moves selected components right 

UP ARROW Moves selected components up 

DOWN 
ARROW 

Moves selected components down 

CTRL + F Find field 

CTRL + A Find again 

CTRL + X Cuts selected text 

CTRL + C Copies selected text 

CTRL + V Pastes selected text 
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Setting up the Program and Setting up the Practice 

Setting up the Program 

Before you can use the Medisoft program, you have to create a practice.  You might only need 
to create one practice, but you can create multiple practices if necessary.   

Creating a Practice 

When you first open the Medisoft program after installation, you are required to create a new 
data set (if this is the first time you have ever installed Medisoft) or convert previous Medisoft or 
MS-DOS data.  
 

 
  

If you have been using Medisoft Version 5.5x or 5.6x and above and have just installed Version 
17, a message displays stating that data must be converted before you can access the 
program.  If you have not already performed a backup on your existing data, perform a backup 
now.  Then click OK to perform the automatic conversion.   

If you work with multiple practices, each will have to be converted.   

For more conversion information:  

F1   Converting from Windows Version 5.4x or Lower to Medisoft Version.   

 

If you choose to create a new data set, the Create a New Set of Data window is displayed.  Fill 
in the practice name and the practice data path. The data path is the location within the 
MediData folder in which the practice data is stored. 

 

 

When you click Create, the Practice Information window appears. On this window on the 
Practice tab, you will enter your basic practice information such as the name of the practice, 
address, telephone number. 
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TIP: When initially setting up your practice, considering entering the practice name only. 
You can then complete this tab and the other tabs on the window, later in the setup 
process. Some of the settings on the other tabs, especially the Practice IDs tab, require 
setup first.  
  

 

 

For more information on these settings, see the topics Entering Practice Information and 
Entering Practice Information for a Billing Service. 

 

Other Setup Information 

Creating Multiple Practices 

It is not necessary to install the program for each new practice.  To set up multiple practices, go 
to the File menu and select New Practice.  When the first practice is set up in the Medisoft 
program, the program assumes there is only one practice and establishes a default directory for 
the data for that practice.  Each time you set up an additional data set with totally unrelated 
patients and procedure files, you must create a different subdirectory.  In the Create A New Set 
Of Data window, enter the additional practice name and change the data path.  This 
establishes a completely separate database for the new practice.   

Once you have set up additional practices, you can move easily from one to another by going 
to the File menu, selecting Open Practice, and choosing the practice you want from the list 
presented. 

Changing the Program Date 

You can change the program date for back dating a large number of transactions.  This affects 
all dates in the program except the Date Created setting, which always reflects the System 
date.   

 

Opening a Practice 

To change practices or create a new practice database, go to the File menu and select the 
appropriate option.   

To open an existing database, go to the File menu and select Open Practice. Choose the 
practice you want to open and click OK.   



Setting up the Program and Setting up the Practice 

35 
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Setting up the Practice 

Setting up the Practice 

Once you have the program set up, the next step is to enter data into each of the different 
areas of the program, i.e., entering insurance carrier records in the Insurance Carrier window, 
entering procedure codes in the Procedure, Payment, and Adjustment Codes window, and so 
on.  Here is a sequence for practice setup that should help you enter your practice information 
without moving back and forth between windows. You will set up elements (records) that are 
referred to in other records and grid entries.  
  

TIP: You can follow a different setup order for many of these activities; the following setup 
order calls for you to create records that are associated with other records first to avoid 
having to go back and recreate them. Depending on your office environment and business, 
you might follow a different setup order (if you have a large number of providers, you might 
set that up earlier, if you file very few  EDI claims, you might set that up later, etc.) 

 Set up security 

 Set up preferences 

 Enter practice information on the Practice Information window, Practice Settings tab 

 Set up EDI Receivers 

 Enter insurance carrier records 

 Enter facility records 

 Enter practice information on the Practice Information window, Practice IDs tab 

 Enter provider records 

 Enter referring provider records  

 Enter procedure codes and multilink codes 

 Enter diagnosis codes 

 Billing Codes 

 Enter other address records 

 Enter guarantor and patient records 

Keeping in mind your practice structure and your filing needs will help you set up your practice. 
Also consider reviewing the Assigning Rules topic before completing grid entries on the 
Practice, Provider, Facility, and Referring Provider IDs tabs since these entries or rules 
determine what information is pulled/included in a print or electronic claim. 

 

Rules Creation and IDs Grid Row Selection 

Medisoft claim processing for both print and electronic claims depends on a series of flexible 
rules that you define on the various ID grids in the application. When setting up or updating 
your practice data, you will create a series of grid entries (rules) on the Practice IDs and 
Provider IDs grid. You may also use the Facility IDs and Referring Provider IDs grids depending 
on your practice structure. The grid entries that you complete contain your basic practice 
information, such as group or individual NPI, taxonomy, tax IDs, and claim filing status (group 
or individual), and connect this information to the insurance carriers that your practice accepts 
and the doctors in your practice as a series of rules. 
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You begin by creating general entries for each provider on the Provider IDs grid and by creating 
at least one entry on the Practice IDs grid level.   

NOTE: The setup for solo providers offers more flexibility. Also taxonomy requirements or 
NPI setup considerations can impact how you create your practice. For more information, 
see: 

F1   An Overview of Setting up the Practice. 

In these general entries, you enter information that would apply to the most generic situation. 
Then you would create other grid entries that apply to a specific insurance carrier, insurance 
class, facility, provider, etc.  

TIP: When creating or editing IDs grid entries, do not create matching wild card entries (all 
selected for insurance carrier and insurance class) since the rules engine would not know 
which row to select. If you had different legacy numbers (for instance, in each entry), the 
system might not select the correct row. In this case, modify one of the wild card rows and 
apply it to a specific insurance carrier or class. 

When you create claims, the application gathers general data and then selects data from the 
IDs grids by analyzing the entries (rows) on the various IDs grids.  The process of selecting the 
correct row involves first selecting a row that applies to the insurance carrier, provider, or 
provider class. If more than one row is present on the various ID grids, the application matches 
the row on an IDs grid to the data gathered for the claim. The logic looks for a specific match on 
an IDs grid first before moving to a general match (All button); for instance, the application 
searches for insurance carrier X before looking for a row that applies to all insurance carriers.   

The logic continues matching the other various selections on the grids. For instance, if one or 
more entries are on the grid, the application would see which entries match the facility on the 
claim. This pattern has a specific order and follows the left to right layout on the IDs grid. For 
instance, on the Practice IDs grid, the logic looks at provider code first, then insurance carrier, 
then facility, etc. 

For instance if you are setting up a group practice with three doctors, you would need to have 
at least one rule (grid entry) on the Practice IDs grid and one rule on the Providers IDs grid for 
each provider (three rules). You must include an entry for each provider on the Provider IDs 
grid since you define your claim filing status (individual or group) here. For this general rule on 
the Practice IDs grid, you could apply it to all providers, all insurance carriers, and all facilities 
(assuming you have no facilities associated with your practice or all facilities would use the 
same details).  

In this entry, you could include your group NPI, taxonomy, and tax ID numbers. Then on the 
Providers ID grid, you would create one grid entry for each provider. Each of these initial entries 
would be general and could apply to all insurance carriers and facilities. You would also select 
Group for your claim type and could select From Practice to pull NPI, taxonomy, and Tax IDs 
from the Practice IDs grid. If one of the insurance carriers that your practice accepts requires a 
legacy identifier, you would create a second entry on the Practice IDs grid. By creating a 
second entry on this grid instead of the Provider IDs grid, you save time and effort since one 
specific entry could be applied to all the providers at the practice level instead of creating an 
entry for each provider on the provider level. In this second entry, you would select the 
insurance carrier and select all providers. Importantly, you would need to include your NPI, 
taxonomy, and Tax IDs since each grid entry needs to be complete. You would also select the 
legacy number your carrier requires. When the application gathers claim data, it would select 
this row for the specific insurance carrier and pull the data for the claim. 

If one of the providers in your practice files claims as an individual with an insurance carrier the 
other providers do not use, you would need to create another rule on the Provider IDs grid for 
that provider. In this grid entry, you would specify the insurance carrier. You would also change 
your filing status to Individual and enter the provider's NPI number, not the group NPI number. 
You could also include the taxonomy and tax ID/social security number in this grid entry.    
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NPI Setup Considerations 

Depending on the setup of your practice and your claim submission requirements, you can 
enter the NPI number on the Practice window, the Practice IDs grid, the Provider window, the 
Providers IDs grid, or on both windows.  

Solo Provider (file claims as an individual) 

If you are a solo provider (file claims as an individual) with the same pay to as your billing 
address (the Pay To tab is blank), you can enter your NPI information on the Practice IDs grid. 
In this case, you would select on the Providers IDs grid the From Practice button instead of 
selecting the National Provider ID button and entering an NPI number. 

If you are a solo provider with different billing information and pay to information (the Pay To 
tab is complete), you can enter your NPI information on the Provider IDs grid. In this case, you 
would select on the Providers IDs grid the National Provider ID button and enter your NPI 
number. Entering the NPI number on the provider level is required in this case to pull your NPI 
number in Loop 2010AB. If you left it only on the practice level, the NPI number would not pull 
for this loop.  

If you are a solo provider that has insurance carriers that require mixed NPI numbers (some 
require individual while some require a group), you would enter your group NPI number on the 
Practice IDs grid. You would then create an entry on the Provider IDs grid in which you would 
enter your individual NPI number on the Provider IDs grid and apply it to all insurance carriers, 
an insurance class, or a carrier (you could create several records if needed to address other 
issues such as legacy numbers, taxonomy, etc.). For those carriers that require the group NPI, 
you would create at least one other separate entry on the Providers IDs grid (might need more, 
depending on other issues such as legacy numbers, taxonomy, etc.) for that carrier or 
insurance class in which you select the From Practice button instead of selecting the National 
Provider ID button and entering an NPI number.  

Member of a Group (file claims as a group) 

If you file claims as a group, you can enter your NPI information on the Practice IDs grid. In this 
case, you would select on the Providers IDs grid the From Practice button instead of selecting 
the National Provider ID button and entering an NPI number. 

Mixed NPI Numbers 

If you have insurance carriers that require mixed NPI numbers (some require individual NPI 
numbers while some require a group), you would enter your group NPI number on the Practice 
IDs grid. You would then create entries on the Provider IDs grid in which you would enter your 
the specific provider’s individual NPI number on Provider IDs grid and apply it to a specific 
insurance carrier or an insurance category (you could create several records if needed to 
address other issues such as legacy numbers, taxonomy, etc.). For more information, see:  
 
F1   Entering and Editing Provider Information 
 

Claim Filing Setup for Individuals and Groups 

You set your claim filing status on the Providers window on the Provider IDs matrix by selecting 
either the Individual or Group buttons. If you always file claims one way (either as an individual 
or a group), you can select that button and apply this setting to all insurance carriers set up in 
the system by selecting the All button (might need to create other entries to address issues with 
NPI numbers, taxonomy, legacy numbers); if some insurance carriers require you to file as 
group or individual (opposite of your first entry on the grid), you could create a second entry to 
address this situation on the Providers ID, in which you select the insurance company and 
select group.  
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Assigning Rules 

Medisoft claim processing for both print and electronic claims depends on a series of flexible 
rules that you define on the various ID grids in the application. When setting up or updating 
your practice data, you will create a series of grid entries (rules) on the Practice IDs and 
Provider IDs grid. You may also use the Facility IDs and Referring Provider IDs grids depending 
on your practice structure. These grid entries that you complete contain your basic practice 
information such group or individual NPI, taxonomy, tax IDs, claim filing status (group or 
individual) and connect this information to the insurance carriers that your practice accepts and 
the doctors in your practice as a series of rules. 

You begin by creating general entries for each provider on the Provider IDs grid and at least 
one entry on the Practice IDs grid level.   

NOTE: the setup for solo providers offers more flexibility. Also taxonomy requirements or 
NPI setup considerations can impact how you create your practice.  

In these general entries you enter information that would apply to the most generic situation. 
Then you would create other grid entries that apply to a specific insurance carrier, insurance 
class, facility, provider etc.  

TIP: when creating or editing IDs grid entries, do not create matching wild card entries (all 
selected for insurance company and insurance class) since the rules engine would not 
know which row to select. If you had different legacy numbers, for instance in each entry, 
the system might not select the correct row. In this case, modify one of the wild card rows 
and apply it to a specific insurance carrier or class. 

When you create claims, the application gathers general data and then selects data from the 
IDs grids by analyzing the entries (rows) on the various IDs grids.  The process of selecting the 
correct row involves first selecting a row that applies to the insurance carrier, provider or 
provider class. If more than one row is present on the various ID grids, the application matches 
the row on an IDs grid to the data gathered for the claim. The logic looks for a specific match on 
an IDs grid first before moving to a general match (All button); for instance the application 
searches for insurance carrier X before looking for a row that applies to all insurance carriers.   

The logic continues matching the other various selections on the grids. For instance, if one or 
more entries are on the grid, the application would see which entries match the facility on the 
claim. This pattern has a specific order and follows the left to right layout on the IDs grid. For 
instance, on the Practice IDs grid, the logic looks at provider code first, then insurance carrier, 
then facility, etc. 

For instance if you are setting up a group practice with three doctors, you would need to have 
at least one rule (grid entry) on the Practice IDs grid and one rule on the Providers IDs grid for 
each provider (three rules). You must include an entry for each provider on the Provider IDs 
grid since you define your claim filing status (individual or group) here. For this general rule on 
the Practice IDs grid, you could apply it to all providers, all insurance carriers, and all facilities 
(assuming you have no facilities associated with your practice or all facilities would use the 
same details).  

NOTE: for more information on setting up a facility, see the topic Facility Information. 

In this entry, you could include your group NPI, taxonomy, and tax ID numbers. Then on the 
Providers ID grid, you would create one grid entry for each provider. Each of these initial entries 
would be general and could apply to all insurance carriers and facilities. You would also select 
Group for your claim type and could select From Practice to pull NPI, taxonomy and Tax IDs 
from the Practice IDs grid. If one of the insurance carriers that your practice accepts requires a 
legacy identifier, you would create a second entry on the Practice IDs grid. By creating a 
second entry on this grid instead of the Provider IDs grid, you save time and effort since one 
specific entry could be applied to all the providers at the practice level instead of creating an 
entry for each provider on the provider level. In this second entry, you would select the 
insurance carrier and select all providers. Importantly, you would need to include your NPI, 
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taxonomy, and Tax IDs since each grid entry needs to be complete. You would also select the 
legacy number your carrier requires. When the application gathers claim data it would select 
this row for the specific insurance company and pull the data for the claim. 

If one of the providers in your practice files claims as an individual with an insurance carrier the 
other providers do not use, you would need to create another rule on the Provider IDs grid for 
that provider. In this grid entry, you would specify the insurance carrier. You would also change 
your filing status to Individual and enter the provider's NPI number, not the group NPI number. 
You could also include the taxonomy and tax ID/social security number in this grid entry.    

 

Setup Activities After Data Conversion   

 

If you are converting data from an existing Medisoft practice, then you will need to review/select 
your claim filing status (individual or group) for each provider in your practice.   

To select your filing status  
1. Click Lists, select Provider, select Providers. 

2. On the Provider List window, select a provider and click Edit. 

3. Review the data on the Address tab and update as necessary. Click the Provider IDs 
tab. 

4. The conversion process will have created at least one entry for the provider.  

5. On the Provider IDs grid, select the first entry and click Edit. The Edit Provider IDs 
window opens.  

6. If you file claims as an individual, make sure the Files Claims As Individual button is 
selected. 

7. If you file claims as a group, make sure the Files Claims As Group button is selected. 

8. Click OK. 

Repeat steps 4-7 for any other entries in the grid. When complete, repeat the steps for any 
other providers in the practice.  

To provide the highest level of data integrity and accuracy, the conversion process for Medisoft 
17 provider/practice setup does not delete information while creating grid entries that might still 
be needed, such as legacy information (Blue Cross provider numbers, Medicare provider 
numbers, etc.) but converts this data to a grid entry in Medisoft 17. Before filing claims, you will 
also need to finalize your grid entries making sure to remove unnecessary data such as out-of-
date legacy numbers.  

This activity is especially important for any data entered on PINs tab in previous versions of 
Medisoft and also if you used the NPI Only check box on the Insurance Carriers window. Since 
data was converted instead of deleted to provide a high level of data accuracy in Medisoft 17, 
you will need to remove out-of-date legacy numbers from the new grid entries. 

For instance, if you had an entry in the PINS tab in Medisoft 15 for a Medicare provider number 
and then at a later date selected the NPI only check box on the Insurance Carrier window for 
this insurance carrier, this legacy number will be converted in Medisoft 17. Before filing a claim 
with this carrier, you would need to remove this from the grid entry in Medisoft 17. In this 
example, you would click Lists, select Provider, and select Providers. On the Provider List 
window, select the provider. Click the Provider IDs tab. When the data converted, the insurance 
carrier that had required the Medicare provider number will have a specific row on the Provider 
IDs grid. Select that row and click Edit. Then in the Legacy Identifier 1 field, select the None 
button. Click Save. You would repeat this process for any other legacy data that is out-of-date. 

You will also need to examine each IDs grid (Practice, Provider, Referring Provider, and 
Facility) before completing print or electronic claims. This step is critical for success, especially 
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when converting data, with multiple legacy numbers. For instance, if your practice in Medisoft 
15 had a referring provider record that had multiple entries on the PINs tab, Referring Provider 
window, the conversion process will re-create these entries as separate rows, for instance four 
entries in Medisoft 15 would translate into four entries on the Referring Provider IDs grid. All of 
these entries would be generic (wild card) rows without any selection of an insurance carrier. 
These grid entries, however, need modification since all four would be generic/ wild card rows 
in which all is selected for insurance carrier.  

Before filing claims, you would need to first examine the legacy numbers and see if all are still 
needed. Then, you would begin adding, deleting, or editing entries to match your claim filling 
needs. For instance, you might keep the generic/wild card row since this information is needed 
for most of the insurance carriers you file claims with. Then, you might select one of the other 
legacy wild card rows (the rows in which All insurance carriers and all insurance classes are 
selected) and apply this rule to a specific insurance carrier or class. If needed, you could add a 
second legacy number if the carrier required it. You could delete the other entries or apply an 
insurance carrier or class to the entry. 

If you do not review and modify your ID grid entries, you can potentially have problems when 
filing claims if you leave multiple wild card rows (all selected for insurance carriers and 
insurance classes) since the rules engine would not know what rule to select. In this case, the 
rules engine might select the correct (most complete wild card row) row but could also pull one 
that contained the wrong legacy id resulting in a claim rejection.  

 

Setting Program Options 

The Program Options window contains set conditions which affect fields and program 
operations in different parts of the program.  Go to the File menu and select Program Options. 
The Program Options window opens. 

 

 

TIP: During initial setup, for most users the default settings on the various tabs on the 
window, are sufficient for initial use. You can customize these settings at a later date.   
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Each tab features settings for different functional elements in the application. For more 
information on the available options and settings, see:  
 
General Tab  

Data Entry Tab 

Payment Application Tab 

Aging Reports Tab 

HIPAA Tab 

Color-Coding Tab 

Billing Tab 

Audit Tab 

BillFlash Tab 

 

Security Setup Overview 

Medisoft Standard Security  

Basic security in Medisoft is practice based with each practice having various users and 
groups. Multiple practices require security setup for each database.  Set up security when 
nobody else is using the program. You create users in the User Entry window--click File, select 
Security Setup, and click New. 

 

 

After you set up security, close and open the practice to apply the changes. Users that you 
create are displayed in the Security Setup List window. 
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Security in Medisoft Advanced and Medisoft Network Professional allows restricted levels of 
access to those areas of the program that the security supervisor designates.  The supervisor 
has unlimited access and full control of security, while other users are restricted to varying 
degrees.  See Permissions.  You can also manage password settings, such as how frequently 
a user must change the password.  Once at least one Level 1 user has been entered, you can 
add more names, edit entries, or delete entries as necessary.  

F1   Look up Login/Password Management.  

In Medisoft Basic, you can define a user as an Administrator, which grants the user access to 
the Security Setup window and the ability to create users. If you are creating an administrator, 
make sure that you select the Administrator check box. The first user needs to be designated 
the Administrator.  

Through the Security Setup window, you are also able to assign users to groups.  Grouping 
users by job function or security level can help you easily assign tasks or send messages to a 
number of people at once. 
 

 

 

F1   Look up Medisoft Standard Security 

 

If desired, Level One users can also set up and apply the Global Login feature. The Global 
Login function provides an extra layer of security and added convenience for users that access 
multiple practices and applications.  

F1   Look up Global Login Overview. 

Login/Password Management 
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In Login/Password Management, the supervisor sets the requirements and application of login 
rights and password usage.  For example, you can set the length of valid passwords, the valid 
time frame in which a password can be used before it has to be changed, how long a user has 
to wait before reusing a password, etc.   

 

 

 

F1   Look up Login/Password Management 

 

Setting Permissions 

Permissions 

NOTE: This is an Advanced and above feature.  

The Permissions feature provides five levels of access to the program. The Security 
Supervisor, who has unlimited access and full control of security, can assign or remove rights 
for any level of security, with one exception.  Level 1 access cannot be removed from any of 
the three options listed in the Security window settings for the Supervisor.  Lower level access 
can be added, but the Supervisor must retain rights to these options. 

Go to the File menu and select Permissions to open the Medisoft Security Permissions 
window or select Report Permissions to open the Medisoft Reports Permission window 
which is used is to set permissions for most reports available in Medisoft and in the Medisoft 
Reports engine. Permissions for most statements and other reports using the .MRE extention, 
however, are set in the Medisoft Security Permissions window.  

NOTE: These options do not appear on the File menu until the security has been applied to 
practice with users created in the Security Setup window. 
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Level 1 is for unlimited access and is designed to be used exclusively by the Supervisor or 
administrator to restrict access to the program.  Levels 2, 3, 4, and 5 can be user-defined with 
the Supervisor deciding what fits in what level and assigning users accordingly.  Generally, the 
higher the level number, the fewer rights are assigned to it.  Add or remove check marks for 
level access by clicking the appropriate check box for each process displayed with each listed 
window name. 

If a task is attempted by a user who does not have rights to that task, based on the security 
level assigned, a warning dialog box is displayed stating that the user does not have the 
authority to perform the requested task.   

Once the security feature is used, the File menu contains an additional option, Log In As 
Another User. 

 

Entering Practice Information 

Setup Scenarios  

Before setting up a practice, consider reviewing the topic An Overview of Setting up a Practice. 
This topic reviews setup order and has links to other topics with specific instructions for setting 
up providers. Also consider reviewing the material in the various topics in the Getting Started 
section of the help file.  

 

If you are a solo provider, you can use two different methods to set up your practice. 

For instance, you can enter key elements such as NPI, taxonomy, and tax ID/social security 
number on the Practice level or in the Practice IDs grid. Then, you would need to create at least 
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one record (can create more if you have different requirements from various insurance carriers) 
on the Provider IDs grid in which you select the From Practice button for these data elements. 
Selecting From Practice will pull these values for claims from the Practice IDs grid. 

Or, when setting up your practice (assuming you do not need to send taxonomy in Loop 
2000A), you could on the Practice IDs grid select None for NPI, taxonomy, tax ID/social security 
number and enter a minimal amount of information of Practice IDs grid (still need at least one 
record). You would then create at least one record on the Provider IDs grid in which you specify 
your NPI, taxonomy, and tax ID/social security number. 

If you are a group practice, then you will complete at least one grid entry on the Practice IDs 
grid for the practice. You will also create at least one grid entry on the Provider IDs grid for each 
provider. If you have a provider that in some instances bills using his/her own NPI number for a 
specific insurance carrier, you can create an extra grid entry for this provider, in which you 
specify the insurance company and select to pull the provider's NPI number from the Provider 
IDs grid. 

 

For more information, see:  
 
F1   Entering and Editing Practice Information 

For more information, see:  
 
F1   Entering and Editing Provider Information. 

Billing Service or Different Pay To Address 

If your pay to address is different from your service address, you will also need to complete the 
Practice Pay To tab. You will also complete this tab if you are a billing service. 

Bill Flash Users 

If you want to send statements electronically, you must use Bill Flash. You will also complete 
the Statement Pay To tab. Data on this tab is used to create a separate pay-to address location 
for the statements, for instance, a PO Box instead of a physical address.  When you generate 
Bill Flash report forms in Medisoft, data is pulled from this tab. 

Practice Type  

The practice Type field is a drop-down list.  Click on the arrow to view the entry options, i.e., 
Medical, Chiropractic, and Anesthesia.  Each option controls special fields within the program.   

Medical: This is the general setting for all healthcare groups except Chiropractic and 
Anesthesiology.   

Chiropractic: Choosing Chiropractic activates the Level of Subluxation field in the 
diagnosis section of the patient case file.  When set as Medical or Anesthesia, this field is not 
available.   

Anesthesia: The Anesthesia choice adds a Minutes field in the Transaction Entry window 
for entering charges in transaction billing functions.   

Entering Practice Information 

1. Click File and select Practice Information. Click the Practice tab.  
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2. On the Practice tab enter the contact information for practice including practice name, 
address, telephone number, etc.  

3. From the Type list select your practice type. Choices include Medical, Chiropractic, 
and Anesthesia.  When you choose Chiropractic or Anesthesia, other areas in the 
program change accordingly. Medical is the default practice type and does not add any 
additional fields. 
 
When you select Chiropractic, the Level of Subluxation field appears in the 
Diagnosis tab of the Case window for entering the level of subluxation. See Case 
(Diagnosis). In addition, five treatment fields are displayed in the Miscellaneous tab of 
the Case window electronic claims: Treatment Months/Years, No. Treatments-
Month, Nature of Condition, Date of Manifestation, and Complication Ind. See 
Case (Miscellaneous). 

4. In the Federal Tax ID field enter the practice's federal tax ID.  

5. From Practice Type, select Individual or Group.  

6. From Entity Type, select Person or Non-Person. Choose Person or Non-Person 
depending on whether the practice name consists of a practice name or an individual’s 
name.  For example, if the practice name is Western Associates Clinic, you would 
choose Non-Person.  However, if the practice name is Dr. John Smith, you would 
choose Person. 

NOTE: Extra 1 and Extra 2 are optional fields that may be used if a carrier requires extra 
data on a claim.  They can hold up to 30 characters.  

 

Entering a Practice IDs Grid Entry 

Use the Practice IDs tab and Practice IDs grid to enter or edit key data elements associated 
with your practice (tax ID/social security number, NPI, taxonomy, legacy numbers, etc). You will 
set up at least one entry (rule) on the Practice IDs grid and associate this information to all 
providers, insurance carriers or insurance categories, and all facilities or a particular provider or 
carrier, and an insurance category or any combination of these elements. For more information 
on entering data on the IDs grid, see the topic, Assigning Rules. 

This grid contains two elements. The first displays all current entries (rules). The second 
element, the New/Edit Practice ID window, is used to edit or create entries. The grid displays 
insurance carrier, insurance class, facility, NPI, Taxonomy, tax ID/ social security number and 
legacy data. 
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TIP: when creating or editing IDs grid entries, do not create matching wild card entries (all 
selected for insurance carrier and insurance class) since the rules engine would not know 
which row to select. If you had different legacy numbers, for instance in each entry, the 
system might not select the correct row. In this case, modify one of the wild card rows and 
apply it to a specific insurance carrier or class.  
 
TIP: Press CTRL + DELETE to delete all ID entries in the Practice, Provider, Referring 
Provider, or Facilities IDs grids. Use this with caution since all your entries will be removed. 
If you have numerous legacy ID entries that no longer apply and only a few rows that need 
to be set up, you save time by deleting all entries and setting up the few rows you need. 

1. Click Practice IDs tab. 
 

 
  

2. Click the New button to create a new grid entry.  
 
--OR-- 
 
 
To edit an entry, select the record on the grid and click Edit.  
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3. Select the All, Provider, or Provider Class button.  
 
Select the All button to apply the rule to all providers associated with the practice.  
 
To apply the rule to a specific provider, select the Provider button and click the 
magnifying glass to select the specific provider.  
 
To apply the rule to a specific provider class, select the Provider Class button and click 
the magnifying glass to select the provider class. 

4. Select the All, Insurance Carrier, or Insurance Class button.  
 
Select the All button to apply the rule to all insurance carriers associated with the 
practice.  
 
To apply the rule to a specific insurance company, select the Insurance Carrier button 
and click the magnifying glass to select the insurance carrier.  
 
To apply the rule to a specific insurance class, select the Insurance Class button and 
click the magnifying glass to select the insurance class.  

5. Select either the All or Facility button.  
 
Select the All button to apply the rule to all facilities associated with the practice.  
 
To apply the rule to a specific facility, select the Facility button and click the magnifying 
glass to select the facility.  

6. Select either the None or National Provider ID button.   
 
Select the None button to not associate an NPI number with the rule.  
 
Select the National Provider ID button and enter an NPI number to associate that NPI 
number with rule. 
 
TIP: if your practice has a group NPI number, enter it here. Then, if providers in your 
office need to file claims as individuals, you can create a rule for that provider using the 
provider's individual NPI number that you enter on the Provider IDs grid.  

7. Select either None or Taxonomy.  
 
Select the None button to not associate a taxonomy number with the rule.  
 
Select the Taxonomy button and enter a taxonomy number to associate that taxonomy 
number with rule. If your carrier requires this taxonomy number on a claim, you will also 
need to select the Send Practice Taxonomy in Loop 2000A box on the EDI/Eligibility tab 
of the Insurance Carrier window. 

8. Select the None, Tax Identifier, or Social Security Number button.  
 
Select the None button to not associate a tax ID or social security number with the rule.  
 
Select the Tax Identifier button and enter the tax ID number to associate with the rule.  
 
Select the Social Security Number button and enter the social security number to 
associate with the rule.    
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9. If needed, enter up to two legacy numbers and qualifiers to associate with the rule using 
the Legacy Identifier 1 and 2 fields. Use these fields to customize your rule to meet 
filing requirements with an insurance carrier(s). 
 
For each entry select either None or Legacy Identifier.  
 
Select the None button to not associate a legacy number with the rule.  
 
To associate a legacy number with the rule (for instance a Medicare Provider Number), 
select the Legacy Identifier button, enter the legacy number, and select an ID qualifier 
to associate with the rule.  

Entering Practice Information for a Billing Service 

Billing Services 

If you are a billing service, enter your client’s information in the Practice tab.  Enter your 
information in the Billing Service tab.  If you want to use the Medisoft program to keep track of 
your own accounts receivables, a separate database can be set up with each client listed as a 
patient.  Separate procedure codes can be created to cover the various services of your billing 
service. 

 

Billing Service or Different Pay To Address 

If your pay to address is different from your service address, you will also need to complete the 
Practice Pay To tab. You will also complete this tab if you are a billing service. 

1. Click File and select Practice Information. Click the Practice Pay-To tab. 
 

 

2. Enter the pay to information in the Practice Name, Street, City, State, Zip Code, etc. 
fields. 
 
NOTE: the Extra 1 and Extra 2 fields are only used if a carrier requires extra data on a 
claim.  

3. Click Save. 

 

Bill Flash Users 

If you use Bill Flash for electronic statement processing, you will also complete the Statement 
Pay To tab. Data on this tab is used to create a separate pay-to address location for the 
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statements, for instance a PO Box instead of a physical address.  When you generate Bill Flash 
report forms in Medisoft, data is pulled from this tab. 

 
1. Click File and select Practice Information. Click the Statement Pay-To tab. 

 

 
  

2.  Enter the pay to information in the Practice Name, Street, City, State, Zip Code, etc. 
fields. 
 
NOTE: the Extra 1 and Extra 2 fields are only used if a carrier requires extra data on a 
claim.  

3. Click Save. 

 

 

EDI Receiver Records 

The EDI Receivers window displays parameters used for transmitting information to a 
clearinghouse.  Go to the Lists menu and select EDI Receivers.  The EDI Receiver List window 
opens.  Click Edit to modify an existing record.  The EDI Receiver window opens. 
 
The settings in Medisoft on the EDI Receivers window are used for setting rules for electronic 
claims generation. The actual transmission of claims is driven by Revenue Management. If you 
make changes on these tabs in Medisoft, the changes transmit to Revenue Management and 
changes made there are also transferred to Medisoft. 

When sending electronic claims, you will set up your clearinghouse or direct payors in Revenue 
Management. Once an EDI receiver is set up, Revenue Management will synchronize the EDI 
settings in Medisoft. For users upgrading to Medisoft 17, Revenue Management can use the 
existing settings for the payors set up on the EDI Receivers window, but you will need to 
reconfigure receivers to work with Revenue Management. 
 

NOTE: The Group Practice box on the EDI Receivers window IDs tab (available in Medisoft 
15), is removed.  This functionality is moved to the Provider window, Provider IDs tab. On 
this window you can assign to all insurance carriers, an insurance class, or a specific 
insurance carrier per provider, whether you file claims as a group or as an individual. This 
change provides greater flexibility since you will no longer need to possibly create two 
versions of the same receiver to address cases in which you had sent claims as a group 
and as an individual. Now, you can create as many records on the Provider IDs grid as 
needed to address your claim submission needs using the same receiver. 
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F1   Look up EDI Receiver Entry 

  

Setting up Insurance Carriers and Insurance Classes 

Setting up the insurance carriers correctly is essential to getting claims paid in a timely 
manner.  Go to the Lists menu and select Insurance.  Select Carriers from the drop-down 
menu or click the Insurance Carrier speed button.   

  

Insurance Classes 

Use this window to create insurance classes, such as Blue Shield or Medicare.  Use these 
classes to group insurance carriers for easier reporting.  Go to the Lists menu and select 
Insurance.  Select Classes from the drop-down menu. The Insurance Class List window 
appears.   
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To create a new insurance class, click New or press F8.  To edit a class, click Edit or press 
F9.   Enter an ID, Name, and Description for the class.  Insurance classes are assigned in the 
Insurance Carrier Entry window, Options tab.  

  

 
 
F1   Look up Insurance Class Entry 

  

Insurance Carriers 

1. Click Lists, click Insurance, and select Carriers. The Insurance Carrier List window 
opens.  
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2. Click New. 
 
--OR-- 
 
Select an entry on the Insurance Carrier List grid and click Edit.  The Insurance 
Carrier window opens. 

3. Click the Address tab. Enter the company's contact information in fields such as Name, 
Address 1, Address 2, City, State, ZIP Code, Telephone, and Fax.   
 
In the Contact field, enter a contact name at the insurance carrier. 
 
In the Plan Name field, enter the plan name administered by this carrier.  
 
From the Class list, select an insurance class to assign to the carrier: This field lets you 
assign the carrier to a dynamic list of classes you create yourself.  Insurance classes 
are then used by the rules engine for selecting an entry on the various IDs grids in the 
application. For more information on the rules engine and assigning rules, see the topic 
Assigning Rules.    
 
NOTE: Insurance classes are created on the Insurance Class window (Lists, Insurance, 
Classes). For more information, see the topic Insurance Class Entry.  
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4. Click the Options and Codes tab.  
 

 
 

5. From the Procedure Code and Diagnosis Code Set lists, select a procedure code set 
(1, 2, or 3) and a diagnosis code set (1, 2, or 3) to apply to the insurance carrier. 
Medisoft gives you the ability to assign up to three codes to the same procedure.  By 
using this field, the claims for each carrier can contain the correct code. For more 
information, see Procedure/Payment/Adjustment Entry. 
  

6. From the Patient, Insured, or Physician Signature on File lists, for each option 
select, Leave blank, Signature on file, or Print name. 
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These fields control what is printed in the signature Boxes 12, 13, and 31, respectively, 
on the CMS - 1500 claim form.  These fields do not control whether anything is printed 
in these boxes, but what is printed.  Whether anything prints is controlled by settings on 
the Case window, Policy tab, Accept Assignment and Benefits Assigned field, and 
Provider window, Address tab, Signature on File field.  
 
The Signature on file option prints "Signature on File" (if the Signature on file field has 
been activated in the patient and provider records). 
 
The Print name option prints the name of the patient, insured, or physician. 
 
The Leave blank option prints nothing.  

7. From the Print PINs on Forms list select PIN Only or Leave Blank.  
 
When setting up Medicare and Medicaid carriers for printed claims, select PIN Only; 
otherwise, select Leave Blank. 

8. From the Default Billing Method 1, 2, and 3 lists select either Paper or Electronic for 
handling  primary (1), secondary (2), and tertiary (3) claims.  Select Paper if claims are 
to be printed; select Electronic if claims are to be transmitted electronically.  

9. In the Default Payment Application Codes box select default payment codes. 
 
Payment: Click the down arrow to select a default payment code. 
 
Adjustment: Click the down arrow to select a default adjustment code. 
 
Withhold: Click the down arrow to select a default code for entering withhold amounts.  
 
Deductible: Click the down arrow to select a default code for entering deductibles. 
 
Take Back: Click the down arrow to select a default code for entering take backs. 

10. Click the EDI/Eligibility tab. The EDI/Eligibility tab is mostly used for electronic claims.  
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11. In the Primary Receiver panel on the EDI Receiver list, click the magnifying glass and 
select an EDI receiver you use when sending electronic claims for primary insurances. 
 If you do not enter an EDI receiver in the EDI Receiver field, electronic claims will not 
be created or sent for this insurance company.  

12. In the Claims Payer ID field enter the payer ID for the insurance carrier. Refer to the 
enrollment information you received from the carrier/clearinghouse and look up the 
commercial identification number/ submitter identification numbers assigned to the 
insurance company by the clearinghouse. 
 
Option: click the Payer ID magnifying glass to look this up using the pre-loaded 
database which contains many payer IDs. 

13. If you use the eligibility verification service and want to verify eligibility with this 
insurance carrier, in the Eligibility Payer ID field, enter the payer ID (for some carriers, 
the eligibility payer ID is different from the payer ID). Refer to the enrollment information 
you received from the clearinghouse and look up the commercial identification number/ 
submitter identification numbers assigned to the insurance company by the 
clearinghouse. 
 
Option: click the Payer ID magnifying glass to look this up using the pre-loaded 
database which contains many payer IDs.  

14. Option: The National Plan ID field is not yet mandated. If you have received an ID 
number, enter it in this field.  

15. If you file secondary claims with the insurance company, select/enter values on the 
Secondary Receiver panel for the EDI Receiver, Claims Payer ID, Eligibility Payer ID, 
and National Plan ID fields. If you do not enter an EDI receiver in this section of the 
window, electronic claims will not be created or sent for this insurance company for 
secondary claims. 

16. From the Type list select a type for the insurance company from the following options: 
Automobile, Blue Cross/Shield, Central Cert, ChampsVA, Disability, EOP, FECA, 
Group, HMO, Indemnity, Liability, Library Medical, Medicaid, Medicare,  Medicare Part 
A, Mutually Defined, No Charge, Other, Other Federal, Other non-federal, POS, PPO, 
Self-pay, Title V, Tricare/Champus, Unknown, and Worker’s Compensation.. 

17. Leave Alternate Carrier ID blank. The Revenue Management feature will populate this 
field if needed. 

18. The NDC Record Code field is also used by the Revenue Management feature.  

19. If needed, select from the EDI Max Transactions list, a maximum number of 
transactions accepted by the carrier.  This field is available for those carriers that limit 
the number of transactions per claim accepted electronically.  If you submit more than 
the maximum number of transactions per claim, the program automatically splits the 
claim.   

20. If the insurance carrier is used as both a primary EDI insurer and a Medigap insurer, in 
the EDI Extra 1/Medigap field, enter the Medigap number in this field. The number 
entered is the COBA Medigap claim-based identifier received from the national 
Coordination of Benefits Contractor (COBC).  

21. The EDI Extra 2 field is used by the Revenue Management feature. 

22. Select the Complimentary Crossover box if you are filing complimentary crossover 
claims.  Secondary insurance will not be sent in the claim file.  However, the program 
will mark the secondary as sent.  If you are sending Medigap claims, do not select this 
box. 
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23. Delay Secondary Billing: If there is a secondary insurance company, you can delay 
printing the secondary claim form until a response is recorded from the primary carrier 
by selecting the Delay Secondary Billing box. To print the secondary claim form at the 
same time the primary is printed, leave the box empty (which is the default setting). 

24. Select the Send Ordering Provider in Loop 2420E box to send ordering provider 
information on an electronic claim. 

25. Select the Send Practice Taxonomy in Loop 2000A box to send taxonomy in Loop 
2000A for electronic claims. Loop 2000A is usually used to report taxonomy for 
individual providers though some carriers require here and in 2310. Contact your carrier 
for more on their taxonomy requirements. For more information on setting up taxonomy 
in Medisoft, see the topic Taxonomy. 

26. Options: Click the Allowed tab.  
 

 
 
This displays the amount last paid by the selected carrier for each procedure code 
available in the program. If you do not enter anything in this table, each time a carrier 
makes a payment on a particular procedure code, the program takes the amount paid 
plus any deductible and divides it by the established Service Classification percentage 
to arrive at the allowed amount.  That amount is entered in this matrix and in a matching 
matrix that is part of the Procedure/Payment/Adjustment Code record.  
 
This allowed amount is used when calculating the patient portion estimate of any 
procedure in the Transaction Entry window. The existing allowed amount can be 
changed in the Transaction Entry window by clicking the Allowed Amt column and 
entering the corrected amount. 

27. Click Save. 

  

  

Facility Information 

Setup Scenarios  
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If you have a facility or a lab attached/affiliated with your practice, you will need to create a 
record for it. There are two components to the record: contact/demographic data entered on the 
Address tab and billing-specific information entered on the Facility IDs tab.  

If you have enumerated a separate NPI number for your facility and need to send facility billing 
information in Loop 2420D or pull data for box 32 of the CMS 1500 form, you can specify the 
type of facility and qualifier (77- service location, FA - Facility, LI - Independent Lab, TL - 
Testing Laboratory, etc.) along with including a separate facility NPI number and if this 
information is sent on the claim by selecting the Send Facility on Claim check box. 

 

Entering Contact Information 

1. Click Lists and select Facilities.  The Facility List window opens.  
 

 
 
  

2. Click New. 
 
--OR-- 
 
Option: select a record on the Facility List grid and click Edit. 

3. Click the Address tab. 
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4. Enter contact data associated with the facility including a name, address, telephone 
number, etc. If the facility is a lab, select the Laboratory button; if the facility is not, 
select Facility. 

5. Click Save if finished or go to the next section for information on entering data on the 
Facility IDs tab. 

 

Entering Information on the Facility IDs grid 

Use the Facility IDs tab and Facility IDs grid to enter or edit key data elements associated 
with a facility (NPI number, taxonomy number, CLIA number, legacy numbers, etc.). If your 
practice is associated with a facility or a lab, you will set up at least one entry (rule) on the 
Facility IDs grid and associate this information to all or a specific insurance carrier or an 
insurance class.  

For more information on entering data on the IDs grid, see the topic, Assigning Rules. 

When creating or editing a facility IDs record, you will first create/modify a rule based a 
combination of all or of a specific insurance carrier or insurance class. When processing claims, 
the rules engine uses this information to select the correct entry on the grid. 

The second part of creating or editing a facility ID record is to select if facility data will appear 
on a claim along with selecting a qualifier for the facility and associating other data elements to 
pull for a claim including a combination of none or a specific NPI, taxonomy number, CLIA 
number, and legacy data (if you need to send information in Loop 2420D or box 32 of the CMS 
1500 form). After the rules engine identifies the correct row on the grid, this data is used in 
processing (either print or electronic) the claim. 

TIP: when creating or editing IDs grid entries, do not create matching wild card entries (all 
selected for insurance carrier and insurance class) since the rules engine would not know 
which row to select. If you had different legacy numbers, for instance in each entry, the 
system might not select the correct row. In this case, modify one of the wild card rows and 
apply it to a specific insurance carrier or class. 
 
TIP: Press CTRL + DELETE to delete all ID entries in the Practice, Provider, Referring 
Provider, or Facilities IDs grids. Use this with caution since all your entries will be removed. 
If you have numerous legacy ID entries that no longer apply and only a few rows that need 
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to be set up, you save time by deleting all entries and setting up the few rows you need. 
 

1. Click the Facility IDs tab.  
 
This window contains two elements. The first displays all current entries (rules). The 
second element, the New/Edit Facility IDs window, is used to edit or create entries. The 
grid displays insurance company, insurance category, NPI, Taxonomy, CLIA, and 
legacy data. 
 

 
  

2.  Click the New button to create a new grid entry.  
 
--OR-- 
 
To edit an entry, select the record on the grid and click Edit.  
 
The New Facility or Edit Facility window opens.  
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3. Select either All, Insurance Carrier, or Insurance Class.  
 
Select the All button to apply the rule to all insurance carriers associated with the 
facility.  
 
To apply the rule to a specific insurance carrier, select the Insurance Carrier button 
and click the magnifying glass to select the insurance carrier.  
 
To apply the rule to a specific insurance class, select the Insurance Class button and 
click the magnifying glass to select the insurance class.  

4. To include facility information on a print or electronic claim (box 32 CMS 1500 form and 
Loop 2420D), select the Send Facility on Claim box and the select an ID Qualifier. 
Leave the box blank (unchecked) to not include facility information on a claim.    

5. Select either None or National Provider ID.  
 
Select the None button to not associate an NPI number with the rule.  
 
Select the National Provider ID button and enter an NPI number to associate the 
facility NPI number with rule.   

6. Select either None or Taxonomy.  
 
Select the None button to not associate a taxonomy number with the rule.  
 
Select the Taxonomy button and enter a taxonomy number to associate that taxonomy 
number with rule.   

7. Select either None or CLIA.  
 
Select the None button to not associate a CLIA number with the rule.  
 
Select the CLIA button and enter a facility CLIA number to associate with rule.   

8. If needed enter up to two legacy numbers and qualifiers to associate with the rule using 
the Legacy Identifier 1 and 2 fields. Use these fields to customize your rule to meet 
filing requirements with an insurance carrier(s). 
 
For each entry select either None or Legacy Identifier.  
 
Select the None button to not associate a legacy number with the rule.  
 
To associate a legacy number with the rule, select the Legacy Identifier button, enter 
the legacy number, and select an ID qualifier to associate with the rule.  

9. Click Save. 

 

Setting up Providers and Provider Classes 

The Provider List is accessed by going to the Lists menu and selecting Providers or by 
clicking the Provider List speed button.  Specific provider information is accessed by clicking 
Edit or pressing F9, and the Provider: (new) setup window is accessed by clicking New or 
pressing F8. 

  

Provider Class Records 
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Use this window to enter classes or groups for providers in your practice.  Grouping providers 
into classes is helpful when sending claims or statements electronically.  Go to the Lists menu 
and select Provider.  Select Class from the drop-down menu.  To create a new class of 
providers, click New or press F8.  To edit a class, click Edit or press F9.  The Provider Class 
List window appears.  Enter a Class ID, Class Name, and Description. Provider classes are 
assigned to specific providers in the Providers window, Reference tab. 

F1   Look up Provider Class Entry 

  

Setup Scenarios  

If you are a solo provider, you can use two different methods to set up your practice. 

If you are a solo provider (file claims as an individual) with the same pay to as your billing 
address (the Pay To tab is blank), you can enter your NPI information on the Practice IDs grid. 
In this case, you would select on the Providers IDs grid the From Practice button instead of 
selecting the National Provider ID button and entering an NPI number. 

If you are a solo provider with different billing information and pay to information (the Pay To 
tab is complete), you can enter your NPI information on the Provider IDs grid. In this case, you 
would select on the Providers IDs grid the National Provider ID button and enter your NPI 
number. Entering the NPI number on the practice level is required in this case to pull your NPI 
number in Loop 2010AB. If you left the NPI number only on the practice level, it would not pull 
for this loop.  

If you are a solo provider with insurance carriers that require mixed NPI numbers (some require 
individual while some require a group) you would enter your group NPI number on the Practice 
IDs grid. You would then create an entry on the Provider IDs grid in which you would enter your 
individual NPI number on Provider IDs grid and apply it to all insurance carriers, an insurance 
class, or a carrier (you could create several records if needed to address other issues such as 
legacy numbers, taxonomy, etc.). For those carriers that require the group NPI, you would 
create at least one other separate entry on the Providers IDs grid (might need more depending 
on other issues such as legacy numbers, taxonomy, etc.) for that carrier or that insurance class 
in which you select the From Practice button instead of selecting the National Provider ID 
button and entering an NPI number.  

If you are a group practice, you will complete at least one grid entry on the Practice IDs grid for 
the practice. You will also create at least one grid entry on the Provider IDs grid for each 
provider.  If you have a provider that in some instances bills using his/her own NPI number for a 
specific insurance carrier, you can create an extra grid entry for this provider in which you 
specify the insurance company and select to pull the provider's NPI number from the Provider 
IDs grid. 

  

For more information, see:  
 
F1   Entering and Editing Provider Information 

Entering Provider Information 

1. Click Lists, select Provider and select Providers. The Provider List window opens. 
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2. Click New.  
 
--OR--  
 
Select an entry on the Provider List window and click Edit. The Provider window 
opens. 
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3. Click the Address tab and enter demographic information for the provider such as last 
name, first name, title, etc.  

4. Options: 
 
Select the Medicare Participating Provider box if the provider is considered a 
Medicare participating provider. A Medicare participating provider agrees to accept 
assignment on all Medicare claims for covered services and supplies. This field is 
generally used with electronic claims. 
 
Select the Signature on File box to indicate that the provider's signature is on file. 
Select this box if the provider has signed an agreement with Medicare to accept its 
charges and an affidavit is on file.  If it is checked, the Signature Date field becomes 
active to display the date on which the signature was placed on file.  To enter a date in 
this field, either type the date or click in the Signature Date field or click the down arrow 
to the right of the field and the calendar opens.   

5. In the License field enter the provider's license number. 

6. Click Save if you are finished with the record or click the Reference tab. 
 
The Reference tab displays data and values before the data was converted to Medisoft 
17 and moved to the Provider IDs grid to create rules for claim creation. The tab shows 
data from the Default Pins and Default Group IDs tabs, which were replaced in 
Medisoft 17 with the Provider IDs tab.  
 
This tab is mostly used for reference purpose only. You can update data on this tab for 
your reference purposes, but none of this data is pulled for claim generation--the rules 
engine does not pull any of this data from this tab. The only field that still impacts claims 
is the Provider Class list.  
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7. Option: Assign a provider to a provider class by clicking the Provider Class list and 
selecting a class.   
 
NOTE: Provider classes are set up in the Provider Class List.   
 
When generating claims, the provider class can be used on the Practice IDs tab to limit 
a grid entry rule to a class of providers. You can change a provider's class on this tab to 
put the provider in a different class which in turn would impact the grid entry that is 
selected on the Practice IDs grid.  

8. Click Save if you are finished with the record or click the Provider IDs tab and go to the 
next section Entering Provider IDs Grid Entries.  

  

Entering Provider IDs Grid Entries  

Use the Provider IDs tab and Provider IDs grid to enter or edit key data elements associated 
with a provider (tax ID/social security number, NPI, taxonomy, legacy numbers, etc). You will 
set up at least one entry (rule) on the Provider IDs grid for each provider in your practice and 
associate this information to all insurance carriers or insurance classes and all facilities or a 
particular insurance carrier or an insurance class or any combination of these elements.  

When creating or editing a provider IDs record, you will first create/modify a rule based a 
combination of all or of a specific insurance carrier or insurance class and facility. When 
processing claims, the rules engine uses this information to select the correct entry on the grid. 
 
This grid contains two elements. The first displays all current entries (rules). The second 
element, the New/Edit Provider ID window, is used to edit or create entries. The grid displays 
insurance carrier, insurance class, facility, NPI, Taxonomy, tax ID/ social security number, 
mammography certificate numbers, CLIA numbers, care plan oversight numbers, and legacy 
data.  
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After the rules engine identifies the correct row on the grid, this data is used in processing 
(either print or electronic) the claim. 

For more information on entering data on the IDs grid, see the topic, Assigning Rules. 

TIP: when creating or editing IDs grid entries, do not create matching wild card entries (all 
selected for insurance carriers and insurance class) since the rules engine would not know 
which row to select. If you had different legacy numbers, for instance in each entry, the 
system might not select the correct row. In this case, modify one of the wild card rows and 
apply it to a specific insurance carrier or class. 
 
TIP: Press CTRL + DELETE to delete all ID entries in the Practice, Provider, Referring 
Provider, or Facilities IDs grids. Use this with caution since all your entries will be removed. 
If you have numerous legacy ID entries that no longer apply and only a few rows that need 
to be set up, you save time by deleting all entries and setting up the few rows you need. 

 
1. Click the Provider IDs tab. Click the New button to create an new grid entry.  

 
--OR-- 
 
To edit an entry, select the record on the grid and click Edit. The New/Edit Provider ID 
window opens. 
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2. Select either All, Insurance Carrier, or Insurance Class.  
 
Select the All button to apply the rule to all insurance companies associated with the 
provider.  
 
To apply the rule to a specific insurance carrier, select the Insurance Carrier button 
and click the magnifying glass to select the insurance carrier.  
 
To apply the rule to a specific insurance class, select the Insurance Class button and 
click the magnifying glass to select the insurance class.  

3. Select either All or Facility.  
 
Select the All button to apply the rule to all facilities associated with the provider (select 
this option if there are no facilities associated with the provider).  
 
To apply the rule to a specific facility, select the Facility button and click the magnifying 
glass to select the specific provider.  

4. Select either File Claim As Individual or File Claim As Group.  
 
Select the Individual button if the provider is a solo practitioner or files claims as an 
individual.  
 
Select the Group button if the provider is a member of a group practice or files claims 
as a group.   

5. Select either From Practice or National Provider ID.  
 
TIP: If you do not want to send an NPI number on a claim, select From Practice and 
then on the Practice IDs window, create a matching entry for the provider in which you 
select None for the NPI option. 
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Select the From Practice button to pull NPI number from the Practice IDs grid.  
 
Select the National Provider ID button and enter an NPI number to associate that NPI 
number with the rule.   

6. Select either From Practice or Taxonomy.  
 
TIP: If you do not want to send a taxonomy number on a claim, select From Practice 
and then on the Practice IDs window, create a matching entry for the provider in which 
you select None for the Taxonomy option. 
 
Select the From Practice button to pull the taxonomy number from the Practice IDs grid.   
 
Select the Taxonomy button and enter a taxonomy number to associate that taxonomy 
number with the rule.   
 

7. Select From Practice, Tax Identifier, or Social Security Number. 
 
Select the From Practice button to pull the tax ID/social security number from the 
Practice ID grid. 
 
Select the Tax Identifier button and enter the tax ID number to associate with the rule.  
 
Select the Social Security Number button and enter the social security number to 
associate with the rule.  

8. If you file mammography claims, select the Mammography Cert button and enter the 
certificate number to associate with the rule. Select the None button to not associate a 
mammography certificate number with the rule.   

9. If you file laboratory claims using a CLIA number, select the CLIA button and enter the 
CLIA number to associate with the rule. Select the None button to not associate a CLIA 
number with the rule.    

10. If your carrier requires a care plan oversight number, select the Care Plan Oversight 
button, enter the care plan oversight number, and select an ID qualifier to associate with 
the rule. Select the None button to not associate a care plan oversight number with the 
rule.  

11. If needed, enter up to three legacy and qualifiers to associate with the rule using the 
Legacy Identifier 1, 2, and 3 fields. Use these fields to customize your rule to meet 
filing requirements with an insurance carrier(s). 
 
For each entry, select either None or Legacy Identifier.  
 
Select the None button to not associate a legacy number with the rule.  
 
To associate a legacy number with the rule (for instance a Medicare Provider Number), 
select the Legacy Identifier button, enter the legacy number, and select an ID qualifier, 
and to associate with the rule.  

12. Click Save. 

  

  

Referring Provider Records 
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Many patient visits are the result of a referral from another provider.  When a patient is referred 
to your practice, add data such as the Unique Physician Identification Number (UPIN), NPI, tax 
ID, etc.   

Go to the Lists menu and select Referring Providers.  To enter a new referring provider 
record, press F8 or click New. 

Setup Scenarios  

If you have referring providers affiliated with your practice, you will need to create a record for 
each referring provider. In this record, you can link the provider to a particular insurance 
company/category, if needed, and include other billing details such as the referring provider's 
NPI, taxonomy, and other legacy IDs. 

  

Entering Contact Information 

1. Click Lists and click Referring Providers. The Referring Provider List window opens. 
 

 
  

2. Click New. 
 
--OR-- 
 
Select a record on the Referring Provider List grid and click Edit. 
 
The Referring Provider window appears. 
  

3.  Click the Address tab.  
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4. On the Address tab enter demographic information for the referring provider such as 
last name, first name, title, etc.  
 
Also, if you are sending electronic claims, select from the Specialty list, the referring 
provider’s special field of practice.  If you need to use a specialty code that is different 
than the usual code, select "Not Listed" and enter your specialty code in the data entry 
box that appears next to the Specialty list.  
 
NOTE: This field is not used for sending paper claims unless you have modified your 
claim form to include this information. 

5. Click Save if finished or go to the next section for information on entering data on the 
Referring Providers IDs tab. 

  

Entering Information on the Referring Provider IDs Grid 

Use the Referring Provider IDs tab and grid to enter or edit key data elements associated with a 
referring provider (NPI, taxonomy, legacy numbers, etc). You will set up at least one entry (rule) 
on the Referring Provider IDs grid for each referring provider that works with your practice and 
associate this information to all insurance carriers or insurance classes or a particular insurance 
carrier or an insurance class.   

When creating or editing a referring provider IDs record, you will first create/modify a rule based 
a combination of all or of a specific insurance carrier or insurance class. When processing 
claims, the rules engine uses this information to select the correct entry on the grid. 
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After the rules engine identifies the correct row on the grid, this data is used in processing 
(either print or electronic) the claim. 

The second part of creating or editing a referring provider record is associating data to pull for a 
claim including selecting whether the referring provider's entity type (person or non-person), 
along with a combination of a specific NPI, Taxonomy, and legacy data. For these values, you 
can either include a value or select None to not include a value.   

TIP: when creating or editing IDs grid entries, do not create matching wild card entries (all 
selected for insurance carrier and insurance class) since the rules engine would not know 
which row to select. If you had different legacy numbers, for instance in each entry, the 
system might not select the correct row. In this case, modify one of the wild card rows and 
apply it to a specific insurance carrier or class. 
 
TIP: Press CTRL + DELETE to delete all ID entries in the Practice, Provider, Referring 
Provider, or Facilities IDs grids. Use this with caution since all your entries will be removed. 
If you have numerous legacy ID entries that no longer apply and only a few rows that need 
to be set up, you save time by deleting all entries and setting up the few rows you need. 

 
1. Click Referring Provider IDs tab. This grid contains two elements. The first displays all 

current entries (rules). The second element, the New/Edit Referring Provider IDs 
window, is used to edit or create entries. The grid displays insurance carrier, insurance 
class, NPI, Taxonomy, and legacy data. 
 

 

2. Click the New button to create a new grid entry.  
 
--OR-- 
 
Select an entry on the grid and click Edit. The Referring Provider ID window opens. 
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3. Select either All, Insurance Carrier, or Insurance Class.  
 
Select the All button to apply the rule to all insurance carriers associated with the 
referring provider.  
 
To apply the rule to a specific insurance carrier, select the Insurance Carrier button 
and click the magnifying glass to select the insurance carrier.  
 
To apply the rule to a specific insurance class, select the Insurance Class button and 
click the magnifying glass to select the insurance category.  

4. Select either Entity Type: Person or Entity Type: Non-Person.  
 
Select the Person button if the referring provider is a person and not an organization.  
 
Select the Non-Person button if the referring provider is an organization. 

5. Select either None or National Provider ID.  
 
Select the None button to not include a referring provider's NPI with the rule.  
 
Select the National Provider ID button and enter an NPI number to associate that NPI 
number with the rule.  

6. Select either None or Taxonomy.  
 
Select the None button to not include a taxonomy number with the rule.   
 
Select the Taxonomy button and enter a taxonomy number to associate that taxonomy 
number with the rule.   

7. If needed, enter up to two legacy numbers and qualifiers to associate with the rule using 
the Legacy Identifier 1 and 2 fields. Use these fields to customize your rule to meet 
filing requirements with an insurance carrier(s). 
 
For each entry select either None or Legacy Identifier.  
 
Select the None button to not associate a legacy number with the rule.  
 
To associate a legacy number with the rule (for instance a Medicare Provider Number), 
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select the Legacy Identifier button, enter the legacy number, and select an ID qualifier 
to associate with the rule.  

8. Click Save. 

Attorney, Employer, or Other Addresses  

The Address file is your address book within the computer.  It keeps the names, addresses, 
and phone numbers (with extensions) of important outside contacts, such as attorneys, 
employers, referral sources, etc. Facilities and referring providers are set up in the Facility file 
and Referring Provider file.   
 
The Address file should include all important contact persons whose phone, fax, cell, and e-
mail numbers the practice needs at any time in the future.   

Go to the Lists menu and select Addresses or click the Address List icon.   

When you click New or press F8, the program automatically assigns an address code based 
upon the Name field.  The address code is not assigned until all information is entered and 
saved.  Use Search for and Field to look up the address code of existing records. 

The addresses maintained in the program are classified by ―type‖ assigned to facilitate ease of 
selection in a drop-down list.  These types include: Attorney, Employer, Miscellaneous, and 
Referral Source.   

F1   Look up Address Entry 

  

Use the Address window to enter information for attorneys, employers, and other entities. To 
set up address records, click Lists and select Addresses.  The Address List window opens. 

 

  

  

To set up Address Records  

1. Click New on the Address List window. 
 
--OR-- 
 
Option: to edit an existing record, select the record on the Address List grid and click 
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Edit. 
 

 
  

2. In the Address Code field, enter a code for a new address record, or leave the field 
blank and let the program create a unique code.  
  

3. From the Type list, select Attorney, Employer, Miscellaneous, or Referral Source. 
 
NOTE: A facility record is entered on the Facility window (Lists, Facilities).  For more 
information, see Facility Entry. 
 
Enter other demographic data such as name, telephone numbers, email address, etc.  

4. Click Save. 

  

Procedure, Payment, and Adjustment Codes 

Procedure codes are used to communicate procedure information between patient, provider, 
and third-party payers.  These codes can be accessed by going to the Lists menu and 
selecting Procedure/Payment/Adjustment Codes.   

The Procedure/Payment/Adjustment List window shows what codes have been set up.   
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At the top of the window, there are two fields to help you find a procedure code:  Search for 
and Field.  Field defaults to Type but can be changed to Code 1 or Description.  If you are 
not sure of the complete code, description, or type, enter the first few letters or numbers in the 
Search for field.  As you type, the list automatically filters to display records that match.  At the 
bottom of the window are choices for setting up a new code, editing a code, or deleting a code.  
If the code you need is not shown in the list, click New or press F8. 

F1   Look up Procedure/Payment/Adjustment Entry 

  

General Tab 

In this area, you can enter a new code number, description, and type.  Valid code types can be 
seen by clicking on the drop-down Code Type list.   
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 Accounting Codes can be any configuration of letters or numbers you want to assign to each 
accounting function, e.g., cash, checks, etc.  Procedure codes are used for recording charges 
for services rendered, and Accounting Codes show the payment and adjustment side of the 
entry process.  These categories are broken down into codes for specific purposes. 

Valid codes that have unique functions within the program are: 

Adjustment                     Deductible 

Billing Charge                     Inside Lab Charge 

Cash Co-payment               Insurance Adjustment 

Cash Payment                    Insurance Payment 

Check Co-payment              Insurance Withhold Adjustment 

Check Payment                  Outside Lab Charge 

Comment                            Procedure Charge 

Credit Card Co-payment       Product Charge 
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Credit Card Payment           Tax 

Also indicated in this window are the type of service, place of service, time to perform the 
procedure, whether to allow the code to print on insurance forms, Alternate Codes and, if 
applicable, whether only the patient is responsible.  There is also a check box to indicate if the 
code is inactive.   

Modifiers help pinpoint the exact procedure performed.  If needed for claim filing, add 
modifiers.  The HIPAA Approved field indicates whether the code is HIPAA approved.  The 
Revenue Code is used with the UB92 claim form.  You can adjust the number of units 
associated with this code in the Default Units field.  If the code is used only with a service that 
the practice purchased (usually from a lab), click this check box. 

F1   Look up Procedure/Payment/Adjustment Entry-General Tab 

Amounts Tab 

The Amounts tab is linked with Case information, Account tab, Price Code field.  Medisoft 
Advanced and Medisoft Network Professional allow 26 charge amounts for each code entered 
in the program.  The applicable charge amount is selected in the Account tab of each patient’s 
Case window.   
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F1   Look up Procedure/Payment/Adjustment Entry-Amounts Tab 

Allowed Amounts Tab (Advanced and above) 

The Allowed Amounts tab keeps track of how much each carrier pays for a particular code.  
The program calculates the allowed amount based on the amount paid, any applicable 
deductible, and the service classification.  This amount is used in calculating the patient portion 
of any transaction entered in Transaction Entry.   
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F1   Look up Procedure/Payment/Adjustment Entry-Allowed Amounts Tab 

  

MultiLink Codes 

MultiLinks are groups of procedure codes combined under one access code.  They are for 
procedures that are normally performed at the same time, e.g., for a physical exam, a routine 
set of treatments, etc. 

The advantages to using MultiLinks include a reduction of time during data entry.  If you can 
create several transactions with the entry of a single code name or number, there is an obvious 
time saving.  MultiLinks also reduce omission errors.  You won’t forget codes that should be 
included if they are included in a MultiLink.  When you use the MultiLink code, all the codes in 
the group are entered.   

Enter the MultiLinks function by going to the Lists menu and selecting MultiLink Codes.   
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The list displays all available procedure codes, adjustment codes, and payment codes.  You 
can also set up a new MultiLink or edit or delete an existing MultiLink code by clicking Edit or 
New. 

 

  

F1   Look up MultiLink Entry 

  

Diagnosis Codes 
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Diagnosis codes represent the reason a service is provided.  In effect, the procedure code tells 
what the doctor did and the diagnosis code tells what the doctor found.   

As with other list functions, the diagnosis code setup is accessed by going to the Lists menu 
and selecting Diagnosis Codes.   

 

  

At this point you can review codes in the list or search for one you do not see.  Clicking New 
(F8) or Edit (F9) opens up a window where you can create a new code or edit an existing one.   

  

 

  

The Diagnosis: (new) window displays fields for the code number and description.  You also 
have the option of entering Alternate Code Sets.  These can be used later for entering codes 
for different carriers but for the same diagnosis.   

F1   Look up Diagnosis Entry 

  

Billing Code List 

A Billing Code is a user-defined two-character alphanumeric code.  Billing Codes can be 
effective in sorting and grouping patient records.  Go to the Lists menu and select Billing 
Codes.   
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The Billing Code List window lets you review and edit the codes contained in the program and 
create new ones.  If you want to use a code you have not previously entered, click New or 
press F8 and the window for a code and description appears.   

  

 

  

A billing code range is a filter available in most reports printed in Medisoft. 

F1   Look up Billing Code Entry 

  

Contact List  

NOTE: This is an Advanced and above feature.  

The Contact List contains a ready reference of people with whom you have had contact during 
the course of business.  The Contact window has space where you can add notes concerning 
your conversations to help you keep track of what was discussed and any conclusions or 
information shared during the conversation.  Click Lists and select Contact List. 
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To create a new contact, click New; to edit an existing contact, click Edit. 

  

 

  

For more information on the use of this feature, see: 
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F1   Look up Contact Entry 

  

Setting Up Patient Records 

One of the most important functions in getting your practice computerized is entering patient 
data.  Go to the Lists menu and select Patients/Guarantors and Cases.  

  

 

  

You can search for an existing patient’s record by entering the first few letters of his or her last 
name in the Search for field.   

If you want the Patient List window to open automatically each time you open the program, go 
to Program Options and click Patient List in the Show Windows on Startup section of the 
General tab. 

Clicking New or pressing F8 opens an entry window to set up a new patient.  Each of the data 
windows during setup lets you edit, change, or delete the information contained in window.  The 
importance of entering correct information into the patient data files cannot be 
overemphasized.  From setting up the chart numbers to entering percentage amounts for 
insurance claims, the effect of data entry is far reaching. 

It is especially important to set up the guarantor when doing insurance billing. 

F1   Look up Patient/Guarantor Entry 

  

Setting Up the Chart Number 

Every patient or guarantor must have a chart number and be set up in the database before 
transactions can be entered.   

If using the program’s default automatic settings, each chart number consists of eight 
alphanumeric characters.  If you leave the Chart Number field blank, the program 
automatically assigns a unique chart number.  If you want, you can change the default settings 
and have the program automatically assign numeric chart numbers.  Go to Program Options, 
open the Data Entry tab, and click Use numeric chart numbers in the Patient section.   

If you want to establish your own patient chart numbering system, type a number or code as 
soon as you enter the new patient window.  There is no need for corresponding numbers within 
a family; the number sequence has little bearing on grouping of patients.  Each patient is set up 
individually in the program and individual bills are prepared for each guarantor.  It is important 
to understand that once assigned, the Chart Number cannot be changed.  To correct a wrong 
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chart number, you’d have to delete the entire patient record and create a new one with the 
proper chart number.  All other data in the patient record can be modified. 

F1   Look up Chart Number 

  

New Patient Setup Window 

Clicking New Patient or pressing F8 lets you set up a new patient record in the program.  

  

 

  

Enter all known or necessary information.  When entering an address, the focus moves from 
the Street fields directly to the Zip Code field.  The program has a feature that saves city, state, 
and zip code information in a table.  Once you enter a zip code with its associated city and 
state, the next time you enter the zip code, the City and State fields are filled in automatically, 
saving you time when entering new records. 

In the Medisoft Advanced and Medisoft Network Professional programs, you can establish 
default information, applied to all new patient records.  Enter that information which is generally 
the same for all of your patients, and then click Set Default.  To remove your new default 
settings, hold down CTRL and the button name changes to Remove Default.   
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When you enter a Social Security Number, the program checks through the patient records for 
any duplications.  If a number you enter is a duplicate, the program displays the name and 
chart number of the patient first showing that Social Security Number. 

Do not include spaces or hyphens as you enter dates or phone numbers.  If you want the 
program to automatically hyphenate Social Security Numbers, go to Program Options, open 
the Data Entry tab, and click Auto format Soc. Sec. # in the Patient area.  Then enter Social 
Security Numbers without hyphens.   

The Other Information tab contains fields for additional information relevant to the patient 
record, such as the assigned provider, identification codes, and emergency contact numbers.   

 

  

If you have chosen to use patient flagging (Advanced and above), the Flag field lets you 
choose which flag to associate with the patient record, including None if you want to disable the 
feature after assigning a flag.   

F1   Look up Patient/Guarantor Entry-Other Information Tab  

F1   Look up Program Options – Color Coding Tab (Advanced and above) 

If the patient’s employer record has been set up in the Address file, this data is available in the 
Other Information tab.  Clicking the arrow or magnifying glass icon to the right of the Employer 
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field displays a list of those employer records already stored in the program.  If the employer 
record you need is not available, press F8 for the new employer setup.   

Use the Payment Plan tab to assign a payment plan to a patient if the patient's account is in 
collection. Create patient payment plans by clicking Lists and selecting Patient Payment Plan. 

 

  

  

F1   Look up Patient/Guarantor Entry - Payment Plan Tab  

F1   Look up Patient Payment Plan Entry 

  

  

Setting up a Case 

Transactions within the program are generally case-based.  A case is a grouping of procedures 
or transactions generally sharing a common treatment, facility or insurance carrier.  You can set 
up as many new cases as needed.      

Each new case that is set up needs to contain the patient’s pertinent information.  If you click 
New Case or press F8 with the case list selected, only the Guarantor designation is copied to 
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the new case.  To save time, click Copy Case to copy all the current case information, and then 
revise those portions of the data that are different for the new case.   

You definitely want to open a new case if the treatment comes under a different insurance 
carrier.  Suppose you are treating a diabetic patient regularly and he is injured on the job.  His 
visits regarding the work-related injury should be kept in a Workers’ Compensation case, totally 
separate from the regular visits, for legal and reporting reasons.  The ideal situation is to have a 
case for each different malady from which the patient suffers.  Then you can pull up groupings 
of case visits to help you evaluate the patient’s overall health status.  By pulling a case that 
contains all diabetic treatments, one for high blood pressure, one for angina, and one for 
cancer, you get a better picture of the full range of health problems.   

TIP: If a patient comes for a onetime treatment, you can create a transaction for that 
treatment without creating an entirely new case.  Just select different diagnosis codes in 
Transaction Entry when creating the transaction. 

Existing case numbers are found in the Patient List window through which you set up new 
cases.  Case numbers set by the program are sequential and not one of the numbers is 
repeated within the program in a single data set. 

An existing case can be edited or reviewed through the Patient List window or accessed from 
any Case fields in the program by pressing F9.  The patient Case window contains tabs that 
display fields necessary to complete an insurance claim form.   

In Medisoft Advanced and Medisoft Network Professional, you can limit the tabs that are 
displayed.  If a tab is not applicable to your practice or if you would prefer not to have it visible, 
right-click the tab.  In the list that appears, click each tab you do not want displayed.  That tab 
no longer appears in the Case window.  To add tabs that are not visible, right-click the tabs and 
click the tab you want displayed to remove the check mark.   

The Personal tab establishes the patient and his or her guarantor information, marital and 
student status, and employment.   
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F1   Look up Case – Personal Tab 

  

The Account tab displays the provider, referral, and attorney information set up in the Address 
file.  It also covers billing and price codes and information on visit authorization, including the 
number of visits.    
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F1   Look up Case – Account Tab 

  

The Diagnosis tab allows for entry of up to four default or permanent diagnosis codes for this 
case, plus entry for allergy and EDI notes.  Information in the Allergies and Notes section is 
displayed in Transaction Entry and the New Appointment Entry window of Office Hours 
when a Chart number is selected.   
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F1   Look up Case – Diagnosis Tab 

  

The Condition tab allows for entry of information pertinent to the illness, pregnancy, or injury 
and tracking of symptoms.  It also includes dates relative to the condition, plus Workers’ 
Compensation information.   
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F1   Look up Case – Condition Tab 

  

The Miscellaneous tab contains supplemental information features like lab work charges, 
whether the lab is in-house or outside, Referral and Prescription Dates, Local Use A and 
Local Use B fields, case Indicator code, and prior authorization.  It also provides space for 
recording information concerning a primary care provider outside your practice.   
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F1   Look up Case – Miscellaneous Tab 

  

The Policy 1, 2, and 3 tabs let you connect up to three insurance carriers to the patient record, 
including policy and group numbers, and Insurance Coverage Percents by Service 
Classification (how much the carrier pays for certain types of procedures).  The service 
percentage classification is tied to each procedure code.   
 
F1   Look up Procedure/Payment/Adjustment Entry 

A Deductible Met check box is provided in the Policy 1 tab.  When the patient meets his or her 
deductible obligation for the year, click this box and the status is displayed in the patient 
account detail of the Transaction Entry window.   

The three tabs have the same layout, except Policy 1 asks about Capitated Plan and Co-Pay 
Amount and has the Deductible Met check box; Policy 2 asks if this is a Crossover Plan; and 
Policy 3 can be set up for tertiary or third-party involvement. 
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F1   Look up Case – Policy 1, 2, and 3 Tabs 

  

The Medicaid and TRICARE tab includes fields for all submission numbers, reference, and data 
for each carrier.  It also includes branch of service information. 

Within the Medicaid and Tricare tab are EPSDT and Family Planning indicators, required 
submission numbers, and reference data for the case.  It also includes service information for 
TRICARE claims.   
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F1   Look up Case – Medicaid and Tricare Tab 

  

The Multimedia tab (Network Professional only) allows you to add bitmaps, video, or sound to 
your patient records.  

F1   Look up Case – Multimedia Tab and Multimedia Entry 

  

The Comment tab (Advanced and above) is provided for the entry of notes to be printed on 
statements.   
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F1   Look up Case – Comment Tab 

  

This EDI tab is where you enter information for electronic claims specific to this case. If 
applicable to the claims for this case, enter values in the fields. 
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F1   Look up Case – EDI Tab 

  

Default Printer Selection  

NOTE: This is an Advanced and above feature. 

Setting a default printer for printing various superbills, claims, and statements involves a series 
of simple steps to first identify items to be assigned to a specific device, followed by any 
additional print setup selections.  
 
Open Medisoft and select the Default Printer Options command from the Reports menu 
window. The Default Printer window will open. 

NOTE: this command is only available by default, if security is applied, to level 1 users. If 
you plan on other user levels having access you will need to change the default 
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permissions in the Permissions window. If you are not using security any default printer 
settings are saved to the workstation.  

 

  

You will use the Default Printer Window to assign a printer to superbills, claims, and 
statements. The window displays available reports and provides controls to select or delete a 
default printer. After selecting a report, you can click the Select Printer button to select a printer 
from the Print window. On the Print window (standard Windows printer interface window), you 
can further select other available settings. You can also select multiple reports to assign to a 
default printer by holding down the CTRL Key while clicking a report at the start of the range 
and holding down the CTRL Key while clicking a report at the end of the list. Then when you 
click the Select Printer button, you can assign all the selected items to the same default printer 
using the same default settings. 

The window also features a Delete button to remove a default printer from a report and a Reset 
Default button to remove all assigned printers from the available reports.  

If you assign a default printer to a report and the printer is not available for printing 
(disconnected from the network, off-line, etc.), the system will prompt you to select another 
printer or cancel the print job. If the printer is permanently no longer available, you would need 
to assign another printer to all reports that were using this resource.  

   

F1   Default Printer Setup Options 

F1   Setting a Default Printer 
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Entering Transactions 

Transaction Entry Overview 

The Transaction Entry window is designed for easy transaction entry and to display as much 
information with as few clicks or keystrokes as possible.  Not only do you record all patient 
visits and their charges, you also enter payments and adjustments that may be added to the 
ledger.   

Medisoft is an Open Item Accounting program, meaning that transactions entered are marked 
when paid but remain on the active ledger as long as the case is active.  There is no clearing of 
the ledger and bringing up a total to start a new month, as with a balance forward program.   

Transaction entry is generally case-based.  Transactions are entered into the patient ledger 
grouped by case number.  You can have a case for each transaction or for each diagnosis 
type.    

  

 

  

F1   Look up Transaction Entry 

  

Start with a Chart Number 

From the Activities menu select Enter Transactions or click the Transaction Entry speed 
button.  Within Transaction Entry, two numbers are of prime importance:  the chart number 
and the case number.  

Enter the chart number or click the Chart field and select the chart number from the drop-down 
list.  You also have the option of entering the superbill number or selecting the superbill number 
from the drop-down list in the Superbill field. If the patient record has not yet been set up, 
press F8 to bring up the Patient/Guarantor: (new) window.  See Setting up Patient Records 
for more information. 
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When you press TAB or ENTER, a case number is selected in the Case field (if one is 
available). By default, the most recently opened case is opened.  You can change the default in 
the Program Options window, Data Entry tab, Case Default field, see Data Entry Tab .   

If you want to create a new case, the shortcut to bring up the Case window is F8.  Another 
method of selecting a specific case is to click the speed button to the right of the Case 
description field to open the Select Case by Transaction Date window.    Cases are sorted on 
the Case drop-down menu based on the case number and appear in descending order; for 
instance, case nine would appear at the top of the list, followed by case five, followed by case 
four, etc. 

F1   Look up Select Case by Transaction Date 

A document number is automatically assigned by the program and is used for reference and 
filtering purposes, whether the field is displayed in the Transaction Entry window or not.  You 
can replace this number with your own if you want.   

If you use superbills, you can enter a superbill Serial Number in this field to help keep track of 
the superbill.  To use superbill numbers in Transaction Entry, open Program Options and 
click both Force Document Number and Use Serialized Superbills in the Data Entry tab. 

You can also print blank, serialized superbills that are not assigned to an appointment. Before 
using the feature if you have security applied to your practice, you will need to give access to 
this feature to appropriate users. The default setting is for level 1 users only. For information on 
changing permissions, see Setting Permissions.  
 
F1   Look up Permissions 

The same options you selected to use Superbills also applies if you want to print blank 
superbills: the Force Document Number and Use Serialized Superbills options on the Program 
Options window, Data tab must be selected. 

Once enabled, you can print a blank Superbill by selecting the Blank Superbill command on the 
Reports menu and at a later date, assign the blank superbill to a chart and case in the 
Transaction Entry.  
 
F1   Look up Printing Blank Superbills  

F1   Assigning a Blank Superbill to a Patient and a Case 

Sometimes there is a need to provide more documentation about a transaction.  This can be 
done in a special Transaction Documentation window activated by pressing F5 or clicking 
Note in the Charges section of the Transaction Entry window.   

There are various transaction documentation types available, and they can be viewed in the 
Quick Ledger. 
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F1   Look up Transaction Documentation 
 
If you need to enter drug/prescription information for a charge on the Transaction Entry window, 
you can click the Details button to open the Transaction Details window. On this window you 
can add data which is then included on a custom report or a printed claim. You will need to 
customize a report and modify fields 24A-24H to add National Drug Code (NDC) data in a 
charge line (electronic claims automatically pulls this data for claims). For more information on 
modifying a report, see Report Designer. And, to view NDC Information on the Transaction 
Entry, you will need to add the NDC fields to the grid. 

F1   Look up Adding NDC Information, Report Designer, and Grid Columns 

  

  

Entering a Charge in Transaction Entry 

Once you have selected patient chart and case number in the Transaction Entry window, click 
New or click in any column of the Charges section.   

The current date is automatically entered.  If you are entering transactions from earlier dates, 
insert the correct date of the entries with which you are working.  If you have a number of 
transactions from a different date, you can change the program date by clicking the date in the 
lower right corner of the program window and selecting a new date.  Be sure to change the 
date back to the current date when finished. 

The Transaction Entry window displays on a tabbed panel the current insurance carriers 
assigned to the patient’s case along with the aging columns. The aging columns’ appearance is 
dictated by setting on the Program Options tab. 

Enter information in the Procedure column and any other information that is necessary to 
complete this charge transaction.   

To create a second charge transaction, click the down arrow key or click New.   

Sort the columns in the Transaction entry by clicking a column header to sort the grid by that 
value (Medisoft Advanced and Medisoft Network Professional feature).  For instance, click the 
Procedure header to display transactions sorted by the procedure numbers of the line items. 
The default sorting pattern is based on date and sorts in a descending order and the last sort 
selection is also saved for next use.  For more information, see:  
 
F1   Look up Sorting the Transaction Entry Grids 

  

  

Entering a Payment or Adjustment in Transaction Entry 

After selecting patient chart and case numbers in the Transaction Entry window, you can 
enter a payment by clicking New in the Payments, Adjustments, and Comments section of 
the window.   

The current date is inserted in the Date field.  Select the Pay/Adj Code, and then enter Who 
Paid, a Description, and the Amount.  If the payment is being made by check, the check 
number can be entered in the Description field. 

  

Apply Payments or Adjustments to Charges  

WARNING: We recommend that you apply all payments and adjustments to charges.  
Failure to do so results in other parts of the program not functioning properly, i.e., 
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remainder billing and the delay secondary billing feature (Advanced and above), to name 
only two. In addition, some report results will be incomplete or inaccurate. 

You can distribute a payment or an adjustment to a specific charge or charges by clicking 
Apply.  The Apply Payment to Charges or Apply Adjustment to Charges window opens 
(depending on whether you are applying a charge or an adjustment) and lets you direct that 
payment or adjustment to the proper charge or charges. 

Besides displaying the source of the payment or adjustment and the patient’s name, the Apply 
Payment to Charges or Apply Adjustment to Charges window also displays the number of 
charges in this case.  The upper right corner displays the unapplied amount entered in the 
payment.   

Once the entry is complete and verified, click Close to return to Transaction Entry.  You can 
then click Print Receipt (which gives the patient a Walkout Receipt before leaving the office), 
click Print Claim (which prepares entries that have not yet been submitted on an insurance 
claim and sends them to print), or click Close to exit the window. 

F1   Look up Apply Payment to Charges or Apply Adjustment to Charges 

  

  

Unprocessed Transactions  

The Unprocessed Charges window provides an interface between an Electronic Medical 
Records (EMR) service and Medisoft via Communications Manager. 

This window provides controls to edit and post financial transactions imported from an EMR 
service to Medisoft.  

Transactions imported into Medisoft from an EMR service through Communications Manager 
are held as Unprocessed Charges until they can be processed by a Medisoft user. 

From the Activities menu, select Unprocessed Transaction and then select Unprocessed 
EMR Charges. The Unprocessed Charges window appears with a list of transactions that 
have yet to be posted. 

The columns in the list correspond to information from the EMR application. Columns such as 
billing, providers, diagnosis codes, and procedure codes should be reflected in the same 
manner as found in your practice management software. 
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F1   Unprocessed Transactions Overview 

Communications Manager Overview 

This product allows you to transfer data between Medisoft and EMR programs. Currently, you 
can create a connection to Medisoft Clinical, InstantDx, Practice Partner Patient Records, 
MediNotes, RelayHealth (send patient demographics only), and SpringCharts. The product also 
provides a Standard HL7 connection type that supports sending patient demographics and 
scheduling data to any EMR that is HL7 and Communications Manager compliant. 

There are two major components to the Communications Manager suite: 

Communications Manager: This portion of the program allows you to create connections 
between your practice management software and EMR programs. One connection to an EMR 
programs can be created for each practice. Communications Manager also allows you to define 
connection settings and manage connection errors. Once you set up your connections, it rarely 
requires additional maintenance. 

Communications Messenger: This portion of the program manages the transfer of data 
between your practice management software and EMR programs. Once you have enabled the 
Communications Messenger and set up your connections through Communications Manager, 
Communications Messenger will automatically deliver and receive data. Once this program 
successfully sends its first message, it rarely requires additional maintenance.  

For more information, see: 

F1   Look up Communications Manager Main Window 

F1   Look up Creating a New Connection 
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Patient Treatment Plans  

NOTE: This is a Network Professional only feature. 

When a patient has a choice of options for the treatment he or she can receive, a treatment 
plan can be prepared which sets out the different treatments offered and the cost of each plan. 

F1   Look up Treatment Plan List 

  

Print Receipts, Create Claims 

Once a transaction has been entered and saved, the transaction can be displayed in the 
Transaction Entry window.  By sliding the scroll bar at the bottom of the window, a full 
summary of the transaction is revealed. 

You can now print a receipt for the patient, file a claim, or close the window.   

F1   Look up Create Claims 

  

  

  

Billing Charges  

NOTE: This is an Advanced and above feature. 

This feature lets you apply billing charges to accounts that are past due.   

Before you can use this feature, you must set up at least one billing charge type of procedure 
code.  Do this through the Procedure/Payment/Adjustment List and 
Procedure/Payment/Adjustment: (new) windows.  Fill in the Code 1 and Description fields.  
Be sure to select Billing charge in the Code Type field.  Add whatever other information you 
want and save the code.  Create as many billing charge codes as you need.   

If desired, you can use billing codes (which are used to categorize patient records) and 
indicator codes in applying billing charges.  Be sure these codes are set up if you want to use 
them.   

Go to the Activities menu and select Billing Charges.   
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Use the range limitations to select the records to which you want to apply the billing charges.  
The Charges Creation Date is the date that appears in the ledger with the billing charges.  
This can be whatever date you choose (but the transactions created still show on the current 
day’s activity reports). 

Fill out all the requested information, then click Start.  New transactions are added to each 
patient record that fits the criteria you selected.   

F1   Look up Billing Charges and Procedure/Payment/Adjustment Entry 

  

Quick Ledger  

NOTE: This is an Advanced and above feature. 

The Quick Ledger in Medisoft gives a quick reference for transaction and other information in 
the patient’s account.  There are two types of Quick Ledgers in Medisoft: the Patient Ledger 
and the Guarantor Ledger.   

The Patient Ledger displays transaction information and account totals for individual patients.  
The Patient Ledger is the default ledger in Medisoft. 
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The Guarantor Ledger provides the same information as the Patient Ledger but allows you to 
view guarantor totals as well.  In the Program Options, General tab, you can select Guarantor 
Ledger as your default ledger. 

  

 

  

To get quick and easy access to a patient’s ledger from almost anywhere in the program, press 
F7 or click the Quick Ledger speed button.   

While no new transactions can be made in the ledger itself, it is possible to edit and print the 
ledger and gain valuable detail on patient accounts. 

You can change responsibility for a selected transaction in the Quick Ledger window.  Right-
click a transaction to change its responsibility between insurance carriers or from an insurance 
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to the patient.  This feature lets you skip entering the zero-dollar insurance payment to indicate 
that no payment is coming from the insurance carrier.  

F1   Look up Changing Responsibility in Quick Ledger 

The Quick Ledger detail window is very similar to the Transaction Entry window.  Use the 
horizontal scroll bar to reveal additional data fields.  A navigation bar lets you move quickly 
through the list of transactions.  Three buttons open additional data fields.   

Click Edit or press F9 to open the Transaction Entry window where charges, payments and 
adjustments can be reviewed and edited, as needed.  Both the Patient and the Guarantor 
Ledgers let you view the notes entered for transactions in the grid and also add a note. Click 
the Note button or press F5 to toggle the display any transaction notes attached to the 
transaction. If a note is not yet attached, you can enter a note. The second column from the left 
(next to the record pointer column) displays a note icon if the transaction has a note.  
  

F1   Adding a Note to a Line Item on the Quick Ledger  
  

Click Payment Detail to display all payments/adjustments made toward a specific charge.  
Click Filter to search which transaction data to display.  Real power comes with using multiple 
filters.  Navigation buttons in the Payment/Adjustment Detail window are for selecting other 
entries in the Quick Ledger to review without having to exit the Payment/Adjustment Detail 
window first.   

TIP: If you click Quick Statement, you print statements from the Reports menu.  If you 
click Statement, you print statements from Statement Management. 
  

F1   Look up Quick Ledger, Payment/Adjustment Detail, and Transaction Filter 

  

  

Quick Balance  

NOTE: This is an Advanced and above feature. 

Quick Balance is a quick summary of all remainder charge totals contained within the program 
for a selected guarantor record.  Click Activities and select Quick Balance or press F11 to 
access the feature.  
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If the record selected is a guarantor’s record, the Quick Balance window displays each patient 
for whom the guarantor is responsible and the total qualifying remainder charges for each.  If 
the record selected is not a guarantor’s record, a listing of all the selected patient’s guarantors 
is displayed.  Choose a guarantor to see the quick balance. 

TIP: If you click Print in Quick Balance, you print statements from the Reports menu.   

F1   Look up Quick Balance 
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Creating Claims 

Claim Management 

This section explains briefly how to manage claims within the Claim Management window and 
includes creating, editing, printing/reprinting, and listing claims, as well as changing claim 
status. 

  

The Claim Manager’s Job  

To help you better understand the function of claim management, let’s use a shipping analogy.  
Whereas Cases are containers filled with claims for specific diagnoses, claim management is 
the process by which the cases are checked, sorted and delivered.  In other words, claim 
management is the process of making sure all shipments are correct, ready to be sent and 
shipped to the right companies (insurance carriers).   

The Claim Manager (the person performing claim management) checks the claims, makes sure 
the boxes are properly marked, and sends them on their way.  She determines whether the 
shipment goes by truck (paper claims) or by air (electronic claims).  When a box is returned 
(rejected claim), the Claim Manager makes whatever changes are necessary (with help from 
the EOB or Audit/Edit Report) and ships the box again (resubmits the claim). 

Someone else sees and treats the patients.  Another person enters data from the superbill to 
begin the billing process.  Once all the data has been entered, it must go through the Claim 
Manager’s office before being sent to an insurance carrier. 

The Claim Manager focuses on three principal areas, not necessarily sequential:  review, batch, 
and final review. 

Watchdog:  The Claim Manager is, first of all, the watchdog of the claims.  She checks each 
claim and verifies the numbers.  She has the authority to edit the claim and make needed 
changes.  If she sees that a claim should go to a different carrier than indicated, or if the EDI 
receiver information is incomplete, she corrects the record.  She also has access to the 
insurance carrier records.  She checks the billing date and how the claim is to be sent, either 
by paper or electronically.  And then she can indicate the status of the claim.  There is a 
place where she can add any special instructions that need to go with the claim. 

Batch ‘em up!  The function of creating claims serves to group claims that are headed to the 
same destination.  The Claim Manager gathers and sorts by range of dates or chart 
numbers.  Transactions can be selected that match by primary carrier, Billing Code, case 
indicator, or location.  Random Billing Code numbers can be selected.  The Claim Manager 
can also indicate a minimum dollar amount for creating the claims, eliminating claims too 
small to be worth billing. 

Reviewer:  The Claim Manager has at her fingertips a List Only button that lets her retrieve 
claims that match a certain criteria that she has determined.  The List Only Claims That 
Match window is a ―show me‖ window that lets the Claim Manager review all that is in the 
program.  The claims that come before her can be given a final check for accuracy and 
completeness.  She can select specific or all carriers to review.  She can group all electronic 
media claims.   

Besides these three focus areas, the Claim Manager also has responsibility to mark claims 
that are paid and those that are rejected. 

Marking paid claims:  The date of submission in the Claim Management window indicates 
when the claims were shipped or transmitted.  Claims are marked under the designation of 
―Sent‖ and the date is automatically inserted.  The claims stay in Claim Management marked 
as ―Sent‖ until they are manually changed in the Claim edit window as having been received 
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and dispatched by the carrier.  When a payment is received, use the EOB to enter all 
payments through transaction entry.  If selected in Program Options (Payment Application 
tab, Mark Completed Claims Done field), the status for paid claims is automatically changed 
to ―Done.‖  

Handling rejected claims:  When a paper claim is rejected for payment by the insurance 
carrier, change the payment status in the Claim Management window from ―Sent‖ to 
―Rejected.‖  

Now put yourself in the picture.  Picture yourself as the Claim Manager.  The tools by which 
you get the job done are found in Claim Management.   

  

The Claim Management Window 

To perform any claim management functions, go to the Activities menu and select Claim 
Management, or click the Claim Management speed button. This window features several 
sections used for various tasks. 

 

  

Header 

Search: Enter values for which you want to search in the grid.  This field is affected by the 
variable in the Sort By field 

Sort By: Click the down arrow to select the variable by which you want to search.  For more 
information, see:  
 
F1   Look up Grid Columns 

List Only: Click this button to list only certain claims in the grid.  For more information, see:  
 
F1   Look up List Only Claims that Match 

Change Status: Click this button to change the status on a batch of claims.  For more 
information, see:  

F1   Look up Change Claim Status/Billing Method 

Navigation Buttons: These buttons in the upper right corner of the window allow you to 
move through the displayed records.  The button at the right end of the navigation buttons 
refreshes the information in the grid.  



Creating Claims 

113 

Grid   

This section shows you information about each claim.  You can add and remove fields from this 
section by clicking the grid modification button in the top left corner of the grid.   
 
F1   Look up Grid Columns  
 
Click a column header to sort the grid by that column. When you exit the Claim Management 
window, the application saves your currently selected sorting pattern and displays this selection 
the next time you access the window.  

The column next to the record pointer indicates whether notes are attached to the particular 
claim.  If the column contains a page icon, highlight the record and press F5 to view the note.   
 
F1   Look up Claim Comment  

Buttons   

Edit: Click this button to edit the selected claim.   
 
F1   Look up Edit Claim 

Create Claims: Click this button to create claims.   
 
F1   Look up Create Claims 

Print/Send: Click this button to print the claims on paper or send them electronically.   
 
F1   Look up Print/Send Claims 

Reprint Claim: Click this button to rebill claims.   
 
F1   Look up Reprinting Claims. 

Delete: Click this button to delete the claim number and release the transactions bound to the 
claim.  You can then put those transactions on a different claim.   

Close: Click this button to close the window. 

  

Creating Claims 

It is in the creating claims operation that a claim is finally prepared for submission.   

Preparation can involve a single claim or a batch.  Claims are gathered by range of dates 
and/or chart numbers.  The selection of claims to be created can be further narrowed by 
specifying detail in the Select transactions that match, Provider, and Include transactions 
if the sum is greater than fields.   
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F1   Look up Create Claims 

  

Editing Claims 

This function within the program is the watch dog area where you can verify and edit the claims 
that are ready to be submitted for payment.  It is a safety net where problems can be solved, 
and information entered in a transaction can be overridden if necessary.  An override in the 
Claim edit window changes that claim submission, but does not affect the default database. 

As the claim comes up for final verification, it may be determined that a change needs to be 
made, such as a different carrier or EDI receiver.   

By highlighting a specific claim and clicking Edit or pressing F9, the Claim edit window appears 
with the claim details and information concerning all assigned insurance carriers and their 
pertinent data.   
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The detail also indicates submission method assigned to the claim (paper or electronic), as well 
as the claim status.  Claim status options include:  Hold, Ready to send, Sent, Rejected, 
Challenge, Alert, Done, or Pending.  The status of the claim can be changed at this point. 

Any time a claim is sent, a batch number is assigned.  That number shows in the Batch data 
box in the center of the window of the claim you are reviewing.  If a claim needs to be 
resubmitted, the batch number coincides with the number shown in the Claim Management 
window and the one you use to designate those claims that need to be resubmitted.   

The Transactions tab reveals a listing of all transactions applied to the selected claim.  You can 
split, add, or remove qualifying transactions in this tab.  The Comment tab provides an empty 
box in which to place whatever comments you feel are necessary concerning this claim and/or 
any transactions relating to it.  If you have Medisoft Advanced or Medisoft Network 
Professional, these notes are represented by a note icon in the Claim Management window.  
Double-click the icon to view or edit the note. 

F1   Look up Edit Claim 

  

  

Printing Claims 

Once claims are created, you can print them by clicking Print/Send.  Indicate whether you are 
sending the claims on paper or electronically, then apply filters to select only those claims you 
want to send. 

F1   Look up Print/Send Claims 
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Troubleshooting Insurance Claims 

Claim Form Not Centered 

If your insurance claims are printing just a little off center, this can be fixed by entering the 
Report Designer (Reports menu, Design Custom Reports and Bills).  Open the insurance 
form you use for printing claims.  Go to the File menu and select Report Properties.  In the 
Form Offset area of the window, adjust the form as necessary from the top and/or left 
margins.  The form is moved in increments of one hundredth of an inch.  When the form is 
adjusted, save the form, exit the Report Designer, and reprint your claim. 

  

F1   Look up Report Designer 

  

  

  

Reprinting Claims 

If necessary, you can reprint claims without regard to their status.  To reprint an entire batch, 
the status must be changed for the batch. 

F1   Look up Reprinting Claims 

  

Listing Claims 

The Claim Management window has a claims viewing feature that lets you retrieve claims that 
match a set of criteria that you define.  Click List Only.  
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In the List Only Claims that Match window, use one or more of the options to limit the claims 
you want to appear in the window. 

F1   Look up List Only Claims that Match 

  

Changing Claim Status 

In the Claim Management window, all submitted claims are automatically marked Sent with an 
indication of the method of submission.  There may be occasions when you need to change 
this status.   

Entire Batch 

If the status of an entire batch needs to be changed, you can change all the claims at once.  
Highlight one of the claims and note the number listed in the Batch 1 column in the Claim 
Management window.  Click Change Status.  The Change Claim Status/Billing Method 
window is opened.   
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Choose the Batch radio button and enter the batch number from the Batch 1 column in the 
Claim Management window.  Then choose the appropriate radio buttons in the Status From 
and Status To sections.  All claims with that batch number have the status changed when you 
click OK.   

  

Selecting Multiple Claims 

When only one or a few claims within the same batch or claims from multiple batches need a 
status change, hold down the CTRL key and click each claim that needs the status changed.  
Note that the selected claims do not need to have the same claim status to begin with, but they 
are all changed to the same status.  Click Edit. 

In the Change Claim Status/Billing Method window, choose the Selected Claim(s) radio 
button, then choose the appropriate radio buttons in the Status From and Status To sections.  
If you have chosen claims with varying statuses, choose Any status type in the Status From 
section.  When finished, click OK.   

F1   Look up Change Claim Status/Billing Method and Marking Claims 

  

Sending Claims to a File 

Medisoft has the ability to print CMS or UB-04 claim data to a text file. You process the claims 
like you are sending electronic claims through one of the electronic claims modules only you 
create the file on your desktop instead of sending it to the clearinghouse or insurance company.  
  

F1   Look up Sending Claims to a File. 
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Creating Statements 

Statement Management  

NOTE: This is an Advanced and above feature. 

This section explains briefly how to manage statements within the Statement Management 
window and includes creating, editing, printing/reprinting, and listing statements, as well as 
changing statement status. 

To perform any statement management functions, go to the Activities menu and select 
Statement Management. 

You can also track patients that do not immediately pay their copay using the Copay 
Remainder statement. This format is only available when processing statements using the 
Statement Manager feature. Before using this statement format, you will need to select the Add 
Copays to Remainder Statements box on the Program Options window, Billing tab. 

   

F1   Look up Program Options window, Billing tab  
F1   Look up Tracking Missed Copays 

You can use Statement Management to create, to bill, and to rebill statements all from one 
place.  You can also view information about the statement, such as the guarantor, the status, 
the initial billing date, and the type. You can also generate statements to track missed copays. 
For more information, on setting up and using this feature, see the topic Tracking Missed 
Copays. 

  

Statement Management Window 

The Statement Management window has several sections: 

 

Header 

Search: Enter values for which you want to search in the grid.  This field is affected by the 
variable in the Sort By field. 

Sort By: Click the down arrow to select the variable by which you want to search.  If you want 
to sort by Submission Count, you have to add that column to the grid to see the counts.  For 
more information, see:  

F1   Look up Grid Columns 

List Only: Click this button to list only certain statements in the grid.  For more information, 
see:  
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F1   List Only Statements that Match 

Change Status: Click this button to change the status on a batch of statements.  For more 
information, see: 
 
F1   Change Statement Status/Billing Method 

Navigation Buttons: These buttons in the upper right corner of the window allow you to 
move through the displayed records.  The button at the right end of the navigation buttons 
refreshes the information in the grid.  

Buttons 

Edit: Click this button to edit the selected statement.  For more information, see: 

F1   Look up See Edit Statement 

Create Statements: Click this button to create statements.  For more information, see:  
 
F1   Create Statements 

Print/Send: Click this button to print the statements on paper or send them electronically. For 
more information, see:  
 
F1   Print/Send Statements 

Rebill Statement: Click this button to rebill statements. For more information, see 
 
F1   See Rebilling Statements 

Delete: Click this button to delete the statement number and release the transactions bound 
to the statement.  You can then put those transactions on a different statement.   

NOTE: If you delete electronic statements that have already been billed and decide to 
recreate them, the program will automatically assign a media of Paper to those 
statements.   

F1   Recreating Electronic Statements 

Close: Click this button to close the window. 

  

Creating Statements 

Click Create Statements to gather available transactions onto a statement.   
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You can create a single statement or an entire batch.  Enter ranges of transaction dates and/or 
chart numbers to control which statements are created.  Also, you can further limit the 
statements created by entering information in the Select transactions that match, Include 
statements if the remainder total is greater than, and Statement Type areas of the window.   

F1   Look up Create Statements 

  

Editing Statements 

Highlight a specific statement and click Edit or press F9 to edit a statement.  You can modify 
general statement information, the transactions that appear on the statement, and any 
comments attached to the statement.  When you make changes in the Statement edit window, 
you modify only that statement and do not affect the defaults for other statements.   
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The detail also indicates submission method assigned to the statement (paper or electronic), as 
well as the statement status.  Statement status options include:  Hold, Ready to send, Sent, 
Failed, Challenge or Done.  You can also see the statement type, initial billing date, batch 
number, submission count, and most current billing date. 

Any time a statement is sent, the program assigns the statement a batch number.  That number 
shows in the Batch field.  The program also updates the submission count, the number of times 
the statement has been sent, and the billing date. 

The Transactions tab shows all the transactions that appear on the statement.  You can split, 
add to, or remove transactions from statements in this tab.  The Comment tab provides an 
empty box in which to place whatever comments you feel are necessary concerning this 
statement and/or any transactions relating to it.  If you add a note here, an icon is displayed 
next to the statement in Statement Management.  You can double-click the note to view or edit 
the note. 

F1   Look up Edit Statement 

  

Converting Statements 

To make it easier to use Statement Management, you can now easily convert old statements 
into Statement Management statements in the format’s report properties.  This is done through 
the Design Custom Reports and Bills option in the Reports Menu. 

F1   Look up Converting a Statement Format to a Statement Management Format 

  

Printing Statements 

Once statements are created, click Print/Send to process them.  Indicate whether you are 
sending the statements on paper or electronically.  If you are sending statements electronically, 
specify the format for the statements.  Then apply filters on the Data Selection Questions 
window to select only those statements you want to send. 
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TIP: Use the True option on the In Collection Match check box to display only records that 
meet the criteria of true or in collections.  Selecting False will not apply the filter.  A field left 
blank has no limits placed on it and the program searches the entire database and includes 
all information that fits the criteria. 

Use the Txn Sort Order list to sort transactions within a statement and to the statements as a 
group. Choices include: Entry order, Date of Service, and Document Number. 

F1   Look up Print/Send Statements 
F1   Look up Data Selection Questions 

  

Reprinting Statements 

If necessary, you can reprint statements without regard to their status.  To reprint an entire 
batch, the status must be changed for the batch. 

F1   Look up Reprinting Statements 

  

Listing Statements 

Click List Only to view only those statements that match a set of criteria that you define.   

In the List Only Statements that Match window, use one or more of the options to limit the 
statements you want to appear in the window. 
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F1   Look up List Only Statements that Match 

  

Changing Statement Status 

In the Statement Management window, all submitted statements are automatically marked 
Sent with an indication of the method of submission.  There may be occasions when you need 
to change this status.   

Statements sent electronically through BillFlash get a report that marks each statement as 
either accepted or rejected.   

Entire Batch 

If the status of an entire batch needs to be changed, you can change all the statements at 
once.  Highlight one of the statements and note the number listed in the Batch column in the 
Statement Management window.  Click Change Status.  The Change Statement 
Status/Billing Method window is opened.  
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Choose the Batch radio button and enter the batch number from the Batch column in the 
Statement Management window.  Then choose the appropriate radio buttons in the Status 
From and Status To sections.  All statements with that batch number have the status changed 
when you click OK.   

Selecting Multiple Statements 

When only one or a few statements within the same batch or statements from multiple batches 
need a status change, hold down the CTRL key and click each statement that needs the status 
changed.  Note that the selected statements do not need to have the same status to begin with, 
but they are all changed to the same status.  Click Edit. 

In the Change Statement Status/Billing Method window, choose the Selected Statement(s) 
radio button, then choose the appropriate radio buttons in the Status From and Status To 
sections.  If you have chosen statements with varying statuses, choose Any Status Type in the 
Status From section.  When finished, click OK.   

F1   Look up Change Statement Status/Billing Method and Marking Statements 

  

Billing Cycles 

The cycle billing feature lets you print statements every certain number of days.  If you want to 
print statements every 30 days, you can set up a billing cycle of that length.  First you set up 
the billing cycle in Program Options, Billing tab.  Then you process the statements through 
Statement Management.  The other ways of printing statements do not offer this feature. 

F1   Look up Cycle Billing 

  

Claim Rejection Messages 

Use this window to enter claim rejection messages received on an EOB (Explanation of 
Benefits).  These messages can then be attached to transactions and printed on statements to 
explain why the claim was rejected.  You connect the message to a transaction in the 
Rejection field when applying deposits from the insurance company.  

If the EOB shows a code for a certain procedure, you can enter or select the code in the 
Rejection field found in the Apply Payment/Adjustments to Charges window.  You can then 
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format a statement that prints transaction statement notes.    Using this reformatted statement, 
the program prints the claim rejection messages on patient statements. 

F1  Look up Format/Design Reports  

Go to the Lists menu and select Claim Rejection Messages.  The Claim Rejection Message 
list window opens. Click New to create a new rejection message or select an entry on the grid, 
and click Edit. 

 

TIP: When applying a claim rejection message to a line item in the Apply 
Payment/Adjustments to Charges window, use the F8 and F9 keyboard shortcuts. Click the 
Rejection column and click F8 to create a new rejection message or click F9 to edit an 
existing rejection message. In the Code field, enter the claim rejection message code. In 
the Message field, enter the message. 

  

F1   Look up Claim Rejection Message Entry  

F1   Look up Apply Payment/Adjustments to Charges Grid 

  

Troubleshooting Statement Printing 

Patient Remainder Statements  

NOTE: This is an Advanced and above feature. 

If you are having trouble printing patient remainder statements, check to be sure the following 
items have been performed: 

 The patient has insurance coverage other than Medicare.  This is indicated in the 
patient Case window, Policy 1 tab, Insurance 1 field (also Policy 2 and Policy 3 tabs if 
there is secondary and/or tertiary coverage). 

 A charge has been posted in the patient case. 

  A claim has been created. 

 An insurance payment or adjustment has been posted, applied, and marked as 
Complete to the account for each applicable carrier. 
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Applying Deposits 

Deposit/Payment Application  

NOTE: This is an Advanced and above feature. 

This feature makes creating a deposit list and applying payments, especially EOB payments 
from insurance carriers, an easy process.  In many ways, it is a more convenient place to apply 
payments than Transaction Entry because you enter one deposit, then distribute the payment 
to as many cases as necessary, then click one button and all the transactions are created at 
one time.  If necessary, within the same window, open a different patient record and continue 
distributing payments. 

F1   Look up Deposit Entry  

F1   Look up Apply Payment/Adjustments to Charges, and Program Options 

Go to the Activities menu and select Enter Deposits/Payments to open the Deposit List 
window.   

  

 

  

In this window, you can select a payment to apply, edit a payment, or create a new payment.  
The deposit date does not have to be the current date (but the transactions entered still appear 
on the current day’s activity reports).   

TIP: To save time and increase work efficiency, you can close a case after applying 
payment by right-clicking the line item in the grid and then selecting Close Case. At a later 
date in File Maintenance, closed cases can be deleted from the database.   

Select an entry on the grid and click the Detail button to pull up an information-only window that 
displays all the activity the selected deposit.  You cannot make changes in this window.  

If needed, you can print item details.  
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F1   Look up Print an Entry from the Deposit List 

When you highlight a payment and click Apply, the Apply Payment/Adjustments to Charges 
window is opened.   

  

 

  

In this window, select the patient chart number (if you have chosen an insurance payment) and 
apply the portion of the payment to the applicable charge(s).  When finished, click Save 
Payments/Adjustments to create the transactions.   

TIP: If you check Print Statement Now and click Save Payments/Adjustments, you print 
statements from Statement Management. 

Then, if you need to apply payments from the same deposit to another patient record, select 
the next patient chart number and continue making payment applications.  This window is also 
tied to the Payment Application tab of Program Options.  Unless deactivated, all payment 
applications are automatically checked as paid in full by the payer, allowed amounts are 
calculated on all charges, and any charges over the calculated allowed amounts are 
automatically entered in the Adjustment field.   
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TIP: Be sure to click Save Payments/Adjustments before closing this window or 
transactions cannot be created. 

The payment application feature is designed specifically to closely match the format of an 
EOB.  When you receive an EOB with a payment from an insurance carrier, open the Deposit 
List window, create the total amount deposit, and then apply the payment to the cases as 
specified in the EOB.   

   

EOB Payments 

Part of the payment structure to a healthcare office from an insurance carrier involves a check 
and an ―Explanation of Benefits.‖  Widely known throughout the industry as the EOB, it lists 
claims for which payment is being made and, in some cases, an explanation of what is not 
being paid and why. 

Not every insurance claim that is filed with a carrier is paid in full.  It may be that payment is 80 
percent of the claim or it may be 50 percent.  Other times a claim may be totally or partially 
disallowed.  The EOB explains in these cases.  Normally the part that is not paid by the carrier 
is picked up by a secondary carrier or charged back to the patient. 

When an EOB is received, a transaction must be entered to offset the charges.  This is done by 
creating a deposit in the Deposit List window.  If the EOB check covers several charges, 
distributing a payment to specific charges can be handled by clicking Apply.  The window lets 
you select the patient records and claims to be paid and designate how much goes to each.   

F1   Look up EOB Payments/Managed Care/Capitation Payments 

  

Managed Care 

One of the important sources of patients and income in many practices has begun to be 
managed care organizations.  In each instance, the HMO or PPO provides a list of patients who 
have selected your practice as their primary care provider.  Payment is made to your practice 
on a per-patient basis, regardless of whether the patient ever visits the office.  When a patient 
does come in for treatment, he or she pays a set co-pay amount. 

The co-pay is charged only by the primary care facility or the facility to which the patient is 
referred by the primary care facility.  After a patient’s visit to the doctor’s office, a claim is filed 
and sent to the carrier.  When the EOB is returned, there is seldom a payment included, since 
payment is made under the capitation program for managed care organizations.   

F1   Look up EOB Payments/Managed Care/Capitation Payments 

  

Capitation Payment 

The basis for capitation payments is to provide healthcare for a fixed cost, irrespective of the 
amount of service required by each individual patient.  This is done in connection with the 
managed healthcare services such as HMOs and PPOs.  There is no direct relationship 
between the capitation payment received by the practice and the number of patients covered 
by the plan who actually visit the practice for treatment.  Capitation payments are not posted to 
patient accounts but are entered in the Deposit List window.  If it is necessary to zero out a 
patient account, create a zero deposit for the carrier.  For each patient covered by the 
capitation payment who has an outstanding balance, zero out the account by entering the 
remainder in the Adjustment field.  When it is applied, the payment shows as zero and the 
patient’s balance shows as a write off in the Adjustment field in the Transaction Entry 
window. 

F1   Look up EOB Payments/Managed Care/Capitation Payments 
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Managing Collections and Small Balance Write-Offs 

Collection List 

The collection list is a central place where you can manage accounts that are in collections.  
Ticklers or collection reminders are displayed as collection list items.  Go to the Activities 
menu and select Collection List.   

NOTE:  Security must be activated before this feature can be used. 

  

 

  

What appears in the collection list depends on the user login.  The program displays the 
collection list item for the current user, unless the user has administrative access.  
Administrators can choose to view all or selected users’ collection list items.   

To enter items in the collection list, click New while in the collection list.  Fill in the necessary 
information.   
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F1   Look up Collection List 

TIP: Use the F7 keyboard shortcut on the Collection List to launch the Quick Ledger. Select 
a line item on the Collection List grid and press F7 to display the patient's record in the 
Quick Ledger. 

  

Add Collection List Items 

The option to add collection items through reports is no longer an option.  However, you can 
add collection items with the new Add Items option in the Collection List.  This feature lets you 
create tickler items based on criteria you enter in the Add Collection List Items window.  
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F1   Look up Add Collection List Items 

  

  

Patient Payment Plans 

To help patients make consistent payments on their accounts, create payment plans.  You can 
create as many plans as necessary to accommodate your patients.  Go to the Lists menu and 
select Patient Payment Plan.   
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Once you create a plan, open the Patient/Guarantor window, Payment Plan tab, and assign 
the plan to the patient’s record.  The particulars for the plan appear in fields in this tab. 

  

 

  

The program records and tracks the scheduled date for the next payment and the amount to be 
applied.  If the patient follows the payment plan (e.g., the patient pays the required amount by 
the required date), this account is not included when you process collection letters.  If the 
patient does not follow the payment plan, the account is included when you process collection 
letters. 

F1   Look up Patient Payment Plan Entry 

  

Collection Letters 

Once you put a patient-responsible account in collections, you can create collection letters to 
follow up with the patient.   

To print collection letters, go to the Reports menu, select Collection Reports, and then select 
Patient Collection Letters.  You must print the Collection Letter Report before you print 
collection letters.   
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In the Data Selection Question window, click the Exclude items that follow Payment Plan 
check box to activate Generate Collection Letters box.  Check the Generate Collection 
Letters box.  

F1   Look up Collection Letters and Collection Letter Report 

  

Customizing Collection Letters 

Customize the collection letter format through the Collection Letter Wizard.  Go to the Tools 
menu and select Collection Letter Wizard.   

  

 

  

The things you can customize are the name and address, contact phone number, and sender’s 
name.  Make your selections and click either OK or Preview. 

Access the new format through the Custom Report List.  New formats are named 
WzCollections date (using the date on which the format was revised).  If you create several 
new formats in a single day, you can distinguish them by the order in which you created them.  
Click Show File Names to reveal the format file names.  This shows the file names (which are 
mrcol[#], numbered sequentially), type and date and time last modified.    

F1   Open the Collection Letter Wizard and then look up Collection Letter Selection 

  

Small Balance Write-off 

This feature lets you automatically write off remainder balances of a certain amount.  The 
balance written off is the patient remainder balance.  You can write off small remainder 
balances as a batch in the Small Balance Write-off window or for one patient at a time in the 
Apply Charges/Adjustments to Payments window.  

F1   Look up Small Balance Write-off Overview 

  

Writing off a Balance 
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To access the Small Balance Write-off window, select Small Balance Write-off from the 
Activities menu.   

  

 

  

The window is divided into two sections.  In the first section, select criteria for the type of 
remainder balances you want to write-off and click apply.  In the second section, a list of the 
patients who meet the criteria appears in the Write-off Preview List.  The default is set to write 
off all records in the list.  You can select individual records to write off by clicking on the record. 
Multiple records can be selected by pressing the CTRL key and clicking the record.  Click Write 
off to write off the selected remainder balances. 

Use the Stmt Submission Count + field to define a maximum amount of times that you want to 
send a statement before writing off the balance. Once this number is met, the small balance is 
written off. The program selects patients whose statements have been sent (submission count) 
more than the value entered in the field. Once this number is met, the small balance is written 
off. This field works in conjunction with the other fields on this window, and if a value is entered 
in this field, the balance is only written off if it meets the criteria for this field (completed the 
statements) and the other fields such as Maximum Amount field. For instance, if you enter 3 in 
this field and 10 in the Maximum Amount field, small balances would be written off after 3 
statements are sent and if the balance is under $10.00. 

When the program writes off the remainder balances it updates a number of other features. 
 Write-off entries are created and applied to all patient responsible charges associated with the 
selected patient.  The program also updates the associated Collection List items, refreshing 
balances and marking zero balances as deleted.  After a remainder balance write off, 
statements are changed to the status of Done and a note is added to the write-off entries. 

F1   Look up Small Balance Write-off 
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Using Electronic Services 

Electronic Claims Processing 

Electronic claims send your insurance claims online either directly to the insurance carrier or to 
a clearinghouse that then sends the claims to the insurance carrier. Medisoft currently offers 
modules that send to a clearinghouse and modules that send directly to insurance carriers via 
the Revenue Management feature. This solution is offered in two forms: Revenue Management 
Advanced and Revenue Management Direct.   

Revenue Management Advanced uses the RelayHealth clearinghouse for electronic claims 
processing and eligibility verification. With Medisoft 17, there is no cost for this software option 
though there are clearinghouse charges. For more information on pricing, contact your local 
value added reseller or Medisoft sales at 800-333-4747. 

Revenue Management Direct provides pre-configured connectivity to the most popular direct 
payers and also supports adding connections to other payers or clearinghouses.  This solution 
is available as an annual subscription with additional fees per direct connection. For more 
information on pricing, contact your local value added reseller or Medisoft sales at 800-333-
4747. 

With either option, Revenue Management provides a flexible tool that lets you manage your 
claims processing environment and, if necessary, make changes without completely replacing 
your EDI software.   

Revenue Management differs from other EDI solutions by virtue of its design; it is an integrated 
component of Medisoft which means that the company that produces your practice 
management solution also produces your EDI solution—a complete revenue management 
solution that seamlessly updates claim status and date sent while also providing  ERA 
(electronic remittance advice) posting and eligibility verification.  

   

F1   Look up Electronic Claims Overview 

  

  

Statement Processing 

You can send statements electronically through BillFlash, the web-based company that is set 
up to process Medisoft electronic statements.  Statements sent electronically through Billflash 
get an instant response report that tells what information was sent.   

F1   Look up BillFlash 

 

Receive/Send Reports through Medisoft Terminal 

Within Medisoft, the Medisoft Terminal option can be used to send or receive reports by 
connecting to various bulletin boards using a modem.  The BBS (Bulletin Board Service) is set 
up through Medisoft Terminal.   

F1   Look up Medisoft Terminal 

  

Eligibility Verification 

The Eligibility Verification feature lets you check a patient's insurance coverage online.  The 
Revenue Management feature conducts eligibility verification.   

Contact the Medisoft sales department at (800) 333-4747 for information on pricing.  You must 
have broadband internet service to make eligibility verification inquiries.   
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Eligibility Verification Setup 

To set up Medisoft for eligibility requests, you must make sure the Tax ID is entered on the 
Practice Information window, Practice IDs grid.  You must also enter information in the 
Providers, Insurance Carriers, and Patients windows.   
 
You must also apply security to your practice and create at least one user. For more 
information on Medisoft security and setting up users, see Setting up Security. 
  

F1   Look up Eligibility Verification Overview 

Practice Information: Click File and select Practice Information. Click the Practice IDs 
tab. On the Practice IDs grid, make sure there is an entry on the grid with the Practice Tax 
ID populated.  

Providers: Click Lists and select Provider and Providers. On the Provider List window 
open the provider whose patients you want to verify.  Make sure the following fields are 
populated: 

Provider IDs Tab: On the Provider IDs grid, make sure there is an entry on the grid with 
the Tax ID populated. 

Insurance Carriers: Click Lists and select Insurance and select Insurance Carriers. On 
the Insurance Carrier List window, select the insurance record for which you want to verify 
coverage.  Make sure the following field is populated:   

EDI/Eligibility tab: Click the magnifying glass in the Claims Payer ID field to search for the 
payer associated with this insurance company.  The Payer ID Lookup window opens.  If 
you select the payer and the Eligibility Payer ID field is blank, then the clearinghouse to 
which Medisoft sends verification requests does not support that payer at this time for 
eligibility requests. 

NOTE: Some carriers require Group NPI numbers instead of Individual NPI numbers for 
individual practitioners. If one of your carriers requires a Group NPI number, you will need 
to set up a separate entry on the Provider IDs grid for handling this type of dual NPI 
environment. For more information:  
 
F1   Setting up Mixed NPI Numbers for Eligibility. 

Patients: Fields in the Patient / Guarantor window must be populated for each patient.  On 
the Name, Address tab, enter information in the following fields:  Last Name, First Name, 
Date of Birth, Gender, and Social Security Number.  On the Other Information tab, enter 
information in the Assigned Provider field. 
 
Cases: Fields in the Case window must be populated for each patient.  On the Policy 1, 
Policy 2, and Policy 3 tabs, enter information in the following fields:  Insurance, Policy 
Holder, Relationship to Insured, and Policy Number.  On the Account tab, enter 
information in the Assigned Provider field.  

  

F1   Look up Patient/Guarantor Entry and Look up Case Entry 

  

Eligibility Verification Results 

There are multiple places in the program from which you can make eligibility verification 
requests: the Eligibility Verification Results window, the Patient List window, Office Hours, and 
the Task Scheduler window.  The type of eligibility inquiry you make, either real-time or 
scheduled, depends on the window from which you are making the request.   
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Eligibility Verification Results 

If you access this window from the Activities menu, the list will automatically show the last 
inquiry made for each patient.  You can also set it to show all inquiries.  To make a real-time 
eligibility inquiry from the Eligibility Verification Results screen, highlight the patient and click 
Verify.   

Patients 

To make a real-time eligibility inquiry for a specific patient, right-click the patient's case in the 
Patient List and select Eligibility Verification.  The Eligibility Verification Results screen opens 
for the patient.  Click the Verify button to make the inquiry.  You can also open the patient's 
case and click Eligibility. 

Office Hours 

To make a real-time eligibility inquiry for a specific patient from the appointment grid, right-
click the patient's appointment and select Verify Eligibility.  The Eligibility Verification Results 
screen opens for the patient.  Click the Verify button to make the inquiry. 

Task Scheduler 

You can use the Scheduled Tasks feature to schedule a daily time to send a batch of 
eligibility inquiries.  To schedule the batch, go to the Activities menu, select Eligibility 
Verification, and then select Schedule.  The task will automatically make inquiries for patients 
scheduled in the appointment grid up to a week in advance.   

TIP: Press F10 to launch the Eligibility Verification Results window to verify a patient's 
eligibility.  
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Scheduling Appointments 

Office Hours Overview 

Office Hours is an appointment scheduling program that helps keep track of appointments for 
your practice.  It is automatically installed with Medisoft. 

If you purchased Office Hours Professional, the features of this program are specifically marked 
as Office Hours Professional features in the documentation. 

  

 

Starting Office Hours 

If you are working in Medisoft, click the Appointment Book speed button or go to the Activities 
menu and select Appointment Book.   

Accessing Office Hours from Other Programs 

You can access Office Hours at the same time as you are working in other Windows-based 
programs.  Open Office Hours at the beginning of each day and then minimize it.  Press ALT + 
TAB at the same time to activate Office Hours, perform the desired scheduling tasks, and then 
minimize it to return to your previous task. 

  

Office Hours Setup 

Office Hours Setup 
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There are several portions of the program that need to be set up before you can start 
scheduling.   

First, set up provider records in Medisoft unless you are using Office Hours Stand Alone.   

NOTE: If you create a provider in Office Hours, you will need to finish setting up the 
provider in Medisoft. The Provider IDs tab and grid is not available in any version of Office 
Hours. 

If you are booking appointments for lab work or therapy, each of those technicians should have 
a provider number and schedule and so should each office member whose schedule is 
included in the Office Hours program. 

Second, create your resource records.  You can include all treatment apparatuses in this list, as 
well as consultation and treatment rooms, so that you do not double book a room or equipment. 

Third, establish the number of booking columns you want. 

Fourth, clarify program options, such as establishing appointment length, creating whatever 
views you need for viewing multiple columns at once, and deciding how much information you 
want displayed in your appointment blocks in the appointment grid.   

Fifth, set up breaks and recurring breaks, to show lunch hour, set breaks, seminars, etc. 

  

Setting up Provider Records 

Office Hours must have at least one provider record set up in order to run.  If no provider record 
is set up, Office Hours automatically prompts you to do so--the Providers window is available 
from the Lists menu in Office Hours.   

NOTE: If you create a provider in Office Hours, you will need to finish setting up the 
provider in Medisoft. The Provider IDs tab and grid is not available in any version of Office 
Hours. 

If you want, you can let the program assign the Code for the provider or you can enter a five-
character code yourself.   

Enter the provider’s name and pertinent information.  Enter NPI information, taxonomy, and 
other rules in Medisoft in the Providers window on the Provider IDs tab.  

F1   Look up Provider Entry 

  

Setting up Patient Records 

This can be done in either Medisoft or Office Hours.  Click Lists and select Patient List.  You 
can create a chart number yourself (eight alphanumeric characters) or let the program create 
one.  Enter information in as many of the fields as necessary in both tabs.  When finished, click 
Save.  Repeat this process for each patient who visits your practice. 

F1   Look up Patient Entry 

  

Setting up Case Records 

This can be done in either Medisoft or Office Hours.  Click Lists and select Patient List. Click 
the Case button in the top-right corner of the window and click New Case or press F8 to 
display the Case: Patient Name (new) window.  Enter information in as many of the fields as 
necessary.  When finished, click Save.  Repeat this process for each case you want to enter. 

TIP: In the Case window, you cannot press F8 or F9 to access records available from 
lookup fields, such as Facility or Attorney.  The F8 and F9 keys are only available in the 
Case window from within Medisoft itself. 
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F1   Look up Case Entry 

  

Setting up Resource Records 

The Resource List is a tool to help you manage the scheduling of rooms and equipment in the 
office.  To create the list, click Lists and select Resource List.  In the Resource List window, 
click New or press F8. 

Create a code for the resource or let the program create one based on the description.  Enter a 
description (e.g., Room 1, Treadmill, etc.) and click Save.  Repeat this process until all rooms 
and/or equipment are contained in the list. 

F1   Look up Resource Entry 

  

Setting an Appointment 

Setting an Appointment 

To set an appointment in Office Hours, first select the provider from the provider box at the top 
right of the toolbar. In any Multi View (Office Hours Professional), select the provider by clicking 
in the appropriate provider’s column. 

Select a date for the appointment. You can use the Day, Week, Month, and Year selection 
arrows below the calendar to locate the correct date, or use the Go to Date feature (available 
from the Edit menu).  

Next, in the appointment grid, double-click a time slot, which is highlighted with a heavy line 
border.  You can also right-click the time slot and select New Appointments or press F8; or, go 
to the Lists menu and select Appointment List and then click New to open the New 
Appointment Entry window.   
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Enter or select the chart number of the person for whom the appointment is being set.  If the 
person’s information has been entered in the program, the name and phone number are 
automatically entered and the patient’s last case is reflected in the Case field.   

TIP: After you select a chart number and move to another field (click or TAB key), if the 
patient has a future appointment scheduled, the Patient Has Future Appointment warning 
field appears. Click the magnifying glass or press ALT + A to review the scheduled future 
appointments before finalizing the new appointment. This feature is available for Office 
Hours Professional. 

Assign a resource.  If the resource or room you need is not in the list, press F8 to create a new 
resource record.  The Notes field lets you include a reminder message regarding the patient’s 
need or condition.  Enter an appointment reason in the Reason field.  If necessary, change the 
Length, Date, and Time fields here.  You can also change the appointment color.  If there is a 
need for repeat visits, click Change in the Repeat section.  See the following Repeating 
Appointments section. 

F1   Look up New Appointment Entry 

  

Repeating Appointments 

When a patient needs to make regular return visits, set up repeat appointments through the 
New Appointment Entry or Edit Appointment window.  Click Change in the Repeat section 
at the bottom of the window.  The Repeat Change window that opens is the same window that 
appears when creating repeating breaks.   

In the Frequency box, select the interval for the repeating appointment. Choosing any of the 
radio buttons (except None) displays different data entry boxes in the middle of the window that 
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give you the repeat options for each frequency.  Also, a written summary of the selected 
frequency appears in the bottom middle area of the box. 

It is important to note that when you set up an appointment using the Monthly frequency, the 
date highlighted on the main calendar affects the day or date that is entered in the break 
note.     

  

F1   Look up Repeat Change 

  

Entering Breaks 

Entering Breaks 

You can enter breaks into the appointment schedule as reminders that the time slots are 
committed.  Some breaks are a one-time occurrence, like a vacation or a seminar.  Others are 
regularly scheduled times for each month or week.         

Click Lists and select Break List. Click New or press F8 in the Break List window.   

  

 

  

To create a break, give it a name, a date, and enter the time that the break starts.  Using the up 
and down arrows, enter the length of time in minutes.  The display color of the break should be 
contrasting to the regular daily appointment schedule (the default is gray).  

If the All Columns box is checked, all columns in the schedule display will be marked with this 
break. If this box is not checked, only one column will contain the break. 

The Provider(s) field contains three buttons: Current, Some, and All. If you select Some, the 
Provider Selection window opens when you save the break so you can select the appropriate 
providers.  

NOTE: If you click New in the Break List to create a break, this field does not include 
Current. That is because breaks for all providers are included in the Break List. If only one 
provider is affected by the break, click Some and then select only the one provider. 

Select either the Some button or All button to apply the break to providers you select or all 
providers.  If you select the Some button when you click Save, the Provider Selection window 
appears. Click one or more providers and then click OK.   
 
The Print Grid feature is available with Office Hours Professional. 

F1   Look up New Break Entry 
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Setting Up Repeating Breaks 

In the New Break Entry window is a box marked Repeat. The Change button is next to this 
box.  Clicking Change opens the Repeat Change window where you can establish the 
Frequency of the break.  

 

  

Choosing any of the radio buttons (except None) displays different data entry boxes in the 
middle of the window that give you the repeat options for each frequency.  Also, a written 
summary of the selected frequency appears in the bottom middle area of the box. 

It is important to note that when you set up a break using the Monthly frequency, the date 
highlighted on the main calendar affects the day or date that is entered in the break note.     

  

Moving/Deleting Appointments 

Changing Appointment Status 

NOTE: This is a feature of Office Hours Professional feature.  

There are multiple options for marking the status of an appointment.    

The default is Unconfirmed.  When any change in status occurs, edit the appointment or right-
click on the appointment and choose the appropriate radio button.  If you choose Cancelled, 
the appointment is removed from the grid display.  Any other status is reflected by a small icon 
in the upper right corner of the appointment in the grid.   

  

Moving an Appointment 

If you want to move the appointment to another day or time, click the appointment and press 
CTRL + X (or go to the Edit menu and select Cut).  Move the cursor to the new day and/or time 
slot, and either press CTRL + V or select Paste in the Edit menu.  If you want to move the 
appointment to another time slot showing on the appointment grid (whether the same provider 
or not), click the appointment, hold the left mouse button down and drag the cursor to the 
desired time slot.  Release the mouse button. 

  

Deleting an Appointment 

There are multiple ways to delete or remove an appointment:  click the appointment slot on the 
appointment grid and press DELETE, highlight the appointment in the Appointment List and 
click Delete, or right-click on the appointment (either in the Appointment List window or on the 
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appointment grid) and select Delete or Delete item, respectively.  You can also edit the 
appointment and change the status to Cancelled.   

F1   Look up Moving/Deleting an Appointment 

  

Patient Recall  

NOTE: This is an Office Hours Professional Integrated feature. 

The program includes a complete patient recall system with a recall appointment list to assist in 
contacting patients to schedule appointment dates and times or to make reminder phone calls.  
This feature is available through both the Medisoft and Office Hours programs. 

F1   Look up Patient Recall 

  

Multiple Booking Columns 

NOTE: This is an Office Hours Professional feature.  

If you want to multi-book appointments (that is, schedule more than one patient in the same 
time slot), simply right-click the column heading in the appointment grid and the Speed menu 
gives you a choice of Add Column or Delete Column.  If you add a column, the Add Column 
window has a horizontal scroll bar that lets you indicate the provider for whom you are adding a 
column.  The number of columns determines how many appointments can be booked in one 
time slot for one provider.  There is really no limit as to how many columns can be set up on the 
appointment grid.   

  

Program Options 

Appointment Length 

Click File and select Program Options. 
 
Set the starting and ending appointment times for the practice.  Enter the Starting Time and 
Ending Time, breaking it down by hour and minutes.  Standard appointment Intervals can be 
established by scrolling with the up and down arrows.   

You can also set colors to distinguish appointments, breaks, and conflicts (Office Hours 
Professional).  Make decisions concerning all the other default settings in this tab. 

Designate one of the reports in the Speed Report box (Office Hours Professional) and it 
automatically prints when you click the Print speed button. 
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The following images are from Office Hours Professional. 
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Appointment Display  

NOTE: This is an Office Hours Professional feature. 

In the Appointment Display tab of Program Options (click File and select Program Options), 
you can specify up to five rows of information to display in the grid for an appointment.  Be 
aware that the length of the appointment determines how much data is actually displayed on 
the grid.  An appointment must be at least 75 minutes long to display five rows of information. 

F1   Look up Program Options 



Scheduling Appointments 

149 

  

Views 

NOTE: This is an Office Hours Professional feature.  

One of the most important features of the Office Hours Professional program is the variety of 
ways you can display appointments/breaks in the appointment grid.   

At the bottom of the main Office Hours window, in the Status bar, there are four View boxes, 
with different configurations of dot patterns.  These give quick access to the same functions 
available through the View menu.  These correspond to Single Provider View, Week View, 
Month View, or any combination Multi View.   

Day View 

The Day View shows a single provider’s appointments for a selected day.  If multiple columns 
are set up, all columns are displayed.  To display another provider’s schedule, make a new 
selection in the provider box in the toolbar.  This view does not show columns for resources, but 
columns can be added or removed as necessary in this view.   

 Week View 

The Week View also shows only one provider’s schedule, but with one column for each day of 
the week.  If you have multiple appointments scheduled, the time slot shows the color for 
scheduling conflicts.  You can size the columns to see all the appointments/breaks scheduled 
by placing the cursor on the right column heading boundary line until it takes the shape of a 
double-sided arrow, and then drag the boundary line right or left to increase or decrease the 
size of the column.  Columns can be added or removed as necessary in this view. 

 Month View 

The Month View shows up to 31 days, with the boxes colored where appointments have been 
scheduled.  This is a single-provider view.  The value of this view is that you can get a good 
overall view of which days are free for appointments or other scheduled items.  Columns cannot 
be added or removed in the Month View. 

Multi View/Multiple Provider/Resource View 

The Multi View, or Multiple Provider/Resource View, is the most flexible.  The program provides 
one Multi View setup, which automatically includes all providers and all resources, each with its 
own column.  You can create as many Multi Views as you need in the Multi Views tab of 
Program Options--click File and select Program Options.    

The open data entry field lists all Multi Views that have been set up.  This is where you can 
group providers and/or resources (rooms or facilities scheduled for appointments) in any 
combination desired, or modify or delete existing multiple view setups.  Click New to set up a 
new Multi View (select a view and click Edit to make changes).   

In the New View window, assign a name for the new view.  For the first column, indicate the 
type (Provider or Resource), the Code (provider number or resource code), then the width of 
the column (in pixels).  Set up each column you want in the view and click Close when 
finished.   

If you want to add a column between columns that have already been created, place your 
cursor where you want the new column and click Insert.  

These views can be also edited or reverted to default views through the View menu. 

  

Security Setup  

If you are using Office Hours in connection with Medisoft, the security settings established in 
Medisoft are applied to Office Hours as well.  However, you can make changes from within 
Office Hours if needed.   
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You can be logged in to the program on only one computer at a time.  If you are logged in on 
one computer and try to log in on another, a message pops up.  You have to log out of the first 
computer before you can log in on another computer. 

F1   Look up Security Setup 

  

Reports in Office Hours 

Reports in Office Hours 

If you select one of the following reports in the Speed Report box in Program Options 
(Options tab), that report prints automatically when you click the Print speed button (Office 
Hours Professional). The reports are: 

 Quick Appointment List 

 Appointment List 

 Appointment Grid 

 No Show Report 

  

Appointment List 

Probably the most important report printed in Office Hours is the Appointment Schedule, a 
listing of all the day’s scheduled events.  Generally, printing this report is the first order of 
business.  Print the list and be sure you are ready to meet the day.  Go to the Reports menu 
and select Appointment List.  

In the Report Setup window, select how you want the report to print. If you have Office Hours 
Professional, you can also select if you want to print only those appointments that need 
referrals.  

In the Data Selection window, modify the report by setting Date and Provider ranges, if desired. 
Remember, if a range is left blank, all available records will be included in the report. See Data 
Selection Questions. 

TIP: If available, select the Print Blank Appointments to include unassigned time slots from 
the appointment list in the report. Including this data provides flexibility for you to quickly 
review open slots over the examined range and even print out the report and manually 
enter patients on the printed report. This feature provides a quick way to accommodate 
walk in patients when accessing the application is impractical or not desired. 

F1   Look up Printing the Appointment List 

  

Appointment Status  

NOTE: This is an Advanced and above feature. 

The Appointment Status report displays a list of appointments showing their statuses.   

F1   Look up Appointment Status Report 

  

Printing Superbills 

The superbill is designed to be a physician's worksheet.  At the beginning of the day, consider 
printing a copy of the superbill for each patient with an appointment that day and then attach it 
to his or her chart.  In Medisoft, the superbill is pre-formatted with the patient's name, chart 
number, appointment time, and the practice name at the top.  The superbill displays a list of 
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what procedures can be performed by the provider and the diagnoses related to it displayed in 
a list format. 

If you use Office Hours integrated with any version of Medisoft, you can print superbills for the 
day through Office Hours.  Go to the Reports menu and select Print Superbills.  In Medisoft 
select the Reports menu and then select Print Superbills. 

For a discussion on how superbills work and how to track superbills: 

F1   Look up How Superbills Work 
F1   Look up Tracking Superbills 

For more information on creating new superbill report formats, editing an existing Superbill 
format, or converting an existing superbill format: 

F1   Superbills 

Deleting a Superbill 

If you delete an appointment to which a superbill is attached, the superbill is also deleted from 
the program.  When a numbered superbill is deleted from the program, the number may be 
released for reassignment.  For more information on superbill deletion and reassignment see:  
 
F1   What Happens to the Number When You Delete a Numbered Superbill 

Printing a Blank Superbill 

This feature allows you to print blank, serialized superbills that are not assigned to an 
appointment. Before using the feature if you have security applied to your practice, you will 
need to give access to this feature to appropriate users. The default setting is for level 1 users 
only. For information on changing permissions:  
 
F1   Look up Permissions  

You will also need to select the Force Document Number and Use Serialized Superbills options 
on the Program Options window, Data tab.  

Once enabled, you can print a blank Superbill by selecting the Blank Superbill command on the 
Reports menu and at a later date, assign the blank superbill to a chart and case in the 
Transaction Entry. For more information, see:  
 
F1   Printing Blank Superbills 
F1   Assigning a Blank Superbill to a Patient and a Case  
F1   Look up Printing the Superbill 
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Running Reports 

Reports Overview 

Medisoft offers flexible reporting options. You can run reports in Medisoft by selecting various 
reports from the Reports menu. Or, you can launch the Medisoft Reports engine (for Medisoft 
Advanced and Medisoft Network Professional only) and complete all reporting tasks in this 
window. The Medisoft Report window offers several key features not available when running 
reports off the Reports menu including new reports and features to enhance productivity.  

For more information on using the Medisoft Reports engine, see the Medisoft Reports topic. 
The Medisoft application also supports Medisoft Reports Professional, a robust report authoring 
application.  

F1   Look up Reports Overview 

F1   Medisoft Reports Professional 

F1   Look up Reports and Printing Reports 

  

Report Designer 

One of the most exciting features of Medisoft is the Report Designer, adding flexibility in the 
creation of reports to best serve your practice or business needs.  Using the Report Designer 
and the existing set of reports, you can generate custom reports tailored to meet specific 
needs. 

Report forms in this section are categorized into several ―styles.‖  Each style defines basic 
report characteristics, i.e., List, Label, Ledger, Walkout Receipt, Insurance Form, Statement, 
and Statement Management.   

To create custom reports, go to the Reports menu and select Design Custom Reports and 
Bills.   

F1   Look up Report Designer and Format/Design Reports 

  

Report Procedures 

Printing a Report 

To print a report, complete the following steps: 
1. On the Reports menu select the report to be run. The Print Report Where window 

appears. 

2. On the Print Report Where window, select the Print the report on the printer button.  

3. Click Start.  Depending on the report selected, the Data Selection Questions window 
or the Search window opens.  

4. On the window select data ranges and then click OK. The Print window appears. 

5. Click OK.  

Viewing a Repot 

In Medisoft, you can view or preview a report before printing or exporting it.  For example, you 
could preview a Patient Aging report before printing it to make sure that you have selected the 
most appropriate data criteria. After previewing users can export or print the report. 

To view a report, complete the following steps: 
1. On the Reports menu select the report to be run. The Print Report Where window 

appears.  
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2. On the Print Report Where window, select the Preview the report on the screen 
button. Click Start. Depending on the report selected, the Data Selection Questions 
window or the Search window opens.  

3. On the window select data ranges and then click OK. The report is displayed.  

Use the controls in the Report Preview window to view or search for details. Controls include: 

Print:  Used to print the report on the default system printer using the user specified 
criteria. 
 

 Zoom:  Used to increase or decrease the viewing size of the report.  
 

 Navigate:  Used to navigate or browse through the various 
pages of a multi-page report and features jumping to the first or last page, moving to the 
previous or next page, or specifying a particular page to view. 

 Search:  Used to further refine data parameters/search criteria. Once you have 
generated a report, you can further refine the report and search for a more detailed data 
element. When using this feature, you essentially re-run a report using more specific data 
criteria. 

 Close: Used to close the currently displayed report. 

NOTE: For some reports that use a different format, such as statements, the controls in this 
window are slightly different and include a Save Report to Disk option. If you select this 
option, you can save the report in a .QRP format and then use the Load Saved Reports 
command on the Reports menu to load the report. 

 

  

Searching for a Specific Detail in a Report 

Once you have generated a report, you can further refine the report and search for a more 
detailed data element. When using this feature, you essentially re-run a report using more 
specific data criteria.    

  

To refine your data criteria and search for specific data: 
1. Generate a report. 

2. Click the Search button.  

3. On the Search window, select specific data ranges. 

4. Click OK. The report displays using the new search criteria. 

  

  

Exporting a Report  

In Medisoft, you are able to export a report into another format.  For example, you could export 
a Patient Aging report to an Excel spreadsheet.   
 
To export a report, complete the following steps: 
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1. On the Reports menu select the report to be exported.  The Print Report Where 
window opens. 

2. Click the Export the report to a file button and click Start. The Save As window 
appears. 

3. On the Save As window window select a file format for exporting and a destination.  
Click Save.  The Search window or the Data Selections Questions appears (depends 
on the report or statement selected). 

4. On the window select appropriate criteria if needed.  Click the OK button.  The report is 
exported. 

  

  

Available Reports 

Available Reports 

Not only does the program build an accounts receivable file and handle statements, insurance 
claims, and electronic billing, it also provides a variety of reports that can give you a better 
understanding of the day-to-day workings of your practice. 

Among the reports generated within the program are Day Sheets, Analysis Reports, Aging 
Reports, Productivity Reports (Network Professional), Activity Reports (Network Professional), 
Collection Reports (Advanced and above), Audit Reports, Patient Ledger Report, Guarantor 
Quick Balance List (Network Professional only), and Standard Patient List Reports.   

You can print a title page that shows all the filters used in preparing the report.   

F1   Look up Program Options. 

  

Day Sheets  

Day Sheets are available in three reports.  The Patient Day Sheet lists each patient’s name, 
showing all transactions and a summary of activities for the day.  The Procedure Day Sheet 
breaks down by procedure code the activities of the day, summarizing patients treated for each 
procedure.  The Payment Day Sheet shows the payments made on the requested day and the 
charges to which the payments are applied. 

F1        Look up Patient Day Sheet, Procedure Day Sheet, and Payment Day Sheet 

  

Analysis Reports  

Billing/Payment Status Report (Advanced and above)  

One of the most powerful tools in Medisoft, the Billing/Payment Status Report provides a 
thumbnail sketch of the current billing and payment status of each claim.  The report shows 
what has been billed and not billed, what is delayed for some reason, if the carrier is not 
responsible or has refused the claim, or if the claim is paid in full.  An asterisk (*) next to an 
amount indicates that entity has paid all it is going to pay and the balance, if any, should go to 
the next responsible payer. 

F1   Look up Billing/Payment Status Report 

 Insurance Payment Comparison (Network Professional only) 

The Insurance Payment Comparison report compares the payment records of all carriers in the 
practice. 

F1   Look up Insurance Payment Comparison 
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Practice Analysis  

This report summarizes the activity of a specified period (e.g., a month), listing each procedure 
performed, the number of times it was performed, and the total dollar amount generated by 
each procedure.  It shows the average charge, includes any costs involved with that procedure, 
and calculates the net monetary effect on the practice’s income.   

F1   Look up Practice Analysis 

 Insurance Analysis (Advanced and above) 

This report summarizes all claims filed by category (Primary, Secondary, and Tertiary).  Claims 
totals are shown for charges and insurance payments in both dollar amount and percentage.    

F1   Look up Insurance Analysis 

Referring Provider Report (Advanced and above)  

It is good to keep track of the source of your patients.  The Referring Provider Report shows 
which patients were referred by other practices and the percentage each referral contributes to 
the overall referred income of the practice, as of the date of that report.  The report also 
includes the UPIN of the referring provider.  By blanking out the Referring Provider range in 
the Data Selection Questions window, a report can be generated showing what percentage of 
the entire practice has been referred. 

F1   Look up Referring Provider Report 

Referral Source Report (Advanced and above)  

This is another report for tracking the source of patients who come to the practice.  For the 
report to work, however, all referral sources must be entered in the Address Book.  A source 
can be an attorney, a hospital, friends, other patients, or even the Yellow Pages.  Most new 
patient application forms include the inquiry ―How did you hear about us?‖  The Referral Source 
Report assembles the patient list by source (other than provider) and shows how much revenue 
comes from each source, allowing the practice to identify those sources that send profitable 
referrals and/or limit those that are costly or nonproductive.   

F1   Look up Referral Source Report 

 Facility Report (Network Professional only) 

This report tracks patients who are seen at different facilities.  The Facility Report assembles 
the patient list by facility and shows how much revenue comes from each facility, helping you 
identify which generates the most money. 

F1   Look up Facility Report 

Unapplied Payment/Adjustment Report (Advanced and above)  

This report shows any payment or adjustment that has an unapplied amount and where the 
transaction can be found.   

F1   Look up Unapplied Payment/Adjustment Report 

Unapplied Deposit Report (Advanced and above)  

The Unapplied Deposit Report shows all deposits that have an unapplied amount. 

F1   Look up Unapplied Deposit Report 

Co-Payment Report (Advanced and above)  

The Co-Payment Report shows all patients who have co-payment transactions.  It shows the 
amount of the required co-payment, how much was applied, and what was left unapplied.  If a 
patient does not have any co-payment transactions, he or she is not included in the report.     

F1   Look up Co-Payment Report 

Outstanding Co-Payment Report (Advanced and above)  
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This report shows all patients who have outstanding co-payment transactions. The report 
shows the Co-payment amount expected, the actual amount paid, and the amount due. If a 
patient has no outstanding co-payment transactions, he or she is not included in the report. 

F1   Look up Outstanding Co-Payment Report 

Appointment Eligibility Analysis - Detail Report  

This report shows patients with appointments whose eligibility has been checked, based on 
criteria entered. It includes detail about the patients, their appointment date and time, the 
provider name, and reason code. It is an ARRA report designed for showing that the practice is 
verifying eligibility electronically. 

F1   Look up Appointment Eligibility Analysis - Detail Report  

Appointment Eligibility Analysis - Summary Report  

This report shows a summary of appointments whose eligibility has been checked, based on 
criteria entered. It is an ARRA report designed for showing that the practice is verifying eligibility 
electronically. 

F1   Look up Appointment Eligibility Analysis - Summary Report  

Electronic Claims Analysis - Detail Report  

This report shows the status of claims, providing a summary of total claims and those that have 
been filed electronically or by paper. It includes the percentage of claims filed electronically. In 
addition, it shows detail such as the billing date, insurance carrier, sequence, claim number, 
patient chart and name, and the status of the claim. It is an ARRA report designed for showing 
that the practice is verifying eligibility electronically. 

F1   Look up Appointment Eligibility Analysis - Detail Report  

Electronic Claims Analysis - Summary Report  

This report shows the status of claims, providing a summary of total claims and those that have 
been filed electronically or by paper. It is an ARRA report designed for showing that the 
practice is verifying eligibility electronically. 

F1   Look up Appointment Eligibility Analysis - Summary Report 

Aging Reports  

Patient Aging 

One of the important tools in collections is the patient aging report.  This can be printed 
showing the age of each unpaid transaction for patients.  Default aging criteria is based upon 
the number of days between the creation of the transaction or claim and the date of the report 
you are generating.  The columns break down the amounts due that are 30, 60, and 90+ days 
old.  Aging is from actual date of the transaction, so it reflects the true age of the account.  The 
aging criteria and columns can be altered in Program Options.  This report includes all 
unapplied amounts in the totals.  The Date filter has been removed as it would return invalid 
values.   

F1   Look up Patient Aging 

Patient Remainder Aging (Advanced and Network Professional only)  

This report has the same format as the Patient Aging, but there is a key difference in how it 
works.  A charge does not show up on Patient Remainder Aging until all insurance 
responsibility has been marked complete.   

F1   Look up Patient Remainder Aging Report 

 Patient Remainder Aging Detail (Advanced and Network Professional only)  
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This report has the same criteria as Patient Remainder Aging Detail; however, it also lists each 
insurance company on the patient’s account and the date the insurance payment was marked 
complete.   

F1   Look up Patient Remainder Aging Detail 

Insurance Aging and Summary 

These reports (Primary, Secondary, and Tertiary) tracks aging of claims filed with insurance 
carriers.  The summary versions are similar but no patient information is included. 

F1   Look up Insurance Aging  

F1   Look up Insurance Aging Summary 

  

Production Reports  

NOTE: This is a Network Professional only feature. 

Production by Provider, Procedure, and Insurance and Summary 

These reports give incoming revenue information for each provider, procedure, or insurance 
carrier, respectively. The difference between these reports and the summary versions of the 
reports is that the summary reports do not display as much detailed information as the regular 
reports.  The summary reports display only a summary of the information available. 

F1   Look up Production by... Reports 

F1   Look up Production Summary Reports 
  

NOTE: Medisoft Network Professional provides this report on the Reports menu. This 
report is also available when using the Medisoft Reports Print Engine feature for Medisoft 
Advanced users. 
  

F1   Look up Medisoft Reports Print Engine 

  

Activity Reports  

NOTE: This is a Network Professional only feature. 

Daily/Monthly Activity Report  

This report presents financial activity based on the date range selected. The report displays the 
total number and the total amounts of the charges, payments, and adjustments entered during 
a date range. The report also details the net effect of the financial information entered on the 
Accounts Receivable balance for the day/month. 

Activity Summary by Provider/Insurance and Procedure  

Activity reports break down financial activity by day or month.  The summary reports summarize 
financial information entered for each provider/procedure or insurance carrier, respectively. 

F1   Look up Activity Reports. 

NOTE: Medisoft Network Professional provides this report on the Reports menu. This 
report is also available when using the Medisoft Reports Print Engine feature for Medisoft 
Advanced users. 

F1   Look up Medisoft Reports Print Engine 

  

Collection Reports  
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NOTE: This is an Advanced and above feature. 

Patient Collection Report 

The Patient Collection Report contains information based on statements marked Sent in the 
Statement Management window, showing what has not been paid, statement date, etc.  Also 
select Patient Collection Report (Statement Notes) to generate the report with statement notes 
included. 

F1   Look up Patient Collection Report 

Insurance Collection Reports 

The Insurance Collection Reports are identical in layout, but each reflects the selected 
insurance level—primary, secondary, or tertiary. This report also shows the claim data, what 
amount is outstanding, etc. These reports also offer variants that include claim notes.  

F1   Look up Insurance Collection Report 

 Patient Collection Letters  

The Collection Letter Report is printed in preparation of collection letters.  It contains 
information from the collection list and is used to help evaluate collections.  To access this 
report, go to the Reports menu, select Collection Reports, and then Patient Collection 
Letters.   

F1   Look up Collection Letter Report 

 Collection Tracer Report 

The Collection Tracer Report reports how many collection letters have been sent and when. 
 Each time collection letters are printed, the program, by default, keeps track of each letter 
sent.   

F1   Look up Collection Tracer Report 

  

Audit Reports 

Audit Generator 

The Audit Generator helps create a Data Audit Report that contains only the information you 
want included in the report.  The tables available in the Audit Generator are governed by 
choices made in the Audit tab of the Program Options window and whether a table has been 
edited.  You choose which tables, fields, users, and activities are included in the template.  This 
report is intended as a protection for the practice to keep track of changes made and, if desired, 
by whom. 

Some PHI (personal health information) will be included in the Data Audit Report no matter 
what selections are made or excluded in the Program Options window or the Audit Generator. 

NOTE:  This report does not support printing a report title page even if the Print Report 
Title Page option was set in the Program Options window. 

F1   Look up Audit Generator 

  

Patient Ledger  

This report reflects the account status of each patient.  Charges are shown until a payment is 
entered to remove a specific procedure paid.  You may include all patient accounts or select a 
few.  The patient ledger is similar to a ledger card in a manual accounting program.  Since the 
Medisoft program is a true Open Item Accounting program, it can show all or part of the 
financial activity for a patient, including the current balance and what procedures have not been 
paid.  Past activity in the account includes a listing of all transactions, indicating those that have 
been paid.  The report marks those transactions that have been paid and the amounts. 
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F1   Look up Patient Ledger 

  

Guarantor Quick Balance List 

NOTE: This is a Network Professional only feature.  

This report lists the guarantor quick balances that appear in the Quick Balance feature.  These 
balances are the guarantor remainder balances, so if there are charges that the insurance 
company has not paid on yet, then they are not reflected in this report. 

F1   Look up Guarantor Quick Balance List 
  

NOTE: Medisoft Network Professional provides this report on the Reports menu. This 
report is also available when using the Medisoft Reports Print Engine feature for Medisoft 
Advanced users. 
  

F1   Look up Medisoft Reports Print Engine 

  

Standard Patient Lists  

The Patient by Diagnosis and Patient by Insurance Claim reports provides users a means to 
sort data in meaningful chunks for analysis and reporting purposes.  

F1   Look up Patient by Diagnosis Report 

F1   Look up Patient by Insurance Claim Report 

  

Custom Report List  

Design capabilities in the program let you generate a variety of custom reports to meet the 
needs of your practice.  To access the customized reports, go to the Reports menu and select 
Custom Report List.  When you create a customized report, it is included in the Custom 
Report List. 

There are numerous reports already formatted that are included in the program and can be 
accessed.  These include:  Address List, Billing Code List, Birthday Card, Birthday Labels, 
Claim List, Diagnosis Code List, EDI Receiver List, CMS-1500 Forms, Insurance Carrier List, 
Insurance Payment Tracer (Claim Mgmt), Laser CMS-1500 forms, Patient Birthday List, Patient 
Face Sheet, Patient List, Patient Recall Labels, Patient Recall List, Patient Statements, Pre-
Printed Statement, Primary Claim Detail, Primary Claim Labels, Primary Claim Summary, 
Procedure Code List, Provider/Staff List, Referring Provider List, Remainder Statements, 
Remainder Statement Troubleshooter Report, Sample Statement with Image, Sample 
Statement with Logo, Secondary Claim Labels, Security Permissions Grid, Superbill, Tertiary 
Claim Labels, Transaction List, Unbilled Transactions, and Walkout Receipts.   
  

TIP: In Medisoft Advanced and Medisoft Network Professional, there are two statement 
types:  Statement and Statement Management.  If you are modifying a statement, make 
sure you are modifying one with the correct type.  You can only print Statement report 
formats from the Reports menu and Statement Management report formats from 
Statement Management. 
  

F1   Look up Modifying an Existing Report 

  

Other Report Functions 



Running Reports 

160 

Load Saved Reports  

This option allows you to reopen reports that were prepared earlier and have been saved—
supports reports and statements that use the .qrp extension which is created when an .mre 
extension report is previewed and saved--mostly statements and custom reports. 

F1   Look up Load Saved Reports 

  

Add/Copy User Reports  

This option allows you to share reports by adding reports to your database that may have been 
prepared by another practice or copying reports to disk for use by another practice or for disk 
storage.  Go to the Tools menu and select Add/Copy User Reports. 

 

NOTE: This function supports reports and statements that use the .mre extension. 
 
  

F1   Look up Medisoft User Reports 
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Available Program Options 

General Tab 

Backing Up Data 

The General tab deals with backups, which are an essential part of maintaining a computer-
generated billing program, and with general default settings.  

 

  

TIP: Best Practice--consider backing up data files every day, using a program of rotating 
backup disks so you can restore lost data to the most recent date before the files were 
damaged or corrupted.  If you are working with multiple practices, each practice should 
have its own set of backup files.  Doing your backups within the Medisoft program is a 
dependable method.   

Consider selecting the Backup Root Data option to back up your root data directory, that is, 
C:\Medidata.  The information backed up can include registration information and other files 
shared among all your practices.  Go to the File menu and select Backup Root Data.  The 
Backup Root Data window opens.  
 
F1   Look up Backup, View Backup, or Restore  
F1   Look up Backup Root Data 

Hide Inactive/Closed Items 

Accessed from the General tab on the Program Options window or by right-clicking a list, the 
Hide Inactive/Closed Items option provides quick filtering options for data display for inactive or 
closed items. Users can apply a setting on the Program Options tab and as needed, override 
this setting by right-clicking as needed to view or hide data in a list.  
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The default setting for this option is not enabled; users can selectively override this setting to 
enable the feature as needed or permanently change the default setting and then also, as 
needed, override this setting. 

Users can apply these settings to these lists: Address, Billing Codes, Claim Rejection Message, 
Cases, Contact, Diagnosis Codes, EDI Receiver, Insurance Carriers, Insurance Class, 
MultiLink, Patient Payment Plans, Procedure Codes, Provider Class, Providers Patients, 
Referring Providers, and Security Accounts.  

When users selects the right-click menu option of Show Inactive Records to override the setting 
on the Program Option window, a red X appears next to all inactive items in the list.  The right-
click menu also provides an option to Hide Inactive Records. 

NOTE: The option that is initially displayed depends on the current setting on the Program 
Options window. If the feature is enabled on the window, then the right-click menu initially 
displays the Show Inactive Records option; if the feature is disabled on the Program 
Options window, then the right-click menu initially displays the Hide Inactive Records 
option. 
 
NOTE:  When providers are marked as inactive in either Medisoft or Office Hours 
Professional (Provider window, Address tab, Inactive box), their information does not 
appear on the Appointment grid until the providers’ inactive status is updated to active. This 
means that when in day view (View, Day View), if you select an inactive provider from the 
Provider drop-down list on the Toolbar and click an appointment timeslot, a message will 
appear that notes that the provider you selected is inactive. Also, in multi view (View, Multi 
View) the inactive provider does not even appear on the Appointment grid. 

 Default Choices 

You have the option to show the Patient List and/or Transaction Entry windows on startup by 
placing a check mark next to either or both options here.  You can indicate whether you want to 
show shortcuts and/or hints, or Enforce Accept Assignment.  You have the option to calculate 
patient remainder balances upon opening or closing the program.  You can set account alerts 
that appear in the Transaction Entry, Deposit List, and Appointment windows that tell you when 
a patient has a certain remainder balance, is delinquent on a payment plan, or is in collections.  
In Medisoft Advanced and Medisoft Network Professional, you can indicate whether to print a 
title page for every report.  Network Professional includes an option to synchronize your 
computer time with the time on the network server.  

F1   Look up Program Options-General Tab 

  

Data Entry Tab 

The Data Entry tab gives you lots of options for various sections of the program.   
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In the Global section, you can indicate whether to use ENTER as a toggle to move between 
fields, to force payments to be applied, and to multiply unit times amount.  Using the zip code to 
enter city and state information can save a lot of time.  When the Suppress UB04 Fields check 
box is selected, UB-04 fields do not appear throughout the program. If you do not process UB-
04 claims, check the box. If you do process UB-04 claims, uncheck the box so that all the fields 
you need to populate the claim form will be available. For more information on UB-04 
functionality in Medisoft: 
 
F1   Look up UB-04 

In the Patient section, you can choose to use numeric Chart numbers (the default is to use an 
alphanumeric code) and/or have the program automatically hyphenate Social Security 
Numbers. The Patient Quick Entry Default list and the Use Quick Entry for New 
Patient/Case F8 and Use Quick Entry for Edit Patient/Case F9 check boxes provide setting 
options for the Patient Quick feature, which provides a custom method for creating records.  For 
more information on the Patient Quick Entry feature in Medisoft: 
 
F1   Look up Patient Quick Entry 

Choices in the Transaction section primarily affect Transaction Entry.   

Check the Force Document Number to apply a document number to each transaction in 
Transaction Entry.  It forces the Documentation Number field to appear.  If you uncheck this 
option, no document number is applied to the transactions and the Document Number field is 
not displayed in the Transaction Entry window.  If this option is unchecked, the serialized 
superbill function is also disabled. Selecting this option along with the Use Serialized Superbill 
box, also provides the option to print blank superbills. For more information on this feature, see:  
 
F1   Printing Blank Superbills 

F1   Assigning a Blank Superbill to a Patient and a Case 
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Use Serialized Superbills: Click this box to use the serialized superbills feature.  For more 
information, see: 

F1   Tracking Superbills 

If you click Force payments to be applied, the program makes you apply every payment 
before exiting Transaction Entry.  If you choose to Multiply units times amount, the program 
automatically adjusts the cost of the procedure based on number of units.  If you click Auto 
Create Tax Entry, the program automatically adds tax to any selected procedure code that has 
been marked taxable and creates a separate line item in Transaction Entry.  Be sure you have 
created and selected a Default Tax Code.   

Select the Suppress Co-pay Message option to suppress the co-pay collection message on 
the Transaction Entry for cases that require a co-pay. 

The Case Default field determines which case is selected in Transaction Entry.  The default is 
Last Case Used, but you can change this to Newest Case or Oldest Case. 

There is also a field where you can set the default Place of Service Code.  The default in this 
field is 11.  When there is an occasional change of location, simply type the new code to 
override the default entry. 
  

F1   Look up Program Options-Data Entry Tab 

  

Payment Application Tab  

NOTE: This is an Advanced and above feature. 

In the Payment Application tab, you can establish default settings that affect the payment 
application function.   

 

  

If you choose to accept the default settings, any amount applied to a charge is automatically 
marked as paid by that particular payee, the allowed amount is automatically calculated, and 
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the difference between the calculated allowed amount and the practice charge is offset in the 
Adjustment column.  In addition, any claim that has received payment from all responsible 
payers is automatically marked ―Done.‖  

In the lower half of the window, select default billing codes to be applied when using this 
feature.   

F1   Look up Program Options-Payment Application Tab 

  

Aging Reports Tab 

The Aging Reports tab lets you alter the starting date for patient aging reports and to redefine 
aging columns for both patient and insurance aging reports.   

 

  

F1   Look up Program Options-Aging Reports Tab 

  

HIPAA Tab 

The HIPAA tab offers features designed to help protect patient information from unauthorized 
access.   
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The Auto Log Off check box is designed to protect your data files from unauthorized 
tampering.  Click the check box and then enter a number of minutes (up to 59) in the data box.  
If you click this box and have not utilized the Security Setup feature in the program, a message 
pops up telling you that security has to be set up before the backup will function.  Click OK to 
clear the message.  See Security Setup for information on setting up security for the program. 

With Auto Log Off activated, any time the program remains unused for the amount of time 
designated, it minimizes to a User Login window which requires reentry of the user’s password 
in order to access the program again.  You can also click Close Program to turn the program off 
completely.   

When the Warn on Unapproved Codes check box is checked, the program alerts you if a 
code entered or selected is non-HIPAA compliant.  This warning pops up every time you save 
transactions and the program finds a code that has not been marked HIPAA compliant.  

To mark an existing code compliant, you need to edit each code entered in the program, 
determine its HIPAA compliance and then click the HIPAA Approved box (in both Procedure 
Code and Diagnosis Code edit windows). 

Another option is to use a program such as Codes on Disk.  This program imports current CPT 
and/or ICD-9 codes with all HIPAA-compliant codes marked.  See your local Value-Added 
Reseller or contact McKesson directly at (800) 333-4747.  

  

Color-Coding Tab  

NOTE: This is an Advanced and above feature.  

Transactions 

If you want to use color coding for transactions in Transaction Entry and Quick Ledger, click 
the Use Color Coding box.   
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Select colors for each of six types of transactions:  Unsaved, No Payment, Partially Paid, 
Overpaid Charge, Unapplied Payment, and Overapplied Payment.  These colors appear in 
both windows, letting you know at a glance the status of the transaction. 

 

  

Patients 

This feature, called patient flagging, lets you color code patient records to alert you to various 
situations when viewing the records the Patient List, Transaction Entry, Quick Ledger, and 
Deposit List windows of Medisoft and the New Appointment window in Office Hours (when 
integrated with Medisoft). 

The patient flag colors in the Program Options window are fixed and cannot be edited.  In the 
box to the right of a color box, assign your own description to that flag color.  To activate the 
edit boxes, click Use Flags.   

Patient flags are connected to patient records in the Other Information tab of the 
Patient/Guarantor window as you edit or set up a new patient record.   

F1   Look up Program Options-Color Coding Tab. 

  

Billing Tab  

NOTE: This is an Advanced and above feature.  

Statements 

Options in the Statements section deal with billing cycles.  If you want to use billing cycles 
when sending statements, click Use Cycle Billing.  If you choose to use cycle billing, be sure 
to enter a cycle billing days interval (e.g., every 30 days). 

The Add Copays to Remainder Statements is used to add missed copays (when patients do 
not immediately pay their copay), to the patient’s Copay Remainder statement.  
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F1   Look up Tracking Missed Copays 
F1   Look up Cycle Billing 

  

 

  

Billing Notes 

When Create statement billing notes is activated, a note is added to statements when 
printed.  Be sure to select a default note in the Statement Billing Note Code field.   

When Create claim billing notes is activated, a Comment transaction line is added in both 
Transaction Entry and Quick Ledger whenever a claim is billed.  The note includes the carrier 
name, date billed, claim number, and the name of the provider associated with the claim.  Be 
sure to select a default Claim Billing Note Code.   

F1   Look up Program Options-Billing Tab 

Quick Formats 

If the Use Statement Management for Quick Statements check box is checked, then the 
Quick Format options for Statements are the Statement Management statements; otherwise, 
the list would include the Report option statement formats. Any place that a Quick Statement 
prints would need to print the appropriate statement type: regular statements or Statement 
Management statements 

The Receipt format option is tied to the Quick Receipt button in Transaction Entry.  Select a 
default quick receipt format here, and that receipt is automatically printed when you click the 
Quick Receipt button in Transaction Entry.   

You can select a default Statement format, which gives you one-button printing of a statement 
from Quick Ledger.  When you click Quick Statement from either of these windows, the 
default statement is automatically printed for the selected patient record.  If you do not specify a 
default format here, the first time you click Quick Statement from Quick Ledger, you are 
required to select a format.  
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You can print a Face Sheet directly from the patient Case window.  To set a default form, click 
the down arrow in the Face Sheet field and select one of the options.  The selected default 
form prints each time you click Face Sheet in the patient Case window.  

The Quick List provides report options for selecting a default list report for the Quick List on 
the Patient Quick Entry window.  You can print a quick list directly from the Patient Quick 
Entry window each time you click Quick List in the Patient Quick Entry window.  

F1   Look up Program Options-Billing Tab 

  

Audit Tab  

The Audit tab lists all tables available in the database.  The tables you choose here become 
those tables available in the Audit Generator when preparing the Data Audit Report.  If you 
deselect MultiLink here, it will not be available in the Audit Generator.   

 

  

F1   Look up Program Options-Audit Tab and Audit Report Generator 

  

BillFlash Tab  

The BillFlash tab allows you to control some of the information that appears on the statements 
you send electronically via BillFlash, the web based company that is set up to process 
electronic statements in Medisoft.   
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Credit Cards Accepted: Select which credit cards your practice selects and they will appear 
on the printed statements in the top right hand corner of each statement. Also, enter a message 
for the credit card security code. 

Service Message: Enter up to three service messages. These will appear on the statement 
just below the address of the practice. 

Paper Color: Select the color of the paper that you want BillFlash to use when the statements 
are printed. 

Print Optional Sections: Select the checkboxes for Summary and Aging if you want that 
information to appear at the end of the statement. 

Statement Messages: Enter up to six statement messages.  

Entering a message in the Top field will place the text at the top of the statement. Other 
messages will be placed in the Messages section just above the line item detail for the 
statement. If you leave fields 1-5 empty, the Messages section will not appear at all on 
the statement.  

F1   Look up Program Options-BillFlash Tab 

Performing File Maintenance 

File Maintenance 

The program puts you in the driver’s seat by giving you the ability to rebuild indexes, pack data, 
recalculate patient balances, and purge data.  The tools to perform each procedure are 
contained within separate tabs. 

TIP: Each of these file management functions carries the warning that it can take a long 
time to process.  Keep that in mind when planning your file maintenance activities. 

  Rebuild Indexes 
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The Rebuild Indexes tab provides options to rebuild data indexes and lists the files available for 
rebuilding.  Clicking All Files includes them all.   

 

  

Pack Data 

Select the Pack Data tab to choose the data files from which you want to remove deleted data.  
Here again, you can choose one particular set of files or click All Files to include them all. 
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Purge Data 

The decision to purge data files should be done only after careful consideration.  Data removed 
cannot be reinstated unless you have a previous backup disk containing the information.  You 
have a choice of purging appointment fields, closed cases, and claims data files.  In any case, 
select the cutoff date to which you want to clear data.  All data in the selected file before and 
including the date specified is deleted.   
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Recalculate Balances 

On occasion, account balances or applied amounts may appear to be miscalculated.  This 
option recalculates the selected types of balances.   

NOTE:  An individual patient's account balance can be recalculated in the Transaction 
Entry window by clicking the Account Total amount.  Click OK in the Transaction Entry 
window and the program begins the process.  

To recalculate all account balances, click the Recalculate Balances check box.  To recalculate 
all unapplied amounts, click the Recalculate Unapplied Amount check box.  Click the 
Recalculate Patient Remainder Balances to recalculate all patient remainder balances.  
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F1   Look up File Maintenance 
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Tutorial Activities 

Tutorial Practice 1 - Program Setup 

Initial Program Setup 

Go to the File menu and select Open Practice.   

The sample data set up in this tutorial is under the practice name Medical Group (Tutorial 
Data).  Select that name and click OK.  If this practice name does not appear, click the Add 
Tutorial button.  Then select the practice and click OK.  The practice name appears in the Title 
bar of the main Medisoft window.   

 

User Setup 

1. Go to the File menu and select Security Setup.  This opens the Security Setup 
window. 
 

 
 
  

2. Click New to open the User Entry window.   
 

 
 
  

3. In the Medisoft original program, we recommend that the first user be designated the 
Administrator.  Click the Administrator box in the middle of the window.  Then you can 
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add more names, edit entries, or delete entries as necessary. 
 
In Medisoft Advanced and Medisoft Network Professional, after one Level 1 person has 
been entered, you can add more names, edit entries, or delete entries as necessary.  

4. In Login Name, enter Supervisor as the login name. 

5. In Full Name, enter Pat Smith as the user's full name. 

6. In Password, enter tn872284 as the password. 

7. Reenter the password in Reconfirm. 

8. If you are using Medisoft original, click the Administrator box (if this is the first record 
you are setting up).   
 
If you are using Medisoft Advanced or Medisoft Network Professional, be sure the 
Access Level is 1. 

9. Skip the Expire Date field for now. 

10. Click the Question tab. 
 

 
 
  

11. In the Select a question or type in your own field, select What is your pet’s name.   

12. In Answer, type Ginger.   

13. Reenter Ginger in the Reconfirm field.   
  

14. Click Save. 
 
Repeat these steps for a second user only this time, the user will not have the 
Administrator box checked (Medisoft original).    
 
For instance, repeat steps 1-13 to create an entry for Kelly Cooper a login name of 
scheduling with an access level of 3. 

15. Click Close to close the Security Setup window.  

16. If a message pops up reminding you that user's must relog into the program before the 
changes take effect, click OK to clear this message. Exit Medisoft and login using the 
Supervisor login. 

Group Setup 
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1. Go to the File menu and select Security Setup.  This opens the Security Setup 
window. 
 

 
  

2. Click the Group tab. 

3. Click New to open the Security Group window. 
 

 
  

4. In Group ID, enter DCTRS. 

5. Enter Doctors in the Group Name field. 

6. Enter All doctors and physician assistants in the Description field. 

7. Click Save. 

8. In the Security Setup window, click the User tab. 

9. Select the user information for Pat Smith. 

10. Click Edit. 

11. Select the Group tab.  

12. Click the check-box next to the DCTRS group. 

13. Click Save. 

14. Repeat these steps to create another group and to assign a user to that group. 

15. Click Close to exit the Security Setup window. 

Permissions 
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If you are using Medisoft Advanced or Medisoft Network Professional and are logged in as 
Supervisor (the level 1, Pat Smith user), you can create/revise the rights of each level of 
security.  Be sure you are still in the Tutorial database when you perform the following steps. 
 For this exercise, we will change the settings for Billing Charges function. 

1. Go to the File menu and select Permissions. 

2. Select Activities.  In the Process section, give Level 2 and 3 users the rights to Billing 
Charges by clicking in those boxes. 

3. Click Close.    

4. Click OK on the Information box.  
 

 
 

Login/Password Management  

1. Go to the File menu and select Login/Password Management.   

2. Enter 30 in the Renewal Interval field.  This way, a password must be replaced every 30 
days.   

3. In Reuse Period, enter 90 as the number of days before a password can be reused.   

4. Enter 6 as the minimum character requirement for a valid password.     

5. Enter 25 as the maximum number of characters for a valid password.   

6. Click the Require Alphanumeric check box.  You may notice that the password for the 
Supervisor already complies with these settings.   

7. Enter 5 as the maximum number of failed login attempts before a user is locked out of 
the program.   
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8. In Account disable period, enter 5 as the length of time a user's account is on hold when 
the maximum number of attempts has been exceeded.  
 

 
 
 
  

9. Click Save. 

10. Close the program and open it again.  This applies all the security changes you just set 
up. 

11. When you reenter the program, the User Login box appears asking you to enter your 
login name and password.  Enter Supervisor and tn872284.    

  

Tutorial Practice 2 - Practice Setup 

Adding Details to the Practice Record 

Go to the File menu and select Open Practice.   

The sample data set up in this tutorial is under the practice name Medical Group (Tutorial 
Data).  Select that name and click OK.  If this practice name does not appear, click the Add 
Tutorial button.  Then select the practice and click OK.  The practice name appears in the Title 
bar of the main Medisoft window.   
   

Entering Practice Information 

1. Click File and select Practice Information. Click the Practice tab.  
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2. On the Practice tab, you would enter the contact information for practice including 
practice name, address, telephone number, etc.  

3. You would also select from the Type list your practice type. Choices include Medical, 
Chiropractic, and Anesthesia.  When you choose Chiropractic or Anesthesia, other 
areas in the program change accordingly. Medical is the default practice type and does 
not add any additional fields. 
 
When you select Chiropractic, the Level of Subluxation field appears in the 
Diagnosis tab of the Case window for entering the level of subluxation. 
 
F1  Case Diagnosis 
 
In addition, five treatment fields are displayed in the Miscellaneous tab of the Case 
window electronic claims: Treatment Months/Years, No. Treatments-Month, Nature 
of Condition, Date of Manifestation, and Complication Ind.  
 
F1   Case Miscellaneous  
 
Since we are using tutorial data, most of this tab is complete. We will, however, delete 
and add entries to the Practice IDs grid.  

  

Entering a Practice IDs Grid Entry 

You will use the Practice IDs tab and Practice IDs grid to enter or edit key data elements 
associated with your practice (tax ID/social security number, NPI, taxonomy, legacy numbers, 
etc).  

This grid contains two elements. The first displays all current entries (rules). The second 
element, the New/Edit Practice ID window, is used to edit or create entries. The grid displays 
insurance carrier, insurance class, facility, NPI, Taxonomy, tax ID/ social security number and 
legacy data. 

1. Click Practice IDs tab. 

2. For this activity, the Happy Valley Medical Clinic no longer needs most of their non-NPI 
identifiers (legacy numbers) at the practice level. The supervisor (Pat Smith) has 
decided to delete all Practice IDs and enter a general rule for the whole practice along 
with re-entering the one legacy ID the practice still uses for a certain insurance carrier. 
 
In this case, you could select individual rows on the grid and press the delete key for 
each row or since we want to delete all the rows, press the CTRL key and the DELETE 
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key to delete all grid entries. On the Information window, click Yes.  All the rows are 
deleted. 

3. Now click the New button to create a new general rule for the practice.   
 
 

 
  

4. Select the top three All buttons.  
 
This selection applies the rule to all providers, all insurance carriers, and all facilities 
unless you have a more specific grid entry.  

5. Since Happy Valley Medical Clinic is organized as a group, click the National Provider 
ID button and enter 1234567895.  

6. Since you file electronic claims and your practice is a group, select the Taxonomy 
button and 998877665Y.  
 
 
NOTE: setting up taxonomy at the practice level only works if you select the From 
Practice button for taxonomy on the provider level for each provider and you do not 
select the Send Practice Taxonomy in Loop 2000A box on the Insurance Carriers 
window on the EDI/Eligibility tab. Otherwise you will send taxonomy in loop 2000A (solo 
providers) not loop 2310B (groups). 
  

7. Select the Tax Identifier button and enter your tax ID: 334455667. 

8. Select the None buttons to not associate legacy numbers with the rule.  

9. Click OK. The rule entry appears on the grid. 

10. Click New to create a second entry for the legacy number for a certain carrier. 

11. Click the All buttons for provider and facility but select the Insurance Carrier button and 
select FHP Health Plan from the lookup window. 

12. Re-enter your NPI, Taxonomy, and Tax Identifier.  Each rule that you create has to be a 
complete entry by itself. 
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13. Select the Legacy Identifier 1 button and enter 44446688 and from the qualifier list 
select 0B- State License Number. 

14. Click OK.  
 

 
 
This saves the rule and when you generate claims for FHP, either print or electronic, 
your state license number will be included.  

15. Click Save on the Practice Information window. 

 

Setting Up a New Insurance Carrier Record   

1. Click Lists and select Insurance and Insurance Carriers.   Click New. 

2. Skip the Code field.  Enter the following information: 

3. In the Name field, enter A1 Insurance Partners.  In the other appropriate fields, enter 
PO Box 11223, Hartford, CT 01234.    

4. Enter Best Choice in the Plan Name field.   
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5.  Click the Options and Codes tab. 

 

6.  Leave the Procedure Code Set and Diagnosis Code Set fields alone for now.     

7.  What you select in the various Signature on File fields determines what prints in Boxes 
12, 13, 31, and 24J of the CMS-1500 form.  For now, select Signature on File for 
Patient Signature on File, Insured Signature on File, and Physician Signature on File.   
Leave blank Print PINs on Forms.  Leave the Default Billing Method as Paper.  
 
In the respective default payment application code fields, select INSPAY, APWROFF, 
MCWH, DEDUC, and TAKEBACK (for the purpose of this tutorial, we will not create 
custom default payment types, but use existing ones). 
  

 

  

9. Open the EDI/Eligibility tab.  Since this tutorial is not dealing with electronic claims, 
you can skip most of the settings on this tab. In the Type box, select HMO.     
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9. Click Save.   

  

Setting up a New Provider Record 

Dr. Kris Lee has just joined the practice. You will need to set up Dr. Lee's record including 
creating a general rule for Dr. Lee and also associating a specific insurance carrier with Dr. 
Lee's record. 

1. Click the Lists, select Provider, and select Providers.  Click New.   

2. On the Address tab, skip the Code field.  Enter the following information:   

Name:  Kris Lee 

Credentials:  MD 

Address:  77 Guadalupe Road, Gilbert, AZ 85234 

Office number:  (123) 443-2584.  There are no additional numbers, so leave those fields 
blank.   

This provider is a Medicare participating provider.  Click the Signature on File check 
box, then select or enter 4/3/2008 as the Signature Date.  Click the Medicare 
Participating check box.  Enter Dr. Lee's License Number as ZYX1111110.   
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 The Reference tab is mostly used to display converted legacy data for reference only 
and is not pulled for claims. The only setting on this tab that impacts claim generation is 
the Provider Class list (for the purposes of this tutorial, we will not set up a provider 
class). 
  

3.  Click Provider IDs tab. Click New. On the New Provider ID window, select the All 
buttons for insurance and facility. These choices will make theis rule applies to all 
insurance carriers and facilities unless you create a more specific entry. Since Dr. Lee 
is a member of a group practice, select the Group button. 

4.  Select the From Practice buttons for NPI, taxonomy and tax identifier to pull these 
values from the practice level. Leave None select for the other values. 
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5.  Click OK. The rule appears on the Provider IDs grid. 

6.  Click New. Select the Insurance Carrier button and from the list, select A1 Insurance 
Partners. Leave All selected for Facility. 

7.  Since Dr. Lee is currently the only provider that takes this insurance, select the 
Individual button. Select the National Provider ID button and enter 1234567892. 
Select the Taxonomy button and enter 987654321s. Select the Social Security 
Number button and enter 678976566. Select the Legacy Identifier 1 button and enter 
11223344. Select the qualifier of BQ - HMO Code Number. 
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8.  Click OK. This rule appears on the grid and when a claim is generated for Dr. Lee that 
goes to A1 Insurance Partners, these settings will appear on the claim. 

9.  Click Save. Click Close. 

  

Setting Up a Referring Provider Record 

Dr. Terry Cooper has begun referring patients to your clinic. You will need to create a referring 
provider record for Dr. Cooper. 

1. Click the Lists and select Referring Providers.  Click New.   

2. On the address tab. Create a record for Terry Cooper, MD; 178 Warner Road, 
Gilbert, AZ 85234. Enter tcooper@21medical.com in E-Mail address, 4800981234 
in the Office phone, 4800981233 as the Fax, 6026789123 as the Home phone 
number, and 4805432109 as the Cell Phone number.  Dr. Cooper is a Medicare 
participating physician. Also enter 5551212900 in the License Number field and 
select from the Specialty list, General Practice.  

3. Dr. Cooper's UPIN is 2X3XC12.  That’s all the information needed right now.   
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 Click the Referring Provider IDs tab. Click the New button. Click the All button for 
Insurance. Click the Person button for Type. Click the None buttons for National 
Provider ID and Taxonomy. 

4. Click the Legacy Identifier 1 button and enter Dr. Cooper's Federal Tax ID of 
23YXO444. Select the qualifier of EI - Employer's ID Number. 
 

 
 
 

5. Click OK. 
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6. When information is entered in both tabs, click Save.  Click Close. 

  

Creating a New Address Record 

1. Click Lists and select Addresses. The Address List window appears.  Click New.   

2. Leave the Code field blank this time and let the program automatically assign one 
based on the Name field.  The code is not assigned until all information is entered 
and saved. 

3. In the name and address fields, enter Pizza Planet, 1234 Fifth Avenue, Anywhere, 
IA  85000, 1234567890 (this is the phone number).  In Fax Phone, enter 
1234567899.  Be sure the Type field reflects Employer.   

4. The contact for this entry is Murray.   
  

NOTE: The Extra 1 and Extra 2 fields are used for any other information you may 
want to enter to identify this entry.   

5. When finished, click Save.  Click Close. 
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Creating and Editing Procedure Codes 

New Procedure Codes 

1. Click Lists and select Procedure/Payments/Adjustment Codes.   In the 
Procedure/Payment/Adjustment List window, click New.   

2. In the General tab, enter XYZ in the Code 1 field, and then enter Test Code in the 
Description field.  Select Procedure charge in the Code Type field.   

3. The Account Code is an internal code for in-house bookkeeping.  It can be any 
configuration of letters or numbers you want to assign to each accounting function, 
i.e., cash, checks, etc.  Enter OVSP (for Office Visit-School Patient). 

4. Leave Type of Service empty.  Enter 11 as the Place of Service, and leave Time to 
do Procedure empty.  

5. Leave the Service Classification field alone.  It defaults to A.  

6. Leave the Alternate Codes fields alone.   

7. Click the Taxable box to mark this code as needing tax charges added to it. 

8. Click the Patient Only Responsible box. 

9. No other fields in this window are applicable, so skip them.   
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10. Click the Amounts tab and enter 50 in field A as the amount you want charged for 
this procedure.   

11. Enter 20 in the Cost of Service/Product field and 50 in the Medicare Allowed 
Amount field.  Click Save. 
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Creating a MultiLink Code 

1. Go to the Lists menu and select MultiLink Codes.  Click New.   

2. In the MultiLink Code: (new) window, enter SCHOOLPHYS in the Code field.  
Enter a description in the Description field, such as Physical, School.  In Link 
Codes 1, enter 80050, the general health screen panel; in Link Codes 2, enter 
81000, a routine urinalysis; in Link Codes 3, enter 93000, an EKG; and in Link 
Codes 4, enter 99241, office consultation.  When you have selected all of the 
procedures you want linked, click Save.  Click Close. 
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Creating a New Diagnosis Code 

1. Click Lists and select Diagnosis Codes.  Click New.   

2. Enter TEST in the Code 1 field.  In the Description field, enter Test Diagnosis 
Code.  Click Save.  Click Close.  

 
  

  

Tutorial Practice 3 - Patient and Case Records 

Setting Up a New Patient Record 

1. Click Lists and select Patients/Guarantors and Cases. Click New Patient.   

2. The Patient/Guarantor: (new) window opens on the Name, Address tab.  Chart 
Number is the first field.  Skip this field and let the program create a unique chart 
number. 
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3. Create a record with the following information: Name:  John Smith Jr; address:  246 
Center Street, Gilbert, AZ 85234; e-mail address: johnsmith@gilbertonline.com; 
home phone number:  (513) 224-4668 (remember to not enter parentheses or 
hyphens in phone numbers); work number:  (123) 345-6789; cell phone:  (513) 
224-1111; fax number:  (513) 531-9766; birth date:  1/12/1975; sex:  Male; Social 
Security Number:  012-34-5678; Race: Caucasian; Ethnicity: Non-Hispanic: 
Language: English.   

 

4. Click the Other Information tab.  In the Type field, be sure Patient is selected.  
Assign J. D. Mallard as the provider, click Signature on File, and enter the 
signature date of 9/15/2009.     

5. In the Employer field, select Bean Sprout Express.  Mr. Smith’s status is Full 
time.  When finished, click Save.  Click Close. 
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Opening a New Case 

1. Click Lists and select Patients/Guarantors and Cases.  Select John Smith in the 
left section of the window.  Then click the Case button at the top right of the 
window.  Click New Case.   

2. Enter Back pain as the description of this case.  Change Marital Status to 
Single.  All the other information is taken from the patient record.   
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3. Open the Account tab.    

4. In the Assigned Provider field, select Kris Lee.  In Referring Provider, select 
Terry Cooper. 

5. Mr. Smith was also referred by another patient.  In Referral Source, select Patient 
Referral.   

6. You have already received information from Mr. Smith's insurance carrier and you 
know that treatment is authorized through February 15.  Enter 2/15/2010 in the 
Treatment Authorized Through field.  In Authorization Number enter 6489211, 
in Authorized Number of Visits enter 12, and in the ID field, enter A. 
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7. Open the Diagnosis tab.   

8. In Principal Diagnosis, enter 724.2.   
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9. Open the Condition tab.   

10. In the Injury/Illness/LMP Date field enter January 15, 2010, the Illness Indicator is 
Injury. There have been no similar symptoms.  This was not related to an auto 
accident, so select No in the Related To field.  In Nature Of, select Injured during 
recreation.  No other fields are important for this case so leave them blank.   
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11. Open the Policy 1 tab.   

12. In Insurance 1, select A1 Insurance Partners.  Mr. Smith's Policy Number is 
9782XYZ, and his Group Number is 98KEY.  The Policy Start date is January 1, 
2010 and the End date is December 31, 2010.  Click Assignment of 
Benefits/Accept Assignment.  Leave the default information in the rest of the 
fields in this tab.   
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13. Mr. Smith has a secondary insurance policy.  Open the Policy 2 tab.  Select FHP 
Health Plan as his secondary coverage, Policy Number 00034526Z, and the 
Group Number is 888B.  Policy Start and End dates are January 1, 2010 and 
December 31, 2010, respectively.  Click Assignment of Benefits/Accept 
Assignment.  Your carrier assigns a Claim Number; for this example, use 283-
8765D. 
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14. No fields in the Medicaid and Tricare or Multimedia (Advanced and above) tabs are 
necessary for Mr. Smith--skip these tabs.  Click Save when finished. 

  

Tutorial Practice 4 - Transactions 

Transaction Entry 

1. To begin, go to the Activities menu and select Enter Transactions.   

2. For this exercise, select John Smith in the Chart field to pull up Mr. Smith's chart.  
Press ENTER.  His most recent case opens.  

3. To create a new transaction, click any column in the Charges section or click 
New.  Any information contained in the case Allergies and Notes box is popped 
up for your view.  Click OK to clear this message and continue.    
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4. Enter 99214 (Office visit) in the Procedure column.  Press ENTER.  All available 
information concerning that procedure code is automatically entered in the 
appropriate column.  The charge shows $65 for the visit.   

5. To create a second charge transaction, press the down arrow or click New.  Now 
enter a second procedure code for this visit, 82954 (Glucose Test).  Note that the 
Amount field shows $10.00.   

6. Mr. Smith is making a payment of $10 on the account.  Click any column in the 
Payments, Adjustments, and Comments section, and then enter the procedure 
code for a cash co-payment (COPAY10).  In Who Paid, select Mr. Smith.  In the 
Description field, enter Co-payment.  Notice that -10 is entered in the Amount 
field.  Click Apply. 

7. The Apply Payment to Charges window shows each of the charge entries that 
have been made and a white column marked This Payment.   

 

  

8. With the $10 to apply, select the charge that is $65.00, click in the This Payment 
column of that transaction, and enter 10.   

9. Click Close.   

10. You need to make an adjustment, so click New in the Payments, Adjustments, 
and Comments section of Transaction Entry.  Enter the adjustment code 
CACSYDISC, in the Pay/Adj Code field, Courtesy Discount in the Description 
column, and 5 as the adjustment amount.  Click Apply.    

11. The Apply Adjustment to Charges window is similar to the Apply Payments to 
Charges window.   

12. Locate the $55 balance and enter 5 in the This Adjust column.  Click Close to 
return to the Transaction Entry window.    
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Transaction Documentation 

1. You need to add a note to the first transaction.  Locate that transaction in the 
Charges area and click Note in that same area.  (You can add a note to either a 
charge transaction or a payment/adjustment transaction.)   

2. The default Type is Transaction Note (internal use only).  Enter the following 
in the Documentation/Notes area of this window:  Follow up with the carrier 
on this charge. 

3. Press the ENTER key and then press CTRL +T to enter a date and time stamp in 
the note.  Click OK.  Click Save Transactions.  In the column to the right of the 
selected transaction there is a small icon, which indicates that a note has been 
added.  This indicator is also displayed in the Quick Ledger window next to this 
transaction. 
 

 
  

4. Click Close to close the Transaction Entry window. 

5. Click Save Transaction. 

  



Tutorial Activities 

204 

Tutorial Practice 5 - Claims 

Creating Claims 

1. Click Create Claims in the Claim Management window.   

2. Since we created two charge transactions for John Smith in the Transaction 
Entry portion of this tutorial, let’s create the claim for these charges.  Click the 
first Chart Numbers range field and type SMI to set SMIJ0000 in the first Chart 
Numbers field.  Repeat this process in the second Chart Numbers field.   
 

 
  

3. Click Create.   

4. When you return to the Claim Management window, change the Sort By field to 
Chart Number and type SMI in the Search field.  Press Enter. A new claim has 
been created for SMIJ0000.   

  

Editing Claims 

1.  To edit the claim, highlight the SMIJ0000 claim and then click Edit or press F9 to open 
the Claim editing window.   

2.  Open the Comment tab.  Type the following message:  Notify attorney when claim is 
paid by primary carrier.  Press ENTER and then press CTRL+T to enter a date/time 
stamp.  

3.  The two transactions we created in Transaction Entry are now part of one claim.  
Suppose you find out that they have to be sent separately (for whatever reason).  Open 
the Transactions tab.   

4. This tab shows that both transactions are included in the selected claim.  To split the 
claim, highlight the second transaction, procedure code 82954, and click Split.  Click 
Yes to split the claim.  The second transaction is removed from the claim.   
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5. Click Save.  When Claim Management is reopened, a second claim has been 
created and displays below the original claim.   
 

 

  

Sending Claims 

1.  Once the claims are ready to go, in the Claim Management window, click Print/Send to 
open the Print/Send Claims window.   

2.  We are dealing only with paper claims in this tutorial, so leave the setting at Paper 
and click OK.   
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3.  The Open Report window opens so you can select the claim form on which to send the 
claim.  For now, highlight CMS-1500 (Primary) and click OK. 

4.  The Print Report Where? window pops up for you to indicate whether you want to 
preview the claim before printing or just send the claim directly to the printer.  For now, 
leave the setting on Preview the report on the screen and click Start.  

5.  The program assembles the information and then displays the Data Selection 
Questions window.  In each of the Chart Number Range fields, select Mr. Smith's 
chart number.  Click OK. 

6.  The claim is displayed in the Preview Report window.  If you have preprinted CMS-1500 
claim forms, put a couple in your printer.  Click the Print Report speed button.  Answer 
whatever questions you may need in the Print window, and then click OK.   

7.  Click Close in the Preview Report window.  You may briefly see an Update Billing 
Status window and then are returned to Claim Management and the claim for Mr. 
Smith is printed.  The claim status has been automatically changed to Sent, a batch 
number assigned, and the current date entered in the Bill Date 1 column for both 
claims. 

  

Changing Claim Status 

Through Claim Management, all submitted claims are automatically marked Sent with an 
indication of the method of submission.  The status needs to be changed when the claim is paid 
completely or if a claim is rejected or put on hold or pending for some reason.  Time has 
passed since you printed and sent the claims for John Smith and you have received a rejection 
notice from the carrier.  You have already corrected the errors and are ready to resend the 
claims.  To locate Mr. Smith’s claims, we will use a different portion of the program.  Click List 
Only and select John Smith's chart in the Chart Number field.  Click Apply.  In Claim 
Management, make note of the batch number and click Change Status. 

1.  Select the Batch button and make sure the batch number in the box matches that shown 
in Claim Management.   

NOTE: Since we used the List Only Claims that Match window to locate the claims, 
the batch number is automatically entered in the Change Claim Status/Billing 
Method window. 

2. In the Status From section, choose Sent.  In the Status To section, choose Ready to 
Send.   
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3. Click OK. You are now ready to send the claims for John Smith again. 

  

Tutorial Practice 6 - Statements 

Creating Statements 

1.  Click Activities and select Statement Management. Click Create Statements in the 
Statement Management window to open the Create Statements window.   

2.  Since we created two charge transactions for John Smith in the Transaction Entry 
portion of this tutorial, let’s create the statement for these charges.  Click the first Chart 
Numbers range field and select John Smith's chart.  Repeat this process in the second 
Chart Numbers field.   

3. Click Create.  
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4. When you return to the Statement Management window, a new statement has been 
created for SMIJ0000.    

  

Editing Statements 

1.  To edit the statement, highlight the SMIJ0000 statement and then click Edit or press F9 
to open the Statement editing window.   

2.  Open the Comment tab.  Type the following message:  Notify attorney when 
statement paid.  Press ENTER and then press CTRL + T to set a date/time code.  
Click Save. 
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Sending Statements 

1.  Once the statements are ready to go, in the Statement Management window, click 
Print/Send to open the Print/Send Statements window.   

2.  We are only dealing with paper statements in this tutorial, so leave the setting at Paper 
and click OK.   
  

 
 
 

3.  The Open Report window opens so you can select the statement form on which to send 
the statement.  For now, highlight NEW Patient Statement (30, 60, 90) and click OK. 
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4. The Print Report Where? window pops up to indicate whether you want to preview the 
statement before printing or just send the statement directly to the printer.  For now, 
leave the setting on Preview and click Start.  

5. The program assembles the information and then displays the Data Selection 
Questions window.  In each of the Chart Number Range fields, enter SMI and press 
TAB to print only Mr. Smith's statements.  Click OK. 

6. The statement is displayed in the Preview Report window.  Click the Print Report speed 
button.  Answer whatever questions you may need in the Print window, and then click 
OK.   

7. Click Close in the Preview Report window.  You may briefly see an Update Billing 
Status window and then are returned to Statement Management and the statement 
for Mr. Smith is printed.  The statement status has been automatically changed to Sent, 
a batch number assigned, and the current date entered in the Bill Date column for both 
statements. 

  

Changing Statement Status 

1. Through Statement Management, all submitted statements are automatically marked 
Sent with an indication of the method of submission.  The status needs to be changed 
when the statement is paid completely or for some other reason.  Time has passed 
since you printed and sent the statements for John Smith and you have received a 
correction notice from the patient.  You have already corrected the errors and are ready 
to resend the statements.  To locate Mr. Smith's statements, we will use a different 
portion of the program.  Click List Only and select John Smith's chart in the Chart 
Number field.  Click Apply.  In Statement Management, select the statement and 
click Change Status.   

2. Select the Batch button and make sure the batch number in the box matches that shown 
in Statement Management.   
  

NOTE: Since we used the List Only Statements that Match window to locate the 
statements, the batch number is automatically entered in the Change Statement 
Status/Billing Method window.  
  

3.  In the Status From section, choose Sent.  In the Status To section, choose Ready to 
Send.   
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4.  Click OK. 

5.  You are now ready to send the statements for John Smith again. 

6.  Click Close to close the Statement Management window. 

 

Tutorial Practice 7 - Deposits 

Creating a New Deposit 

1. Click Activities and select Enter Deposits/Payments.    

2. Click New.    

3. The payer is A1 Insurance Partners, so be sure the Payor Type is Insurance.  A1 
Insurance Partners conveniently paid $25 by check No. 5237; enter the check 
number in the Check Number field.  The bank is United Southwest Savings.  Enter 
the amount in the Payment Amount field. 

4. In the Insurance field, select A1 Insurance Partners.  Since you already set default 
codes when you set up the record for A1 Insurance Partners, the remaining fields are 
automatically filled.  Click Save.   
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5. In the Deposit List window, be sure this new deposit is selected, and then click 
Apply.   

6. The Apply Payments/Adjustments to Charges window is opened.  In the For field, 
select John Smith's chart.  

7. Locate the $65 charge, click the Payment column of that record, and enter 20.  In the 
box below (part of the $10.00 charge record), enter 5.  Click Save Payments. 
Adjustments  and then Close.  A message is displayed letting you know that both 
claims will be marked ―Done‖ for the primary carrier.  (This is based on a selection 
made in Program Options.)  If the Print Statement Now box is checked, the Open 
Report window is opened to select a statement form.  You can print it, or click 
Cancel.  
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8. Let's also assume that you receive a check from the secondary insurance carrier, 
FHP Health Plan. Create a new deposit for $10.00 from FHP. The check number is 
10890 and the bank is Greater Southwest Trust. 

9. Click the deposit and click Apply. Select John Smith's chart. Apply $8.00 to the $65 
charge and apply $2.00 to the $5.00 charge. Click Save Payments/Adjustments 
and click OK on the information window. 
 

 
  

10. If the Print Statement Now box is checked, the Open Report window is opened to 
select a statement form.  You can print it, or click Cancel.  

11. To review what you just did, click Detail in the Deposit List window.   
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12. The Deposit Detail window shows which transactions were affected and what was 
applied.  This window is only for reviewing the details of a deposit.  You cannot edit 
any transaction in this window.   

13. If needed, you can print item details by selecting the line item and clicking print grid.  

For more information, see:  
 
F1        Look up Print an Entry from the Deposit List 

14. Click Close after reviewing the details. 

15. Click Close again to close the Deposit List window.  If you return to the Transaction 
Entry window, a new entry has been created in the Payments, Adjustments, And 
Comments section—this insurance carrier payments.  

  

Tutorial Practice 8 - Collections 

Creating Collection List Items 

Note:  Be sure that you have activated security in your Medisoft program.  Collections and 
Revenue will not work unless you have applied security. 

1. Go to the Activities menu and select Collection List.   

2. Click New. 

3. In the Tickler tab, enter Contact Attorney. 

4. Choose the Patient radio button. 

5. In the Chart Number field, select John Smith's chart.  

6. Select Mr. Smith also in the Guarantor and Responsible Party fields. 

7. Choose the person to whom you want to assign this tickler.  The names you see are 
those entered in the Security Setup window.  If no names appear, you must set up 
Security first.   

8. Choose Open as the status of the item. 

9. By default, the follow-up date is today’s date.  Leave that date for now. 

10. Click Save. 

11. Let’s create an insurance-responsible tickler also, so you can see the difference 
between the two.  Click New. 

12. In the Tickler tab, enter Call insurance. 

13. Select Insurance.    

14. In the Chart Number field, select John Smith's chart. 

15. Select Mr. Smith's chart also in the Guarantor field. 

16. Choose AI Insurance Partners in the Responsible Party field. 

17. Choose the person to whom you want to assign this tickler.   

18. Choose Open as the status of the item. 

19. By default, the follow-up date is today’s date.  Leave that date for now. 

20. Click Save. 
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Adding a Collection List Item 

1. Go to the Activities menu and select Add Collection List Item. 

2. Choose the Claims radio button. 

3. Click the Primary radio button in the Carriers field. 

4. Click the Rejected radio button. 

5. Select A1 Insurance Partners for the first Insurances field and FHP Health Plan in 
the second Insurances field. 

6. Enter 2 in the Add item if submission count is great than field. 

7. Assign the item to Pat Smith. 

8. Check the Add Billing Comment to Office Notes check box. 

9. Click Add Items. 

10. Click No. 

Patient Payment Plans 

1. Go to the Lists menu and select Patient Payment Plan. 

2. Click New. 

3. In the Code field, enter A. 

4. In Description enter 5/30 (signifying a plan to pay $5 dollars every 30 days). 

5. In First Payment Due, enter 5 to have payments due on the 5
th
 of every month. 

6. In Due Every … days enter 30. 

7. Enter 5 in the Amount Due field. 

8. Click Save. 

9. Close the Patient Payment Plan List window.   

10. Go to the Lists menu and select Patients/Guarantors and Cases. 

11. Find John Smith’s record, select it, and click Edit Patient. 

12. Open the Payment Plan tab. 

13. In Payment Code select plan A. 

14. Click Save.  Click Close. 

Mr. Smith is now assigned to a payment plan.  If he makes payment of the correct amount and 
in the prescribed time, he will not be receiving collection letters from your practice.   

  

Collection Letters 

Collection Letters 

1. Go to the Reports menu and select Collection Reports, then Patient Collection 
Letters. 

2. Click Start in the Print Report Where? window. 

3. In the Collection Letter Report:  Data Selection Questions window, skip the 
range fields and click Exclude items that follow Payment Plan.   

4. Click Generate Collection Letters.  This also activates and enables the Add To 
Collection Tracer field.  Keep this field clicked.  Then click OK.   
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5. Preview the report, and then click Close (unless you really want to print it first). 

6. When asked if you want to print collection letters, click Yes. 

7. Select the Collection Letter format (or any customized format available) and click 
OK.   

8. Click Start to preview the letters. 

9. Review the letters and print them.   

10. When you open an account in Transaction Entry, Quick Ledger, Quick Balance, 
or an Appointment window, the words ―Account alert‖ appear near the patient’s 
name to indicate that the account is in collections. 

Customizing Collection Letters 

1. Go to the Tools menu and select Collection Letter Wizard.   

2. Choose the Third-Party Address radio button.  The Third-Party Billing Information 
section opens at the bottom of the window. 

3. In the other fields enter Happy Valley Associates, 9825 W. Baseline Road, Suite 
263, Gilbert, AZ 85234, 480-111-2222. 

4. In Sender Name choose Provider. 

5. Click Preview. 

6. After previewing the sample letter, click Create.  A little box appears in the middle of the 
window stating that the format is being updated.  Then a confirmation box displays.  
Click OK.  The wizard closes. 

7. A new collection letter format has been created.  You will see it the next time you create 
collection letters.  It is called WzCollections date.  For example, if today’s date were 
February 2, 2010 and you customized the format today, the format would be called 
―WzCollections120304.‖   

NOTE:  If you create multiple customized versions of the collection letter format, you might 
want to keep a list somewhere noting the date and a note concerning what was 
customized. 

Writing off Small-Balances 

1. Go to the Activities menu and select Small Balance Write-off. 

2. Leave the button set to All in the Patient Selection field. 

3. Select CABADDEBT in the Write-off Code field. 

4. Enter 1/12/06 in the Cutoff Date field. 

5. Enter 150.00 in the Maximum Amount field.  

6. Click Apply. Click OK on the Confirm window. 

7. Select Selected Items in the Write off field. 

8. Hold down CTRL and click the patient record for Sammy Catera and James Doogan. 

9. Click Write off. 

10. Click Close. 

  

Tutorial Practice 9 - Office Hours 

Entering Resources 



Tutorial Activities 

217 

1. Go to the Lists menu and select Resource List.  Click New.   

2. Leave the Code field blank.  In the Description field enter Treadmill.  Click Save.  Click 
Close. 

  

 

Entering Appointments 

1. John Smith calls and needs to see Dr. Lee today.  Dr. Lee actually has an opening at 
11:30 am.  In all views except Monthly (Advanced and above) and Multi View 
(Advanced and above), select Dr. Lee in the provider box to the right of the Exit speed 
button in the toolbar.  In any Multi View, be sure to locate Dr. Lee’s appointment 
column.  You see that the 11:30 time slot is open for Dr. Lee so double-click it to open 
the New Appointment Entry window.   

 

2. In the Chart field, select John Smith.  Press ENTER.  In Resource, enter T to help locate 
the treadmill resource.  Highlight the correct resource and press ENTER.   

3. In the Note field, enter the following information:  Emergency physical for work.    
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4. The Case defaults to Mr. Smith’s most recently opened case.  In the Reason field, 
although we have not yet created reasons of our own, we can select one from the 
database.  Click the down arrow and select Routine Checkup.     

5. The date and time have already been selected, so click Save.  See that Mr. Smith’s 
name appears in the 11:30 am slot.  Also notice that it is fuchsia in color (which is the 
color assigned to the Routine Checkup reason).  A recap of the appointment and Mr. 
Smith’s information is also displayed to the left of the Appointment Grid.  

Repeating Appointments 

1. Dr. Lee wants to follow up on Mr. Smith’s treadmill results and asks you to make two 
more appointments, a month apart.  Since 11:30 am is a good time for Mr. Smith, 
double-click the existing appointment.   

2. In the bottom left corner of the Edit Appointment window, click Change to open the 
Repeat Change window.  Choose Monthly.  In the End on: field, click the down arrow 
to show the calendar.  Click the right arrow twice (for two months).  Then click OK.  
Click Save. 

 

  

Setting Breaks 

1.  Click the Break Entry speed button.  In the Name field, enter Dr. Lee Seminar.    

2.  The meeting is scheduled for two hours on June 21, starting at 1:00 pm.  In the Date 
field, enter 11/20/2009.  For Time, type in 1:00 p.  In Length type 120.  In Resource 
enter L for the Lunch room.  Give it an aqua color, using the down arrow to display the 
color choices.  Click the All Columns box to be sure everyone participates.  Under 
Provider, choose All.  Click Save.  To double-check, click the appropriate Month and 
Day buttons to locate November 20, 2009.  If necessary, use the scroll bar to show the 
seminar. 

3.  To return to today’s calendar, click the Go to Today speed button. 

  

Creating Reason Codes 

1.  Go to the Lists menu and select Reasons List.  Click New to open the Appointment 
Reason Entry window.   

2.  Leave the Code field blank.  In the Description field, enter Sports Accident.     

3.  The default appointment length is 15 minutes.  Change this number to 30.  In the Default 
Appointment Color field, the drop-down arrow lets you select a color that fills the 
appointment space on the schedule grid.  Choose red for this emergency accident 
response.  In Default Template Color (Advanced and above), select Light Red.  Click 
Save. 
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Creating Templates  

NOTE: This is an Office Hours Professional feature. 

1.  Go to the Lists menu and select Templates List.  Click New.   

2.  In one of the six Template Reasons fields, use the drop-down arrow to enter NEW in 
the Code field.  In the Description field describe the template’s use as See New 
Patients.  Using the drop-down arrows, select Dr. Lee as the Provider, and the 
Resource is Exam Room 2.   

3.  Click the arrow on the Date field to display the calendar and highlight the designated 
date.  Use the arrows on either side of the month name to change to an earlier or later 
month, if necessary.  Type 10:00 a in the Time field.  Set the Length to 120.  The 
search arrow on the Color field lets you select light yellow as the color for the template 
on the appointment grid. 

4. Y ou want to use this template every day, so click Change to display the Repeat Change 
window.  Choose the Weekly frequency, enter the number 1, and click the boxes for 
Tuesday and Thursday.  Leave the End on field blank at this time.  Your entry is 
confirmed with the message, ―Every week on Tue and Thu.‖   

  

Creating Multi Views 

NOTE: This is an Office Hours Professional feature. 

1.  Dr. Lee works only with therapy patients and uses Exam Room 2 for consultations.  Let’s 
create a view where you can see all of these schedules at the same time.  

2.  To create a multi view, go to the File menu and select Program Options.  Open the 
Multi Views tab.  Click New.   

3.  Name the new view Dr. Lee and press TAB.  In the Type field, click the box and select 
Provider.  In the Code field, locate and highlight Dr. Lee’s name.  Leave the Width at 
its default setting.  Click Insert Column.   

4.  In the next line, select the Resource type.  Press TAB.  Locate Exam Room 2 and 
highlight it.  Press TAB.  Change the Width column to 50.  Click Insert Column to 
create a new line.  Again select Resource.  This time locate and select Therapy.  Click 
Close.  Click OK. 

  

Using the Wait List  

NOTE: This is an Office Hours Professional feature. 

1.  Mr. Smith has seen the doctor for his injury but he needs a return visit in a week.  With 
the full appointment schedule, the surest way to work him in is to put him on the Wait 
List.  Go to the View menu and click Wait List.  Click New.   

2.  Select John Smith from the Chart number field. Click Save.   

3.  To begin the search for his next appointment, highlight his record and click Find to open 
the Find Open Time window.     

4.  Mr. Smith is out of school at 2 p.m. but has choir practice on Tuesday and Thursday.  He 
needs a 15 minute appointment so enter a Start Time of 2:30 p and an End Time of 
5:00 p.  Click Monday, Wednesday, and Friday.  Click Search and let it go.  In a few 
moments, if the program finds a match, a Confirm window pops up:  ―Open time slot 
found.  Do you want to set the appointment?‖  If the first time slot it presents is not 
satisfactory, click Retry and let it search further.  Or click Yes and schedule the 
appointment. 
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Tutorial Practice 10 - Modifying the CMS 1500 Form 

Repositioning the CMS-1500 form 

1.  Let’s say your paper claims are printing with text shifted too far to the right and below the 
spaces provided in the pre-printed CMS-1500 forms. 

2.  Go to the Reports menu and select Design Custom Reports and Bills.  Click the Open 
speed button (the book with the arrow pointing to it) and select CMS - 1500 (Primary).  
Click OK. 

3.  Go to the File menu and select Report Properties.                        

4. It’s probably better to make one adjustment at a time, so in the Form Offset section, and 
change Left to .05.  Click OK.   
 

 
 

5.  You need to print the form to see if it is adjusted enough.  Click the Print speed button.  
The Save Report As... window is displayed.  Since you are revising a standard form, 
give this form a different name, until you know it is correct.  In the Report Title box, 
enter CMS - 1500 1. 
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TIP: You need to use a name that you can remember, but you cannot replace the original 
form.  If you use the same name as the original form, the list shows two forms with the 
same name and it may be difficult to remember which is the form you have revised.   

6.  The program informs you that claims and statements printed through the Report 
Designer are not marked as billed.  This is generally a good thing.  Click OK. 

7.  In the Data Selection Questions window, select a single claim number in the Claim 
Number Range so only one page prints.  Click OK.   

  

TIP: Use the Claim Number Range and not the Chart Number range because there must 
be an available claim before the form prints from the Report Designer. 
  

8.  Click OK in the Print window.  We made a great adjustment and the right/left adjustment 
is perfect.   

9.  Now repeat the process, opening the Report Properties window.  This time, enter .6 in 
the Top field.  Click OK. 

10. Again print the form and check to see if the alignment is OK.   

11. Unfortunately, aligning the CMS- 1500 form is a trial-and-error process.  You may have 
to make a number of adjustments to get the printing just right.  When you do get the 
adjustments right, save the form and close the Report Designer.  Use this revised form 
each time you print paper claims. 

12. If you are short on CSM-1500 forms, you can print the report on plain paper.  Place the 
test paper on top of a pre-printed form and hold them up to the light to see if the text is 
lined up properly. 

  

How To Revise an Existing Report  

1.  You decide that you want the Zip Code included on your patient lists.  In the Report 
Designer, click the Open speed button.  Locate Patient List and click OK.   

2.  First you need to add the column heading and you have to make a little space for it.  
Move the Phone heading a little to the right by clicking and dragging the field.  (This is 
the heading in the blue band, not the one in the green band.) 

3.  Click the Text Field speed button in the toolbar and then click the cursor in the space 
between CityLine and Phone.  Double-click this new text field to open the Text 
Properties window.  In the Text field, enter Zip Code.  Click Font and, in Font style, 
click Bold.  Click OK.  Click OK again.  To be sure the heading is aligned properly, hold 
down the Shift key and click CityLine, Zip Code, and Phone.  Right-click over one of 
the selected fields and select Align Fields in the Speed menu.   

4.  In the Alignment window, choose Bottoms and click OK.  You’re halfway there! 

5.  In order to align the Phone heading and the Phone 1 field (in the green band), right-click 
Phone and select Properties.  In the Text Properties window, locate and make note 
of the value in the Position Left field.  Click OK.  Now, right-click over the Phone 1 
field and enter the same value in the Position Left field of this window.  Click OK.  The 
Phone heading and Phone 1 field are now aligned.   

6.  Next you need to enter the Zip Code field in the document; you need to insert a Data 
Field in the green band.  Click the Data Field speed button, and then click the green 
band below the Zip Code heading.   

7.  Double-click this new field to open the Data Field Properties window.  Click New Data 
Field.  In the Select Data Field window, the Patient file should automatically be 
selected.  Be sure it is.  In the Fields section, scroll down until you see Zip Code.  
Select Zip Code and click OK.  Click OK again.  
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8.  To make sure the two Zip Code fields are aligned, right-click over the heading and make 
note of the value in the Left position field.  Then right-click over the Zip Code field 
(green band) and enter the same number in the corresponding field of this window. 

9.  To save, you must rename the form.  Go to the File menu and select Save As.  In the 
Report Title box, enter Patient List w/Zip and click OK.  Close the Report Designer.   

10. To test your new report form, go to the Reports menu and select Patient List w/Zip.   

How To Create a New Report  

1. Choose a report style on which to base a completely new form. 

2. Format the report by going to the File menu and selecting Report Properties.  Establish 
the report name, margins, size of bands and filter the source data needed to provide the 
information for the report.   

3. With the report formatted, you can begin placing fields on the grid.  Make the necessary 
additions and/or changes to complete your form, then save and exit Report Designer.  
The new report appears in the Custom Report List. 

4. As you become familiar with the workings of Report Designer, formatting and designing 
become easier.  
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